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Preface

Preface

Thank you for purchasing this Topcon product. The materials
available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon
products, and are designed to assist owners with the use of the
receiver and its use is subject to these terms and conditions (the
“Terms and Conditions™).

@ Please read these Terms and Conditions carefully.

Terms and Conditions

USE This product is designed to be used by a professional. The user
should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local
government protection agency for both private use and commercial
job sites.

COPYRIGHT All information contained in this Manual is the
intellectual property of, and copyrighted material of TPS. All rights
are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without TPS’ express written consent and may only use such
information for the care and operation of your receiver. The
information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and
arrangement by TPS.
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Preface

TRADEMARKS Topcon, Topcon Link, TopSURYV, HiPer, GR-3, and
Topcon Positioning Systems are trademarks or registered trademarks
of TPS. Windows® and ActiveSync® are registered trademarks of
Microsoft Corporation. The Bluetooth® word mark and logos are
owned by Bluetooth SIG, Inc. and any use of such marks by Topcon
Positioning Systems, Inc. is used under license. Other product and
company names mentioned herein may be trademarks of their
respective owners.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD
ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE
RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY
OF MERCHANTABILITY OR FITNESS FOR ANY
PARTICULAR USE OR PURPOSE. TPS AND ITS
DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR
EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN;
NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
RESULTING FROM THE FURNISHING, PERFORMANCE OR
USE OF THIS MATERIAL OR THE RECEIVER. SUCH
DISCLAIMED DAMAGES INCLUDE BUT ARE NOT LIMITED
TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS
OF PROFIT, SAVINGS OR REVENUE, OR LOSS OF THE
PRODUCT’S USE. IN ADDITION TPS IS NOT RESPONSIBLE
OR LIABLE FOR DAMAGES OR COSTS INCURRED IN
CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS
OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR
ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO
LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY
OTHER PERSON OR ENTITY IN EXCESS OF THE PURCHASE
PRICE FOR THE RECEIVER.

LICENSE AGREEMENT Use of any computer programs or software
supplied by TPS or downloaded from a TPS website (the “Software”)
in connection with the receiver constitutes acceptance of these Terms
and Conditions in this Manual and an agreement to abide by these
Terms and Conditions. The user is granted a personal, non-exclusive,
non-transferable license to use such Software under the terms stated

viii Topcon Link Reference Manual



Terms and Conditions

herein and in any case only with a single receiver or single computer.
You may not assign or transfer the Software or this license without
the express written consent of TPS. This license is effective until
terminated. You may terminate the license at any time by destroying
the Software and Manual. TPS may terminate the license if you fail to
comply with any of the Terms or Conditions. You agree to destroy the
Software and manual upon termination of your use of the receiver.
All ownership, copyright and other intellectual property rights in and
to the Software belong to TPS. If these license terms are not
acceptable, return any unused software and manual.

CONFIDENTIALITY This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS’ Confidential
Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade
secrets. Nothing in this paragraph shall restrict you from disclosing
Confidential Information to your employees as may be necessary or
appropriate to operate or care for the receiver. Such employees must
also keep the Confidentiality Information confidential. In the event you
become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the
TPS website (or any other website) or in any other advertisements or
TPS literature or made by an employee or independent contractor of
TPS modifies these Terms and Conditions (including the Software
license, warranty and limitation of liability).

SAFETY Improper use of the receiver can lead to injury to persons or
property and/or malfunction of the product. The receiver should only
be repaired by authorized TPS warranty service centers. Users should
review and heed the safety warnings in an Appendix.

MISCELLANEOUS The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in
accordance with, the laws of the State of California, without reference
to conflict of laws.

P/N 7010-0522 ix
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Manual Conventions

This manual uses the following conventions:
Example Description

File » Exit Click the File menu and click Exit.
Connection Indicates the name of a dialog box or screen.

Frequency Indicates a field on a dialog box or screen, or a tab
within a dialog box or screen.
Enter Press or click the button or key labeled Enter.
g Further information to note about the configuration,
NOTE maintenance, or setup of a system.

Supplementary information that can help you
configure, maintain, or set up a system.

on system operation, system performance,
measurements, or personal safety.

Notification that an action has the potential to
adversely affect system operation, system
performance, data integrity, or personal health.

Notification that an action will result in system
damage, loss of data, loss of warranty, or personal

injury.

Under no circumstances should this action be
performed.

-
@ Supplementary information that can have an affect
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Chapter 1

Introduction

Welcome to Topcon Link, a full-featured data import/export and
conversion utility for Topcon instruments. Topcon Link contains
features and functions to perform the following activities:

 Import data files from all Topcon instruments.

» Convert all Topcon data files and many industry-standard data
files to corresponding file formats.

* Open and display data in easy to use tables and screens.
* Provide basic editing tools for some data types.

» Export an OAF to a Topcon GPS receiver, export coordinate files
to a total station, and export any data file to a TPS controller.

Topcon Link supports all Topcon file formats and an increasing
number of industry standard formats. Any format can be converted to
a Topcon format for export to a Topcon instrument. Many files can be
converted between third-party and proprietary formats.

P/N 7010-0522 1-1



Introduction

Installing Topcon Link

Topcon Link software comes either on a CD (as a standalone
application with TopSURYV software), and also available as free
download from the TPS website to install on a computer. The
InstallAware® Wizard will save the earlier versions of Topcon Link
already installed, and will install the latest version in the folder the
user selects.

<

The CD version of Topcon Link contains all projections,
datums and geoids. The version downloaded from the
Topcon web site comes without the projections, datums
and geoids. They will be downloaded from the Internet and
installed on our computer during the installation process.
Make sure that your computer has Internet access during
installation.

Table 1-1 lists the recommended system requirements needed to
install this software on a computer.

Table 1-1. Topcon Link System Requirements for Installation

¢ Microsoft® Windows XP/Vista ¢ 512 MB of RAM (1000MB
operating system recommended)

* Processor compatible with Intel® * 100 MB of available hard-disk space
Pentium® 1000 MHz or faster

Before connecting the receiver’s USB port to the computer’s USB
port, the TPS USB driver must be installed on the computer. The
driver is available on the TPS website:
(http://www.topconsupport.com/documents/view/1743).

1. Navigate to the Topcon Link executable file or insert the software
CD-ROM.

* If downloading the software from the TPS website, save the
downloaded compressed file to an accessible location and
extract the Topcon Link executable file.

¢ If downloading the software from a TPS software CD, insert
the CD into the computer’s CD-ROM drive.

1-2 Topcon Link Reference Manual



2. The InstallAware Wizard

InstallAware Wizard

starts up:

The Installdware Wizard is werifying the contents
woesn | OF this sekup package. This may take a moment.

]

Cance|

3. Click Next to start the installation process.

Installing Topcon Link

Check the ‘I accept the terms of the license agreement’ box, to
continue the installation (Figure 1-1). Type User Name and
Company Name information, then click Next (Figure 1-1)

I3 TopconLink v.7.3 - InstallAware Wizard

License Agreement
Please carefully read the following license agreement.

Please read this software license agreement carefully before pressing th
Having pressed the "Agree” button you are agreeing to be bound by the
by installng, copying, or athernise using praduct. If you do nat agree to
license, press the "Disagres” button and return the Tapcon software ta t
obtained ar get in kouch with your Tapeon distributer. TF you donnloaded]
from web site, just delete & from the computer.

1. Software License. All software and documentation accompanying this |
whether n disk, in read only memory, on any other media or in any othe
you by Topcon Postining Systems of its daughker enterprises, Your o,
the Topcon Software is recorded but the Topron licensars retain title ta t
The Topcon Software in this packags and any copies that this License Ag|
vou to make are subject to this License Agresment. Here and below undef
Software berm we mean all executive programs, documentation and it pal

[14 3rcepk the Ferms of the icense agreenent

&3 TopconLink v.7.3 - InstallAware Wizard

Customer Registration
Please enter information on yourself,

User Nam

Organization:

Topcon

(<o [ s ] [ el ]

Figure 1-1. Review License Agreement and Enter User Information

5. Select a needed setup type. Depending on the user’s selection,
either all program features or only highlighted features will be
installed. If the user selects Typical type and presses Next, the

installation software will do the following:

* automatically select all available datums and projections (except
the following Table Projections:

— rdtrans 2004 and rdtrans for Netherlands

— LB72 for Belgium
— KK/ for Finland

— USTNO?2 for United Kingdom)

P/N 7010-0522
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» display the next installation dialog (Figure 1-2)

(=]

&3 TopconLink v.7.3 - InstallAware Wizard

Setup Type
Chaose the setup type that is best For your needs, . .
4 TopconLink v.7.3 - InstallAware Wizard

Pl lect: tup b Destination Folder
co s b e Select Folder where setup willinstal files,

@ Typical Install TopcanLink v.7.3 to:
§ " Al program features will be installed, but without rex :\Program Fies|Topeon|TopeonLink_7_% o

datalike Geoids or Table Projsction, This sst of Feat | == | [creme.. ]

be the same as in previous version.

) Custom

Chaose which pregram features you want installed,
Recommended for advanced users,

Destination Folder
Required Disk Space: 81,370 KB

et Remaining Disk Space: 50,595 MB

[ < Back ” Mext = } [ Cancel

A B
Figure 1-2. Typical Setup Type

If the user selects the Custom type and press Next, the Custom
Setup dialog displays (Figure 1-3).

I3 TopconLink v.7.3 - InstallAware Wizard
Setup Type

Choose the setup type that is best for your nesds, ) )
I3 TopeonLink v.7.3 - InstallAware Wizard

‘ . Custom Setup
(Fleess s oz e, Choose the program Features you would live to install

O Iypical Click on an icon in the st below ta changs how a featureris installed.

All program Features will be installed, butf

Feature Descrption
et e Geoids or Table Frojection, This| | =~ =2 aobal A Gobel gecld EGM2008
b the same as in previaus version. X -
P " =L4 1
(%) Lustom = =] Asia
G T R =3 china
Recommendied for advanced users. =3~| Hong Kong
= =3] Japan
X -| Formats
=3~ | Malaysia
8- I:‘W‘a"d Required: 207,221 K
=9~ Thaian: *|| Remaining: 50,553 MB
< Back. < >

[ <Back ][ _met> | [ cancel

Figure 1-3. Custom Setup Type

<

The typical installation does not allow one to install a geoid
on the computer. As against of the typical installation, the
custom installation allows one to install the highlighted
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Installing Topcon Link

geoid for the corresponding projection(s)/datum(s) of the
given region.

The user can highlight only those features (projection or
projection and geoid), which needed for the given job area. Such
regional selection allows one to economize the computer’s disk
size.

This dialog box contains the list of projections:

R T i | Festure Desatiption
e with regional geOidS _I, ] France 1GN69, IGNTE, RAF3S
.Elv Geoic
or
- Feature Description
. . . e Projections: GERMANY-Betlin
 without regional geoids e, CERMANY,
GERMANY-Gauss Krusger
Germany BKG Geoid Format
or
Feature Deseriptian
. . . = g‘ Ehe”::i Praction | Projection: RDTRANS 2004
* with table projection e

The Feature Description displays the list projection(s)/ formats/
geoid(s) which consist the highlighted item. To see what the
feature contains, select the desired feature:

= | F— | Festure Desciption
=-|EIE Projections: GERMANY-Berlin
Soldner, GERMARY,
GERMANY-Gauss Krusger
Germany BKG Geoid Format

| Feature Description
Origial bin geoid *.01

=) 3 » | Denmatk
N (=14 G=cid

If the selected projection contains a list of projection(s) and a
geoid file format, Topcon Link will be installed with the selected
projection(s) and format for adding the corresponding geoid to
the Topcon Link (but not a geoid file). In the given case:

P/N 7010-0522 1-5
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— the Setup tab of the Coordinate System item of the
Configuration dialog box will display the installed geoid file
format in the list of geoid:

%3 TopconLink v.7.3 - InstallAware Wizard =]

Custom Setup
Choose the program features you would like to install

Click o an iconin the list below to change how a feature is installed.

[SEE= 14
=3~ | Formats
= _X_v| Table Projections
[

Feature Description
Projection: NETHERLANDS-RD:
Dutch 2004 Geoid Format

Lok in ||_J Gieowd _'_,' 1-|[|"|Jr‘|°=

Flarsns |

Fossal s [ Duch 2004 Geowd ard) j
| Cancel |

— the installed projection(s) will be displayed in the list of

Projection: CTEARDII7081s ~ Custom.
projections for conversion: ps TR

S| METHERLANDS
RD

If the selected projection contains a list of projection(s) and the
geoid, Topcon Link will be installed with the selected
projection(s), format for adding the corresponding geoid and the
corresponding geoid(s) into the user’s computer. In the given
case:

— the Setup tab of the Coordinate System item of the
Configuration dialog box will display the geoid file format in
the list of geoid and installed geoid(s):

= =3~ | Denmark
|

Feature Description
Original bin geoid *.01

K Configuration

splay Setup | Conversion |
oordinate Systems Geoids List
ave

Path Minimum Longit. .. | Maximum Lom
ciiprogram files... 6°00°00,00000E  17°00°00.000
ciiprogram files..,  B°00'00.00000W  6°0C°'00.000
cilprogram files...  75°00100,00000%  10°0C'00.000 ——
B nkgosa criprogram files... 1°00°00,00000E  33°00°00.000

=
ompute Coordinates
5 Computations
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— the installed projection(s) will be displayed in the list of

Fiscemma CTCAROST085 ~]  Cutom.. |
projections for conversion: ouun L §f5 CTCARON7005) el Lacdl

Eurcpe

+] DENMARK

To add/remove the desired regional projection or geoid to/from
the installing, click the desired feature and select the
corresponding command from the pop-up menu:

X Entire feature will be unavailable

The following rules is used for adding projection and geoid:

1. Itis not possible to highlight a geoid without highlighting
of the corresponding projection:

= K vI = QlelobaI
R Geoid or . Qvl GEni

2. Itis possible to highlight only the desired

projection: = g‘%, ecid

<

Without reference to the selected projection type, Topcon
Link installation will install all datums

If the user did not select any geoid file in the process of installation,
after finishing Topcon Link installation process it is possible to add
(using Configuration dialog box) only the following geoids (global
(*.glc), custom regional (*.rgm) and topcon geoid (*.jff and/or *.gff)
files):

Farmat name: ‘ Global Geoid [*.glc] j

T

am)
Topcon Geaid %, gff ;)

It the user selected some regional geoid file in the process of
installation, after finishing Topcon Link installion process it is
possible to add (using Configuration dialog box) only the following
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geoids (selected official geoid, global (*.glc), custom regional
(*.rgm) and topcon geoid (*.jff and/or *.gff) files):

Format name: | French RAFS8 Geoid [*mnt) j
ench (*.mnt)

Regional Geoid (*.rgm)
Topcon Geoid {*.gff;*.jfF)

<

Without reference to the selected projection/geoid type,
Topcon Link installation saves geoid(s), which were added
in the previous version to the geoid list

To add the desired geoid(s) or the desired projection(s) after
finishing Topcon Link installion process, the user needs to do the
steps is described in “How to add a feature after installation” on
page 1-10

To continue Topcon Link installation, click Next.

3. Either keep the default installation folder or click Browse to
select a different folder in which to install the Topcon Tools.
Click Next to continue (Figure 1-2 on page 1-4, picture B)).

4. If desired, type in a new folder in which to add program icons.
For automatically creating Topcon Tools shortcut check the
‘Create on Desktop’ box. Then click Next (Figure 1-4).

5. Click Next to start the installation process (Figure 1-4)
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6. Topcon Tools is installed on the computer (Figure 1-4)

I3 TopconLink v.7.3 - InstallAware Wizard

Select Program Folder

Select the location where you would like to create new shortcuts,
3 TopconLink v.7.3 - InstallAware Wizard
Setup il add program shorteuts ko the Program Folder listed bel

a new Folder name, or accepk the suggested name. Click Next to Completing the InstallAware wizard for

TopconLink v.7.3
Program Folder:

The Installaware Wizard is now ready to configure TopeonLink.

Install this application For: %.7.3 on this computer,

(%) Anyone who uses this computer (all users)

() Only For me (current user) - Click Kext to begin configuration

- Click Back ko change settings

23 TopconLink v.7.3 - InstallAware Wizard |TH§\ X

Installing TopconLink v.7.3
The program Features you selected are being corfigured,

o Flease wait while the Installiware Wizard instals TapeonLink v.7.3. This
|'§\:l may take several minutes,

- Click Cancel to exit

Shatus: < Back. “ et > ] [ Cancel

Downloading Web Media: EGM2008
39,452,672 bytes received, 41% complete

Cancel

Figure 1-4. Select Program Folder and Installation Progress

Click Finish to exit the installation.

8. Before the user can use Topcon Link, we recommend restarting
your computer.

9. Create a shortcut on the computer’s desktop for easy access
(Figure 1-5).

A piLifik]

TeEEEm Lk

Figure 1-5. Topcon Link Desktop Shortcut
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How to add a feature after
installation
The user can add any features from Custom Setup window after

finishing Topcon Link installion process and restarting Windows. To
do it, make the following steps:

1. Click Settings » Control Panel » Add or Remove Programs

2. Select Topcon Link v.7.3 in the Add or Remove Programs and
click Change (Figure 1-7):

B Add or Remove Programs

~

=1 )

ﬁ Currently installed programs: T show updates Sort by
Change or 2
Remove I3 TopconLink v.7.3
Programs _

% Las 101
Add New y S Change =
Programs e —

Figure 1-6. Add and Remove Programs

3. Select Modify Available Options and click Next (Figure 1-8)

= TopeconLink v.7.3 - InstallAware Wizard

& Welcome to the InstallAware Wizard for
8 TopconLink v.7.3

Plzase choos & mainkenance operation ko perform:

© Madiy A

() uninstall

To continue, click Next.,

Figure 1-7. InstallAware Wizard
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4. Highlight the desired features (projection or projection and geoid)
in the Custom Setup window (Figure 1-9)

= TopconLink v.7.3 - InstallAware Wizard

Custom Setup
Choose the program features you would like to install.

Click on an icon n the list below to change how a featurs is installed.
Feature Description

= = x| Gobal ~
- | Geoid
~| Geoidzooz

= 2 | Asia

Prajection: CH3

Eli

o Le—
— = wilbe

o C E98 Entire

i

Hu

Figure 1-8. Custom Setup Window

Installing Microsoft
ActiveSync for Use With
CE-based Devices

ActiveSync® is free software from Microsoft® that establishes a
connection between a computer (with operation system Windows XP)
and an external device. ActiveSync is used for file transfers and
software downloads between a computer and mobile device running
the Windows® CE operating system, such as a hand-held controller
or CE-based Total Station.

After installing ActiveSync, it will be associated with a port on the
computer. This means that the port will be considered “busy”, and
may need to be freed up for use with other devices.

ActiveSync will start automatically when connecting a CE-based
device (such as, Topcon’s FC-120/FC-200/FC-2000/FC2200/FC2500,
GMS-2/GMS-2Pro, or GTS-720/GTS-750/GPT-7000/GPT-7000i/
GPT-7500/GPT-9000).

1. Log on to the Microsoft website (www.microsoft.com) to
download ActiveSync. Install the program onto the computer.
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2. After installing ActiveSync, start the application and click
File » Connection Settings. Apply the following settings based on
the number of ports on the computer (Table 1-2).

Refer to the help topics in ActiveSync for more

details on connecting with devices.

Table 1-2. About ActiveSync Connection Settings

ActiveSync Settings for Computers
With One Port

ActiveSync Settings for Computers
With Two or More Ports

If using a port for multiple purposes,
select either “Work Network” or “The
Internet”. In this case, ActiveSync will
free up the port for other uses after
disconnecting a device.

@ Connection Settings E‘

Waiting for device to connect
Connect

[V Show status icon in taskbar
I¥ Allows USB connections

[~ Allow connections to one of the Following:

T

This computer is connected to:
I Automatic hd I

¥ Dpen ActiveSync when my device conhed

Heln

wiork Metwark k

The Internet

If multiple ports are available, the
default settings are sufficient. In this
case, ActiveSync will retain use of the
port after disconnecting a device.

If using a USB cable to connect the
device to the computer, select the option.

& Connection Settings El
Waiting for device to connect
Connect.
¥ Show status icon in taskbar
W Allow USB connections
W Allaw cornections to one of the following:
COM1 -
This computer is connected to:
Automnatic hd
V¥ Open ActiveSync when my device connects

If the user's computer operates under Windows Vista,
ActiveSync is not needed. A connection between the
computer and an external device with Windows CE will be
automatically established after connecting your device to

your PC.
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Getting Acquainted

The Topcon Link interface is designed for easy, integrated use with a
PC-compatible computer, a connected Topcon instrument, and
industry-standard data types. The following sections introduce the
various functions available in Topcon Link for transferring, viewing,
configuring/converting, and editing data files.

Main Screen

The main screen has the following components (Figure 1-9):

* Title bar — contains the program name and the name of the
currently active file.

* Menu bar — contains drop-down menus for all functions.
* Toolbar —contains shortcut buttons to frequently used functions.

* Work area — displays dialog boxes, job file information, and pop-
up menus.

* Status bar — displays informative messages about Topcon Link
and various files, as well as pop-up boxes for quickly changing
units and coordinate systems (inactive if no file is open).

] Topcon Link

Toolbar Menu Bar Title Bar

Work Area

Status Bar

Ready | USFest | DMs | Grid | SPCE3-Maryland Y

Figure 1-9. Topcon Link Main Screen Components
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The menu bar (Figure 1-10) provides access to all available options.

File Edit

Wiew Add Process  Window  Help

Figure 1-10. Topcon Link Menu Bar

Table 1-3 briefly describes the functions in each drop-down menu.

Table 1-3. Topcon Link Menu Options

Menu Functions
File menu opens and saves a file
imports and exports data from a device
Open File... O
e e converts a file from one format to another
Inuport From Device. . Shift+F3 Compatible format®
Export ko Device... Shift+F4
ComertFle... s prints information from an active file
Print... Cr+P
Print Previzn displays configuration parameters
Page Setup..
Configraton... iz displays file properties
o Preparios. displays recently accessed files
1 PROJECT RTK tisy
B closes Topcon Link
Edit menu allows an undo or redo of the last operation
cuts, copies, or deletes selected data
adds a point
cut chrl+x . .
oy ChileC displays the properties for selected data
Delete Del
Properties... Ctrl+Enter
View menu displays or hides the CAD view and/or layers

v Toolbar

v Status Bar

v CAD View  Chrl+K
Layers Chrl+d

Zoom 3
Pan Mode

Options 3

view

displays or hides the Topcon Link toolbar and/
or status bar

sets the pan or zoom mode

sets view options for the tabular and CAD
views

Add menu

Add
Pairk... Ctrk,

adds a point

Process menu

ompute Coordinates F&

Process Properties...  Al+CErHP

computes coordinates
sets processing properties

1-14
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Table 1-3. Topcon Link Menu Options (Continued)

Menu Functions
Window menu ¢ closes the current window or all open windows
Ml wie | ¢ arranges open windows in a cascade (stacked)
Close Al or tile (adjacent) order
Cascade .
Tile Wertically ¢ arranges icons
Tile: Harizontally
ferange lcons * shows all open windows, and selects a window
1 CAD View .
v 2 CtiMy DatalPROJECT RTK.Hsw <TopSURY PC Job to be aCtlve
Help menu * accesses the Topcon Link context help
@ * accesses customer feedback options for
Fezdback g sending bug reports and questions to TPS
About Tepeon k... support, and accesses the TPS website

* displays version, publisher, and build date
information for Topcon Link

a. Compatible formats - the formats containing the common data

Toolbar

The toolbar for Topcon Link (Figure 1-11) contains buttons for
frequently used functions.

B HE|FR &S0 > EBE|Laaa a MIHRK
Figure 1-11. Topcon Link Toolbar

Upon startup, the toolbar displays beneath the menu bar. To display or
hide the toolbar, click View » Toolbar.

Table 1-4 describes the various buttons available on the toolbar.

Table 1-4. Topcon Link Toolbar Button Functions

Button Description

- Open File — Opens an existing file.
(- 1. Click the button to display the Open dialog box.
2. Navigate to and select the desired file.

3. Click Open.

Save — Saves a file to the current directory.

Save As — Saves the current file with a new name and/or in a new
ﬁ directory and/or to save in other compatible format.
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Table 1-4. Topcon Link Toolbar Button Functions (Continued)

Button Description
3 Import File from Device — Imports files from TPS GPS+ receivers and
i memory cards, TPS controllers, TPS Total Stations (CE-based, robotic,
conventional), or TPS digital levels
See Chapter 4 for details.
" Export File to Device — Exports data to a TPS controller or Total Station
& (CE-based, conventional, robotic), and exports an Option Authorization
File (OAF) to a TPS receiver.
See Chapter 8 for details.
B3 Convert files between formats — Converts data in a file from one format
G to another compatible format.

See “Converting A File” on page 5-2 for details.

Print — Prints the current window or table.

Undo — Reverses the last action.

Redo — Returns the last action.

Cut — Removes the selected object(s).

Copy — Copies the selected object(s).

Add point —Adds a point to the current file.

1. Click the button to display the Add point dialog box.

2. Enter the point name, coordinates, and codes for the new point.
3. Click Ok.

See “Add a Point” on page 6-1 for details.

Zoom In — Changes the pointer to a magnifying wand for zooming in on
a clicked area of the CAD view. You can also click and drag a square
around the area to zoom in on.

Zoom Out — Changes the pointer to a magnifying wand for zooming out
on a clicked area of the CAD view. You can also click and drag a square
around the area to zoom out on.

Zoom back — Returns the CAD view to the previous zoom
magnification.
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Table 1-4. Topcon Link Toolbar Button Functions (Continued)

Button

Description

A

Restore All — Fits all data in the active CAD view into the viewable
extents of the view.

&

Pan — Changes the pointer to a “hand” with which to “grab” and
dynamically move the CAD view.

CAD View — Available for TopSURV PC Jobs, displays design data
(points, linework, roads, and surface).

Compute coordinates of points — Calculates the point coordinates in the
current file.

See “Computing Point Coordinates for Raw Data and TopSURYV Files”
on page 7-1 for more details.

Context Help — Displays a pop-up tip with information about the
selected view, button, field, etc.

1. Click the button. The pointer changes to a question mark.

2. Click the object you want additional information on. A pop-up tip
gives further information.

3. Click outside the pop-up tip to close it.

Status Bar

The status bar (Figure 1-12 on page 1-18) displays:

* various informative messages about current Topcon Link
activities and opened file.

* the information boxes provide quick information about the
current linear/angular units and coordinate type/system used in
the file. These boxes also provide drop-down lists for quickly
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converting the linear or angular units used in the file, or the
coordinate type or system used in the file.

Graurn ¥

Dratum Lat, Lon, EILH

USFee »

Linear Units | Coordinate Type

WiE554 Lat, Lon, EILH
Daturn Lak, Lon, Elevation

Ready USFeet | DMS | Ground | PROJECT RTE.tsv Localization

/

[ PROJECT RTK Hsv Localiz: = |

Africa

Asia

Australia and Mew Zealand
Canada

Europe

Middle East
Coordinate System Mane
PROJECT
South Ametica
UPs

Usa
UTMMorth
UTM3auth

Angular Units

F- - - F-F -

F-[- - [

Figure 1-12. Topcon Link Status Bar

TPS Device Directories in Windows
Explorer

The Topcon Link installation process also installs device directories
on the computer’s hard drive (Figure 1-13). These directories are used
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to easily access data on a connected device for import/export
activities.

% My Computer, g@@‘
"l"

File Edit View Favorites Tools Help

QBack - & ﬁ /.7" Search s Falders El'

Address | 5 My Computer v a Go

Folders x Hard Disk Drives

@ Desktop
£ D My Documents g g
= _J My Computer
4 5 314 Floppy (A:)
+ % Local Disk (i)
% Local Disk (D:)
b O Drive (E:)
b DVD-RW Drive (Fi) H 4 _) r )
El Mobile Device = ) :‘y

+
+
+
+
* 4& Topcon Digital Levels
&3
3
+

Local Disk (C:) Local Disk (D)

Devices with Removable Storage

3% Floppy D Drive (E:) DVD-RMW Drive
B Topcon Memary Cards (&) .

£ Topcon Receivers
& Topcon Total Stations oth
er
# W My Network Places —

#| Recyde Bin
’ & g D -
L] E = =
Topcon Topcon Mobile Device  Topcon Digikal  Topcon Total
Receivers  Memary Cards Levels Stations

Figure 1-13. Topcon Device Folders in Windows Explorer

On computers with Windows XP, the “Mobile
Device” folder displays after installing Microsoft
ActiveSync.

On computer with Windows Vista, the “Windows
CE” folder automatically displays after connecting
a external device with Windows CE.

This device directory displays the contents of the
connected TPS controller or TPS CE-based total
station.

After connecting a device to the computer, open Windows Explorer
and navigate to the My Computer window. Click the device icon/
directory to transfer data files.

Because some devices require special settings or
setups to use this feature, see the appropriate

section in Chapter 2 for more details.
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Sending Feedback and Bug
Reports to Topcon Support

The Feedback option in the Help menu offers a way for you to
provide feedback. An option to connect directly to the Topcon GPS
website is also available. These options require Internet access.

To send a bug report:

Click Help » Feedback » Send Bug Report. An email opens
with short descriptions of the current version of Topcon Link and
OS of the computer, and log files for Topcon Link are
automatically attached. Describe activities being performed when
the “bug” occurred and send the e-mail to TPS Support:

® Topcon Tools Log File - Message (Plain Text)

A lALB L U = = i i
iigend | A | B2 0 W8 =t §|v (] ot A

i Fle Edt Wew Insert Format  Tools  Actions  Help

=SMTP:topcontechnicalsupport@topcon, com <topcantechnicalsupport@topeon, com:

Subject: Topeon Tools Log File

Attach... | Messagel oq.xml (50 kB); [F Messacel o smlovey (52 k8

Enter you comment here

AppInfo: Topcon Link v.7.3 build data is Mondsy, August 10, 2009
Languagye: 0x409
0%: Microsoft Windows XP Professional Service Pack 3 (Build 2600)

Figure 1-14. Example E-mail for the Send Bug Report Option
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To ask a question:

Click Help » Feedback » Question To Support. Enter any

questions, describing activities in detail, and send the email to

TPS Support:

E¥ Question to Support - Message (Plain Text)

- las U=

=

I File Edit Wiew Insert Format Took  Actions  Help

EEX)

Pigend |H G 4 0B (20 W& 4T ulH&\domms ey

as not been sent.,

To... =SMTP;topcontechnicalsupport@topcon, com <topcontechnicalsupporb@topcon, com:

e |

(o |

Subiect: | Question ta Support

[Enter you comment here

AppInfo: Topeon Link v.7.3 build data is Monday, August 10, 2009

Language: 0x409
05: Microsoft Windows XP Professional Service Pack 3 (Build 2&00)

Figure 1-15. Example E-mail for the Question to Support Option
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Notes:
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Chapter 2

Setting up Topcon Link
for Transferring Data

Topcon Link provides two methods for transferring data between the
computer and a connected device: via the Topcon Link interface or
the installed directories in Windows® Explorer. See “Adding and
Formatting Devices” on page 2-1 for a quick look at what each device
requires for data transfers.

 For Total Stations and Digital Levels, the instrument’ information
and connection parameters must be set up before it’s files can be
viewed. The instrument setup will only need to be done once per
computer.

* For Topcon Memory Cards (flash cards used for data storage in a
TPS receiver), the card must be formatted before data can be
recorded. The card will need to be formatted once.

Adding and Formatting
Devices

Depending on the device, an initial device setup may be required
before a successful data transfer can be completed. The following
table briefly describes the setups required for transferring data
between a computer and a connected device (Table 2-1 on page 2-2).
See the sections below for specific details.
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Setting up Topcon Link for Transferring Data

Table 2-1. Setups Required for Connected TPS Devices

TPS GPS Receivers

No further setups are required.
After searching for connected
GPS receivers, an icon for the
receiver displays. Click the
icon to view the receiver’s data
files.

File Edt ‘View Favortes Tools Help &
Qe - @ - (T O search |[2 Folders
address |2 HIPER v B
Folders x ‘ Ia B Ia

53 TL_Data ~

{2 Topcon Link Dats @wmtps logD10ictps  logdlole tps

@ Topcon Todls Data \M;n}{m tns
p | &

Sokkia GPS Receiver

Parameters for the Sokkia
Receiver must be set up using
Windows Explorer or the
Topcon Link Import function.

See for details“Adding a
Sokkia GPS receiver” on
page 2-3.

Address |=— New Sokkia receiver

%[ 00140610, pde
] 10_07_09.pde
a staticl.pde

Folders

@ Deskkop

D My Documents

B 4 My Computer
“e* Local Disk (C:)
= Sokkia receivers

= New Sokkia receiver

& Topeon Digttal Levels
B Topeon Memary Cards
& Topcon Receivers
& Topcon Total Stations

TPS Controllers

Microsoft ActiveSync needs to
be installed on the computer
with Windows XP. For details,
see “Installing Microsoft
ActiveSync for Use With CE-
based Devices” on page 1-11°.

After connecting to the
controller (via ActiveSync for
computers under Windows XP,
or without ActiveSync for
computers under Windows
Vista), navigate to the
Compact Flash or Storage
Card card and the desired job
file.

for computer under Windows XP

% Jobs =13
.'f

File Edit Wiew Fawortes Tooks Help

eBack - Q - \ﬁ’ /-‘ISearch

Address | ) \CF Card|TPS{TopSURY\Jobs

I.B Folders

B> L=

Folders

= [ Mobile Device ~
() Application Data
) CF Card
SRS 0
123 TopsURY
3 Jobs v

for computer under Windows Vista

& Topcon Total Stations ~ | [l Defaultts)
¥ WindowsCE & MERRELLWEST tlsv
= Storage Card || MERRELLWEST £5j
Archive
Backup

BkFlash
Topcon Receiver Utility |2
TPS

TopSURV
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Table 2-1. Setups Required for Connected TPS Devices (Continued)

TPS Total Stations

Parameters for the total station
must be set up using Windows
Explorer or the Topcon Link
Import function.

See “Adding a Total Station
Device” on page 2-6 for
details.

| ] Topcon Total Stations

File Edt View Favortes Took  Help "
o ®) =

@ mack + () \? ) search | [ Falders

address | & Tapeon Tatal Stations v B

Folders X

4 Topcon Digital Levels ~
&) Topcon Receivers
& Topeon Total Stations
& 1y Metwork Places
# Recyrls Bin
My Eluetaoth Places

Delate g

Properties

2l

TPS Digital Levels

Parameters for the digital level
must be set up using Windows
Explorer or the Topcon Link
Import function.

See “Adding a Digital Level
Device” on page 2-8 for
details.

8% Topcon Digital Levels

File Edit View Favortes Tools  Help "
o @) =
Qe - ) (T SO search [ Folders
Adtress |4 Topean Digial Levels v B
Folders &5 i
L
& Topeon Digtal Levels -

Copy
Paste

Delete !

Properties

&) Topcon Receivers

& Topeon Total Stations
& My Hetwork Places

# Recycle Bin
My Bluetooth Places |

Memory Cards

The receiver’s memory card
must be formatted as a
“Topcon Memory Card”.

After connecting to the
computer’s card reader, the
memory card icon displays as
red or gray.

* A red icon indicates
compatible formatting.

e A gray icon indicates
formatting is required. See
“Formatting a Topcon
Memory Card” on page 2-
11 for details.

Fle Edt Wew Favorktes Tools Help

[ Folders

Qe - O ¥ /f‘l Search
Adress [ B 1;
Folders %
= M Topcon Memary Cards Pe-CoU Pe-COU
A log0S0Sa.tps  log0S0Sh.tps

Adding a Sokkia GPS receiver

Before Topcon Link or Windows Explorer can read data on a Sokkia
GPS receiver, the device must be added to the directory.
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1. Navigate to the Sokkia Receiver device directory (Figure 2-4 on
page 2-6).
* From Topcon Link — Click File » Import from Device. In the
left pane, double-click the Sokkia Receiver directory.
* From Windows Explorer — Open the My Computer window.
Double-click the Sokkia Receiver directory.

The procedure will be the same whether using Topcon Link or
Windows Explorer.

2. Double-click Add New Sokkia receiver (Figure 2-4).

W Sokkia receivers

File Edit View Favortes Tools Help

eBa:k M | 1? /qJSsarch

Address ‘!' Sokkia receivers

H_" Folders

Folders 2
@ Desktop
B MMy Documents
a :{ Iy Camputer
= Sokkia receivers
& Topcon Digital Levels
B Topcon Memory Cards
-‘ﬂ Topcon Receivers
= A 1o ;

iy Al News Sokkia receiver

] Import from Device

Lookin  [w Sodkiarscavers  v| 4 || 2] Lookin [ From_Sokkia_receiver = | 4= | | £

== add Mew Sokkia receiver

|

¥ Open Files after Import

Close

Figure 2-1. Add a New Sokkia receiver

3. On the General tab, enter and select the following information
(Figure 2-5 on page 2-7):
* Name — enter a unique name for the device
* Port — select the COM Port the device typically connects to

e Baudrate - select the baud rate for communication with the
Sokkia Receiver

* Device — enter the receiver type

4. On the Advanced tab, select the parity, byte size, stop bits, and
the way of the handshake for communication with the Sokkia
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receiver (Figure 2-5). Refer to the Sokkia receiver’s
documentation for details.

Create Sokkia receiver rg|
General Mdvanced] Create Sokkia receiver E‘
Name:
[New Sokkia receiver Gererl Acvanced |
Parity:
Port:
(oo = [Mane |
Baudrate: |B:E b J
9600 -
| =l Stop bits:
Device: 1 =
‘HADIAN 5 j Handshake:
NONE >
\ -
RTS/CTS
DTR/DSR
oK Cancel | | onalt
i3 Carcel | ‘

Figure 2-2. Enter New Sokkia Receiver Information

5. Click OK to save device information to the computer. When
connecting to this device, you will select the created device.

Address ‘P Sokkia receivers

Folders b
-
@ Desktop
() my Documents Add Mew
Sakkia...

= :} My Computer
e Local Disk (C:)
(=) == Sokkia receivers
== New Sokkia receiver

= Import from Device

£} Topcon) = . B =

Laok in: - Look in: From_Sokkia_ «|
2 ool o[ ERIIIREIE =] | ]| S on sotia_-| | E1] ]
= Add Mew Sokkia receiver
== New Sokkia receiver

|

¥ Open Files after [mpart

Clase

Figure 2-3. Created Sokkia Receiver for Import
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Adding a Total Station Device

Before Topcon Link or Windows Explorer can read data on a Total
Station, the device must be added to the directory.

1. Navigate to the Total Station device directory (Figure 2-4 on
page 2-6).
* From Topcon Link — Click File » Import from Device. In the
left pane, double-click the Topcon Total Station directory.

* From Windows Explorer — Open the My Computer window.
Double-click the Topcon Total Station directory.

The procedure will be the same whether using Topcon Link or
Windows Explorer.

2. Double-click Add New Station (Figure 2-4).

L ] Topcon Total Stations EWEWE\
#

File Edit Wiew Favorites Toals  Help

0 Back - >} l_ﬂ' /- ) Search u Falders
Address | & Topcon Tokal Stations v| €0
Falders X | Name |

@ Deskkop *M
urJ My Documents

= j My Computer

J4 3% Flogmm

e Local i H Import from Device

‘-'T Local D | ok in & Topeon Tatal St » ﬂ Lok ir: BMP Documents v ﬂ@
b D Dx - .

L DvDR ERadd \I (C3) TopeonLink

[ Mobile My Music

& Topcon (12} My Pictures

(MY Received Files
(LMY Templates
™y videos

My Webs

() New Folder

a Topcon|
&) Topron)
% Topcon|
& My Hetworl

|

W Open Files after Import

J

Clase

Figure 2-4. Add a New Station

3. On the General tab, enter and select the following information
(Figure 2-5 on page 2-7):

* Name — enter a unique name for the device

* Notes — enter any necessary notes
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* Port — select the COM Port the device typically connects to
¢ Model — enter the model number
4. On the Advanced tab, select the baud rate, parity, data bits, stop
bits, and protocol used for communication with the Total Station

(Figure 2-5). Refer to the Total Station’s documentation for
details.

Create Station

General I Addvanced |

Name:

Mate:
- e Paiity: [None [=]
Data hits: i
Maodek lGPT2omm | g -
Stap bits: |1 j
Protocol [ackMack El
’W Cancel ‘ |

Figure 2-5. Enter New Total Station Device Information

5. Click OK to save device information to the computer.
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When connecting to this device, you will select the created device
and then follow the instructions on the Total Station.

| Topcon Total Stations El@l@\
File Edit “iew Favorites  Tools  Help :,'
@ Back ~ () LjT p. ) search “_" Folders

Address | & Topcon Total Stations "| Go
Folders * | Name

(B} Desktop &+Add New Station:

urJ My Documents £ GPT3005W

= ' My Computer

; ERUE 3 Import from Device El@l
S Local Df

% LocalpfLook i | & Topcon Tatal St - ﬂ Lookin:  |LAMy Documents ﬂ@
3 ]
- ;\[:DD: & +idd New Station () TopeonLink
1 VDR [ G o '
-4 =) My Music
@ mabile A

uﬂMy Pictures
(MY Received Files
(LMY Templates
™y videos

My Webs

() New Folder

o2 Topcon|
B Topcor)|
&) Topron)
& Topeon|
& My Metwor

|

W Open Files after Import

Clase

J

Figure 2-6. Created Device

Adding a Digital Level Device

Before Topcon Link or Windows Explorer can read data on a Digital
Level, the device must be added to the directory.
1. Navigate to the Digital Level device directory (Figure 2-7).

* From Topcon Link — Click File » Import from Device. In the
left pane, double-click the Topcon Digital Level directory.

* From Windows Explorer — Open the My Computer window.
Double-click the Topcon Digital Level directory.

The procedure will be the same whether using Topcon Link or
Windows Explorer.
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2. Double-click Add New Digital Level (Figure 2-7).

™ Topcon Total Stations

File Edit ¥iew Favorites Tools Help ,'
o @) =

e Back </ Lﬁ: 7 search u;_ Folders

Address |1‘ Topean Digital Levels b | Go

Folders £8

@ Deskiop

G My Documents

=] ;J My Computer
J 31 Flg =T i
PP kA Import from Device

""_ Local Df | ook in: |« Topeon Digital L ﬂJ Logkin |[LMy Documents ﬂ@
ol L~

L DYDR! (C TapeonLink

@ mobile Ay Music

& Topcon (2 My Pictures

(C)My Received Files
[C3My Templates

B Topeon|
#) Topeon)

|

% Topcon| ™ty videos
ﬂ My Metworl My Wehs
New Folder

¥ Dpen Files after Import

Close

Figure 2-7. Add a New Digital Level
3. On the General tab, enter and select the following information
(Figure 2-5 on page 2-7):
* Name — enter a unique name for the device
* Port — select the COM Port the device typically connects to

* Baud rate and Parity — select the baud rate and parity used for
communication with the Digital Level. Refer to the Digital
Level’s documentation for details.
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Create Digital Level

General 1

Mame:

[pL-103
Part:

Baudrate:

|comM1
Parity:
Even

| 5600

-

=]

Ok b Cancel |

Figure 2-8. Enter New Digital Level Device Information

4. Click OK to save the device information to the computer.

When connecting to this device, you will select the created device
and then follow the instructions on the Digital Level.

# Topcon Total Stations

M 3% Flol
“e* Local D
<o Local Dy
b DD
b DVD-R!
@ mobile
o2 Topcon|
E Topcor)|
&) Topron)
& Topeon|
‘g My Metwaorl

= Import from Device

Look i [ Topeon Digial L +| &= ] |

File Edit Wiew Favorites Tools  Help i
e Back v () Lﬁ: /“ ) Search uﬁ‘ Folders
Address |‘ Topcon Digital Levels b | Ga
Falders X | Mame |
[ Desktop 4 Add New Cigital Level
153 My Documents 8 0L-103
= 4 My Compute

g DL-103

2 Add New Digital Level

|

¥ Dpen Files after Import

J

Lookin: LMy Documents = ﬂ@

() TopeonLink
My Music

ﬂMy Pictures
(C)My Received Files
[C3My Templates
Ay videos

My wWebs
(CNew Folder

2-10

Figure 2-9. Created Device
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Formatting a Topcon Memory Card

Before Topcon receiver can record data to a Topcon Memory Card the
card must be formatted. Formatting a Topcon Memory Card prepares
it for data recording.

* A card removed from a Topcon receiver has already been
formatted. The device icon is red.

¢ A card from another device will need to be formatted before
being used with a Topcon receiver. The device icon is gray.

@ Formatting an SD card will erase all data.

If a Topcon Memory Card is already installed in a Topcon receiver,
the device will have formatted the card. For some devices—such as
the GR-3 and NET-G3—the card can be manually inserted and
removed. While cards typically remain in the receiver once inserted, it
can be removed for accessing via a card reader connected to the
computer. The length of time required to format a card depends on the
size of the card and the device formatting the card. For example,
Topcon Link formats a card in a couple of minutes while the GR-3
can take around half an hour.

1. Navigate to the Memory Card device directory (Figure 2-7 on
page 2-9).
* From Topcon Link — Click File » Import from Device. In the
left pane, double-click the Topcon Memory Card directory.

* From Windows Explorer — Open the My Computer window.
Double-click the Topcon Memory Card directory.

The procedure is the same whether using Topcon Link or
Windows Explorer.

2. Right-click the gray card icon and click Format (Figure 2-7 on
page 2-9).

3. Click Format to format the flash card for access by Topcon
programs (Figure 2-7 on page 2-9).
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@ Topcon Total Stations

Fle Edit View Favortes Tools Help

eBack @ d L’; /:\J Search ‘H? Folders

Address |B Topcon Memary Cards V‘ Go
Falders X | Hame |
@ Desktop B Open

B My Documents
=] & MMy Computer
3 g .
e Local A Import from Device

Look in: T M -| &
] B opcon Memary JJJ
BE Open

i Hormat flashcard LY

(Hry
Iy

Capacity

= &
I

)My | File system
ity
€ My Netw) [cam
[CIMe

i

[¥ Dpen Files after Import

Close

Figure 2-10. Format Memory Card

When selecting a formatted memory card device, you will view its
data in the corresponding screen/pane.

# Topcon Total Stations

File Edit Wiew Favorites Tools  Help ,'
- ) @,

e Back </ L.I: - search f[\_" Folders

Address | a Topeon Memory Cards b Ga

Folders X | Name [

[ Desktop B

@ My Documents

= My Computer
;_i fﬂ"::; A Import from Device |?|E|
o tocalnfLosk i | BTcpeon Memery ~| 4= 1] 1] Lackin: [y Docurerts ~| =] 3] 2]
& (D Dri
Z DVD-R & g:jﬁﬁnk
@ mobile (24 My Pictures
%2 Topeor| LMy Recsived Files

B Topcorn)|

|

(LMY Templates
&) Topeon| My videos
& Topeon| (@1y Webs
& My Metwor (CNew Folder

W Open Files after Import

Clase

J

Figure 2-11. Formatted Memory Card Device
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Adding a Geoid

When working with data in Topcon Link, a geoid may be required to
ensure correct elevation of the GPS network points. A geoid
transforms the ellipsoidal heights measured by GPS to heights based
on a physical reference surface. When working with coordinate data,
you may want add a geoid, or you can create a regional geoid.

ST

Make sure:

- the geoid used to take point measurements is
loaded into Topcon Link before opening a file

- the geoid covers the area where file’s points are
located

- the geoid used to take point measurements is
loaded into Topcon Link before opening a file

The orthometric heights will be equal to ellipsoidal
heights if a geoid file is not downloaded to Topcon
Link and/or the geoid does not cover the area where
file’s points are located and/or if the geoid used to
take point measurements is missing.

1. Click File » Configuration and click Coordinate Systems in the

menu tree.
2. Click Add.

%2 Configuration

Geoids List Add m
B Tron | Name | Path Winimum Longitude | Minimum Lat
Process
[E5] Compute Coordinates Add k
15 Camputations -
Remave
& S
oK Cancel ‘

P/N 7010-0522

Figure 2-12. Add Geoid
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3. Navigate to the location of the geoid and select the format of the
geoid.

4. Select the desired geoid and click Open.

&4 Open E] E]
Leoeaim |E3 GlcbalGiesis EEEE
&4 Open ‘E| (E

Il files (*.*) et |lﬂﬁluha\ﬁemd j ﬂ@
= 27 Alfiles {* ¥

fustralian Geoid Files (s* dat)
Canadian Gevid Files (*.byn;* bin}
Dukech2004 Gevid Files (*.qrd)
Geoidd9)Geaid2003 Files (g bin}
GevidDenmark Files [*.01)
GeoidFrenchs RAFD Files (*.mnk)
GevidSwedish Files (Swen*Lgrd)
GeoidSwissZ004 Files (¥ agr)
Global Geoid File (* glc) [%
Mexican Geoidd? Files (*.geo)
Norwewgian Geaid Files {*,bin)
Regional Geoid Model Files {*.ram}

File name: Topeon Gead files {*.gff;*.Jif)
Format narmne: ‘ Global Geaid File [*.gls)
Cancel File name: [Egm3E.gic
Fomat name: [ Giobal Geaid File (:gi) -
Open [% | Cancel ‘

Figure 2-13. Select Geoid Format and Geoid

5. Repeat these steps for any other geoids. The geoids will be listed
in the right pane (Figure 2-14).

Geenids List

Tcon | Mame | Path | Minimum Longit... | Minimum
W EcMIs CHTOP... 190°00'00.0,,,  90°00'00.C

T Computs Coordnates ® gzonzunt DifGeoi. . 130°0000.0.,,  40°00000.0 Add
75 Computations W gzonsunz D:yGeoi... 11300000, 40°00000.0
B geonzuns DilGeoi. .. 26°00000.00.,.  40°0090.0
W gzonuns D:yGeoi... FORUOOOO0.. 40900000
W gzo0auos DiyGeoi. . 130°0000.0,,,  24°00000.0

Remaove

< | X

Figure 2-14. Added Geoids

6. Any Geoid from the list will be automatically used when Topcon
Link opens files.

7. Click OK to save the configuration and exit.
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About Geoids

A geoid model is used to transform the ellipsoidal heights measured
by GPS (purely geometrical) to heights that are based on a physical
reference surface, such as mean sea level. Over small regions there is
little difference between the two reference surfaces, but for large
projects the differences may be unacceptable. Working with a geoid
model when surveying with GPS will ensure proper point
measurements.

Geoid models for the United States have been developed by the
National Geodetic Survey (NGS). The most recent model is called
Geoid 2003. To keep the file size smaller, the continental United
States is divided into a grid with eight zones; each zone has a geoid.
Use Figure 2-15 to help you determine the geoid file to use for your
project. For Geoid 2003, the files are numbered “g2003u01” to
“22003u08” to correspond to grids 1 to 8. For other regions, or if you
have questions, contact your local representative or Topcon Support.

Grid #1 ) Grid #2
58-40N&111-130W | 58-40N&94-113 W

Grid #3
58-40N & 77 -96 W

Grid #4
58-40N &60-79 W

Washington

1
North Dakota !
Montana Minjesota 1
1

50 - |- -]

Wisconsin

South Dakota

1

1
Oregon Idaho Michigan J_ _!
1

Wyorming

owa
Nebraska | one | ped
N
40 = Nevada
e Colorado wva A
Kansas Missouri 1
Kentucky Vilgini:
California
Tennesee North C:
-} - Okiahoma | Ark
1 Arfona | New Mexico o]
1 Miss. | Ala. | Georgia
1
! Texas
30=b oot ool o T — La _
! ! ! ! Florida ! !
1 1 1 1 1 1
1 1 1 1 1 1 1 1
1 1 1 1 1 1 1 1 1 1
Grid #5 Grid #6 Grid #7 Grid #8
-p42-24N&111-130W_ | .42-24N&94-113W L 142-24N&77-96 W Q< J42-24N&60-79W L
. s n A
1 1 1 1 1 1 1 1 1 1 1 1 1
230 240 250 260 270 280 290 300

Figure 2-15. Geoid Grid Example — Approximate Grid for US

Using Topcon Link, you can create a Topcon geoid file for a specific
area from a supported geoid model, and then export the file into
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TopSURV. See “Geoid File Conversion Parameters” on page 5-20 for
file conversion details.

Creating a Regional Geoid Model

If geoid heights (the differences between ellipsoidal and orthometric
heights) for the nodes of a regular grid are known, you can create a
Regional Geoid Model File (*.rgm). After creating the file, use
Topcon Link to convert the regional geoid model file to a Topcon
geoid file (*.gff).

1. Open an ASCII text editor (such as Notepad).

2. Enter geoid heights in the format shown in Table 2-2, where each
row in the table corresponds to a line in the file. See below for a
description of the fields in this format.

Table 2-2. Regional Geoid Model Format

Format Fields Example

LAT, LON, n_row, n_column, step_lat, |40 36 10, -4 30 00, 3, 3, 2 00, 2 00, SE,

step_lon, geoid_direction, ellipsoid; WGS84;

H1 H2 H3 16.16 11.11 6.6
H4 H5 H6 12.127.72.2
H7 H8 H9 8.83.319.19

3. Save the file with an “.rgm” extension.

4. Open Topcon Link and convert the regional geoid model file to a
Topcon geoid file. See “Converting A File” on page 5-2 and
“Geoid File Conversion Parameters” on page 5-20 for details.

The fields in the regional geoid model format correspond to the
following information:

* LAT, LON - latitude (GG MM SS) and longitude (GG MM SS)
of the start point for the Regional Geoid Model

— Latitudes are positive for the Northern Hemisphere.
— Longitudes are positive for the Eastern Hemisphere.
Enter latitudes and longitudes in this format: dd® mm' ==

¢ n_row — the number of rows in the file
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¢ n_column — the number of columns in the file
* step_lat — grid step along parallels (MM SS)
* step_lon — grid step along meridians (MM SS)

* geoid_direction — direction for entering geoid heights along the
grid (Table 2-3)
Table 2-3. Entering Geoid Heights

NE EN WS
from north to east from east to north from west to south
N A N A Start Point
w< H3 [HZ |H1
H3 |He |He H7 |H8 |He He [HE [H4
H2 |HS |HS H4 |H5 [H6 H9 |H8 [H7
H1 |H4 |HT7 H1 |H2 [H3
Start Point > Start Point > Y
s

* ellipsoid — the ellipsoid type that the given regional geoid is based
on

* HI,H2... — geoid height in the node (meter)
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Notes:
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Chapter 3

File Operations and
Data Views

Topcon Link works with individual data formats rather than importing
data into an application-based, project-style file. This feature allows
Topcon Link to provide robust import/export and conversion utilities
for multiple data types, as well as the ability to work with a data type
in its native format. To this end, Topcon Link uses standard file
opening/closing and saving operations. Most files can be opened,
saved, and closed. However, a few formats may need to be converted
before opening and working with the data, or converted to another
format before saving changes.

» See “File Operations” on page 3-2 for details on opening/closing
files, and for details on setting file properties and printing.

» See “Saving the File as Another Format” on page 3-9 for details
on saving proprietary or device-specific formats.

Topcon Link includes a standard configuration for viewing data, such
as distance precisions, applicable coordinate systems, and
computation parameters. To change any of these settings, see
“Applying Configuration Parameters for Viewing Data” on

page 3-11.

The Tabular view initially contains default data columns and settings
for viewing and working with data. The CAD view can display
information for data points. These columns and settings can be
shown/hidden or re-arranged.

* See “Setting Tabular View Options” on page 3-15 for details on
setting up data columns for the different tabs.

* See “Setting CAD View Options” on page 3-21 for details on
viewing data information in the CAD view.
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File Operations

Topcon Link uses standard file opening/closing and saving operations
for all file types. A properties feature allows job and company
specific information to be saved with the file. The selected view can
be printed for further study.

Opening a File

Because Topcon Link is a utility program that works with various file
types, it does not have a type of file specifically associated with this
software. Some types of files can be directly opened in Topcon Link.
Table 3-1 lists the file types that Topcon Link can open.

Table 3-1. File Types that can be Opened

File Type Format Extensions
Code Library * las; *.dbf; *.tdd; *.xml
Coordinates *.sdr; *.pt3; *.mgn; *.txt; *.xml; *.cr5; *.csv; *.xyz;

* fcd; *.pnt; *.fc5; *.*

Digital Level Observations | *.dl;*.lev;*.txt

GPS+ Raw Data *.pdc; *.tps; *.jps; *.tpd; *.270; *.27D; *.77G; *.7IN

TopSURYV PC Jobs *1sj; *.tlsv

Total Station Observations | *.dat; *.raw; *.fc5; *.gts; *.gt6*, gts6; *.gts7; *.gt7;
* 2k k xml

Other file types must be converted first before Topcon Link can read
the data. See Chapter 3 for details.

1. Open Topcon Link and click File » Open File.
2. Select the file format.

3. Navigate to and select the file to Open.

4. If needed, select desired Advanced options.

For Total Station observations measured using a
vertical angle, select the vertical angle mode.

5. Click Open.
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Look in |E3 TopsURY - ﬂ@

3050119

B 050119 ey
:ljlmag\ng.zwp

B3 FROJECT RTK. Hev
B PROJECT TSty
D TopsURY DATA FILES. zip

y
Code Library {*.dbf;* . kdd;*.xml)
Coordinates (*.bxt;* xeml*.cr5;*. cswy® vz * Fod; *.pnty* Fes*. %)
DL Obs (*.dij* lew;*.txt)
GPS+ Raw Data (¥ tpd;™ 770y, 729G, % 770, 770y ¥ bps; ™ ips)
TopSURY PC Job {* tsw)
+ TS Obs (*.rwS;* raw; ™. dat;* FeS; . gts; * ghe; * ghse; *.gts 7 * gh 7 * %% eml)

File: name: PROJECT ATE sy
Format name: | TopSURY PC Job [Hsv) j

™ Advanced offem

Figure 3-1. Select Format and File to Open

-

Creating a Custom Text File Format for a
Coordinate File

To open or save a file of arbitrary coordinate format, you can create
and save a custom format. A custom text format allows you to
customize the data included in the coordinate file. Text formats are
saved as an ASCII format (*.txt, *.csv, etc.).

To create an arbitrary text coordinate file, take the following steps:

1. Click File » Open File.

2. On the Open dialog box, navigate to and select a desired
coordinate file in the File name field.

3. On the Open dialog box, select the Custom text format from the
list of coordinate formats in the Format name field. Click Open.

4. On the Custom format properties dialog window select the
delimiter that separates data in a line and the coordinate system
used to create the data.

Do not use the “Space” delimiter if the file contains
codes with attributes.

5. Select data types for the custom format:
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* In the left column, select the data type(s) to include and click
the Move Right button.

* In the right column, use the Move Up/Move Down button to
arrange the data types into the same order used in the opened
file.

Always include “PointNum” in the right column
@ and always have it as the first data type.

If including “FullCodes” in the right column,
always have it as the last data type.

6. Select the rule(s) to use for displaying data:
* Ignore first line — if the first line if informational only.

 FullCodes include Code, String and ControlCode — if these
codes are included as shown in Figure 3-2 on page 3-4.

¢ FullCodes include Code and Attribute — if these codes are
included as shown in Figure 3-2.

If the custom format has mixed FullCodes, select both options.

[includes Coée, String, Control Code] Code String cg:g:" Code
CT,663.873.241.411.1 80.604]':5'&Tm@1m_'m%&@.l
FullCodes
[Includes Code and Atiribute | Code Attribute
]’l.660,343.25?.340.]80.903.||Btlst.' Slalionl.' alipcr H_ Vert 1 58].']‘];‘X']‘— "
FullCodes

Figure 3-2. Examples of File Formats with FullCodes

Enter a name for the format and an extension type.

8. Click Ok to store the format in the Formats folder (installed with
Topcon Link) and include it in the format name list. This format
is added to the list of coordinate formats for Open, Save As and
Convert File dialog boxes.
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Delirniters |Comma hd
Coardinate system |BLH | <_°
Ope LatLon Format | ddmmsss -
) - Latitucle Peirt Nurm |
Look in: Coordinates fata Longtude
E;‘jg:t b3 ‘ Move Up ‘

Mate
FulCodes

<< ‘ Move Down
File name: |DAT_DDD1_bIh.txt

[ lgnare first line

6é ¢

Format name: | Customn Text Format - Coordinaty/™ FulCodes include Code, String and ControlCode
g v FullCodes include Code and Attribute
v Advanced options
Format name [FullCode_Coord_BLH
] File: etenision [kt
0K Cancel

Figure 3-3. Create Custom Text Coordinate Format

Topcon Link applies the default file name,

@ UnName*.*, if no file name accompanies the new
coordinate file format. In this case, Topcon Link
deletes the new file format when closed.

About Opening TS Raw Data Files

While TS raw data file do not record information about the vertical
angle mode (Figure 3-4 on page 3-6), you can select the mode under
Advanced options when opening the file in Topcon Link.

* Zenith — vertical angles are from zenith

* Horizontal Level — vertical angles are from horizontal
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* Auto — no information available on the vertical angle mode. In
this case, angles from 0 to 45° are considered “horizontal” and
angles more than 45° are considered “zenith.”

exceed 45°, select the same mode used for these
measurements when opening the file. If a different
mode or “Auto” is selected, the TS Obs tab will
display measurements in the wrong column:

E If vertical angles measured in a TS raw data file

* the Vertical Angle column will display values
read from zenith

* the Zenith Angle column will display values
read from horizontal level

A
Z A Zu'lh
0
Vertical
angle

.-
-
-"
-

-Z 360 L

0
270° 180
Figure 3-4. Vertical Angle from Horizontal Level (A) and Zenith (B)

Creating a Custom Text File Format for TS
Observation file

To open or save a file of arbitrary TS observation format, you can
create and save a custom format. A custom text format allows you to

customize the data included in the TS observation file. Text formats
are saved as an ASCII format (*.txt, *.csv, etc.).
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To create an arbitrary text TS observation file, take the following

steps:

1. Click File » Open File.

2. On the Open dialog box, navigate to and select a desired TS
observation file in the File name field.

3. On the Open dialog box, select the Custom text format from the
list of TS observation formats in the Format name field. Click
Open.

4. On the Custom format properties dialog window select the
delimiter that separates data in a line

5. On the Custom format properties dialog window select data types
for the custom format:

* In the left column, select the data type(s) to include and click
the Move Right button.

* In the right column, use the Move Up/Move Down button to
arrange the data types into the same order used in the opened
file.

6. Enter a name for the format and an extension type.
Click Ok to store the format in the Formats folder (installed with
Topcon Link) and include it in the format name list. This format
are added (will be added) to the list of TS observation formats for
Open, Save As and Convert File dialog boxes.
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ContralCode2
Vertical Angle

5| Bz00zZ_6.raw
= Bz00z_t.raw.iniizl
| Bz00z_7.raw

= Bz0nz_7.raw.iniizl

| Mos2502

Harizortal Distanc:
Werlical Distance

Offset Across
Offget dHt

File name: \M052502_A.raw

Pairt From
Instrument Height
Pairt Ta

& Reflector Height

Azimuth
Horizontal Circle
Slope Distance
Zenith Angle
Code

«

Faormat name:

v Advanced opliohs

| Custorn Text Format - TS5 Obs [*.”]I

Faormat hame

File extenzion

-

Move Up |

Move Down

 I—

[MY_T5_0BS_TEXT]

[ bt

Cancel

8

Figure 3-5. Create Custom Text TS Obs Format

Saving a File

Topcon Link opens and imports many files types, but only saves
certain file types in a native Topcon format.

When saving a file that has been edited, Topcon Link automatically
saves the original version of the file as “*.*.initial” in the current
folder. Then the edited file is saved.

Use one of the following methods to save a file:

¢ Click the Save button on the Toolbar.
¢ Click File » Save File.
* Press Ctrl+S on the keyboard.

An error message displays if the format is not supported for a save

operation.
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Saving the File as Another Format

Topcon Link allows one to save the current file with a new name and/
or in a new directory and/or to save in other format. Saving a file in
another format uses the same process as a file conversion. Topcon
Link allows the user to save files only to compatible formats (the
formats with the common data).

For details on converting files, see Chapter 5.

same file to show progress. Simply add the date or

\i ; / Use the Save As function to keep versions of the
other indicator to the file name.

With the desired file open and active, click File » Save As.
Navigate to the location in which to save the file.

Type in a name for the file.

el

Select the format to save to.

Topcon Link will display only compatible formats
in the File format field of the Save as dialog box.

5. If selecting a different format from the current format, select
applicable Advanced Options.

For details on the advanced options, see the applicable section in
“Converting A File” on page 5-2.
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6. Click Save.

CodefLayer Library (*.dbf ;* xml;* las)
Coordinates {*.mgn;* . opz;* Fodi*, pnk; ¥, FoS;* bk * el .
Cut Sheet {*.csu;*.css)

Design (*.In3;*.dgn;™ bk * ool * . dwg * i+, %)
G5 (*.shp)

GPS Obs (%ol b )

Localization {*.gc3)

Tapcon XML (%, sxril)

TopSURY PC Job {*.tsv)

¥ TS Obs (*.sht;* mos;*.raw;* . dat;* . gks; ™. gbst;* . gte;* gtk 7

Save in: 3 TLSY

I R S

File hame: |RTE_GPS_5_TS
=

Farmnat name:

+ Advanced ophions

Figure 3-6. Save File As...

Closing a File

To close a file without closing Topcon Link, click the system close
button on the Tabular View.

Close File using Syste
Button on Tabular View

M C:\topcon¥TopconLink\TopSURVAPROJECT RTK.-tlsv <TopSURY PC Job>

o

«° paints |2 s occupations | 62 GPSobs | B Codes |
Icon ‘ Name ‘ Ground Morthin,., ‘ Ground Easting ... ‘ Eleration (USFE) ‘ Code ‘ Control ‘ Tl
L] 5000 2064444.891 6179355.110 379,101 EXISTING Nane

5001 2064448.568 6179345.339 379,512 EXISTING Nane
@ s00z 2064451,546 6179335.728 379,531 EXISTING Nane
@ 5003 2064454,479 6179325.560 379,445 EXISTING Nane P
< >

Figure 3-7. Close File

While several files can be open at the same time, it may take longer
for Topcon Link to read or compute data if the files have a lot of data.
Closing a file before opening another may speed up computations.

Viewing and Entering File Properties

The Properties dialog box is used for viewing and entering file-
specific information. This dialog box also includes the location of the
file, file type, and date the file was last saved.

1. Click File » File Properties.
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View the path and format of the file.

3. For some file types, you can type in a name for the job, the name
of the surveyor or company, and any associated notes.

4. Click OK to save and exit.

TOpSURV PC Job File Properties B Properties : TopSURV Job C:\topco. ..

General I

File Mame |E'\mpcnn\TnpcﬂnLink\T opSURYAPRO
Format |TopSURY PC Job
Digital Level File Properties Date I

B Properties : DL Obs C:\topcon\Top... E]E] = [FROJECT RTK

Surveyor |J ohn 0. Public
General I

For Demanstration

File Mame |C:MtopeonhT opeonLink:\DigitalLevelh 37w Note

Format |Topcon DL Obs
oK % Cancel | ‘ oK k Cancel Apply

Figure 3-8. File Properties — Examples

Printing the Selected View

The Tabular and CAD views in Topcon Link can be printed for
viewing offline.

» Use the File » Page Setup option to apply page

\E : i Some views print best with a landscape orientation.
and margin settings.

* Use the File » Print Preview option to view the
potential result of the selected view.

To print the Tabular view, select the tab and click File » Print.

To print the CAD view, select the CAD view and click File » Print.

Applying Configuration
Parameters for Viewing Data

Configuration parameters apply basic settings for such items as how
to display angles and the decimal for digits, the coordinate systems
available and adding a geoid, and the settings to use for adjustments.
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These parameters will be saved with Topcon Link and used when
opening a file. The default configuration is usually appropriate for
most operations.

1. Open Topcon Link and click File » Configuration.

2. In the Display pane, select the following parameters for
displaying information (Figure 3-9 on page 3-12). Click Ok to
save and exit.

* In the Precisions tab, select the number of digits to display
after the decimal for measurements.

¢ In the Time tab, select the local time used for start and end
times for GPS occupations

* In the Roads tab, select the term to use for displaying
information on the centerline; either Chainage or Station.

* In the Angles tab, select the form for displaying angles and
latitudes/ longitudes.

Precisions  Time | Roads | Angles |

GPS Time Zone Offset [GmT |
Precisions | Time Roads | angles |
Display CL Pos a5 [ Chainage ~|
Precisions | Tme | Reads Angles |
ngles [ dmm'ss.s" |
Lat Lon [ defrmmss. s ~|
%2 Configuration E]@
f Precisions | Tme | Roads | Angles |
oordinate Systems Digits after decimal
s Distances E |
mpute Conrdinates Coordinates(N.E] I ‘
TS Computations S B ‘
Angles [seconds] |2 =
Angles [Dec.degrees] 7 =
LatLon [seconds] [E ]
LatLon [Dec.degrees) E |
A1z B ]
Volumes B |
i

Figure 3-9. Select Display Parameters
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3. Inthe Coordinate Systems pane the user can view, add, or remove
available geoid file (Figure 3-10). Click Ok to save and exit.

To add a new Geoid to the list, see “Adding a Geoid” on
page 2-13.

12 Configuration E]@
[ Eoepey [ Geodslit
] Tcon | Mame | Path | Minirmum Longit,.. | Minimum
ave -
- # EcMas CHTOP.., 180°0000.0,,,  90°00100.C
"= ] Compte Coordates ®  gzo0munt Diigaeni.., 130900000, 40°0000.¢ Add
TS Computations & gzoosunz DiyGeoi... 113°00000..,  40°0000.C
W gz000u03 Diigaei.., SE°0ND0.00,,  40°D0'00.C
& gzoozune Di\Gedi.., 79°0000,00,,  40°0000.C
B gz000u05 Diigaeni... 130°0000.0,,,  24°0000.1
Femove
< ®
0K Cancel J

Figure 3-10. Select Geoid

4. In the Save pane, select the interval in minutes for saving a
backup copy of the current file (Figure 3-11). Click OK to save
and exit. Topcon Link uses the following rules for saving/
deleting backup copies:

* The file will be saved at the selected interval.

* If the file has been edited, a backup copy is automatically
saved.

* After saving the file (either click Ctrl+S, click on the Save
button, or click File » Save/Save As), the backup copy is

deleted. A new backup copy is saved when at the end of the
next time interval.

* Type “0” into the field to turn off the backup save feature.

P/N 7010-0522 3-13



File Operations and Data Views

e If Topcon Link (or the system) shuts down unintentionally,
the backup copy of the current files opens and is marked

“reserved”.

Backup Interval (min) 10 =

EE| Compute Coordinates
T5 Computations

0K Cancel J

Figure 3-11. Select File Backup Properties

5. In the Process Compute Coordinates pane (Figure 3-12), type in
distance and angle measurement errors to take them into account
when computing the coordinates of station using directions
observed from the station to points of known positions (resection
method). Click Ok to save and exit.

6. In the Process TS Computations pane, select the refraction
coefficient to be applied to total station observations during
calculation of the coordinate (Figure 3-12). Click Ok to save and
exit.

2| Configuration

Display EDM [3 mm + 3 pam
Coordinate Systems Hés Sigma, fsec] 5

Save
Y& Sigma, [sec] [0

RIX

Refraction Cosfticient
o
® 014
I~ oz
| Withaut Curvaturs

Figure 3-12. Set Processing Properties
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Setting Tabular View Options

Topcon Link displays data in two views, a tab view and a CAD view.
The Tabular view groups data based on type and displays the
information in a series of tables on different tabs (Figure 3-13).

T File Edt View Process Window Help - 8%
= = R & SR A Mo & Bk
o7 points | o G5 Occupations | g2 aPobs | & Codes |

Icon | Mame | Ground morthin... | Ground Easting ... | Elevation (USFt) | Code | cantral e
e 5000 2064444891 6179355110 379001 EXISTING Hore

PRt 2064448558 6179345.339 79512 EXISTING Hore

e sz 2064451546 6179335.728 379,551 EXISTING Hone

e 503 2064454473 6179325560 79,445 EXISTING Hone

e 504 2064457738 6179315.822 379,483 EXISTING Hore

e saos 2064461.034 6179305053 379,528 EXISTING Hore

e 506 2064464.013 6179295227 379,556  EXISTING Hore

e soo7 2064466338 6179205256 379510 EXISTING Hore

e soos 2064468.620 6L79274.605 79,563 EXISTING Hone

e 5009 2064471518 6179264.558 79368 EXISTING Hone

e 5o 2064474482 6179254930 379477 EXISTING Hore

s s 2064477.668 6179245.120 379386 EXISTING Hore

e sz 2064480.670 6179235556 379338 EXISTING Hore

& sz 2064483472 6179223924 373,567 EXISTING Hore

e s 2064485950 6179211842 7943 EXISTING Hone

e  sais 2064489.455 617920189 379360 EXISTING Hore

e saie 2064492.024 6179192.095 379.293 EXISTING Hone e
< ¥
Ready UsFest | DMS | Ground | PROJECT RTK.Hsv Locdlization

Figure 3-13. Tabular View

The tabs that display depend on the type of data in the current file.
Data columns for each tab can be shown/hidden and re-arranged
based on available data and the user’s preference.

Displaying Table Columns

1. To edit the order and visibility of a tab’s column, click View »
Options » Tabular View.
Click the options tab for the corresponding Tabular View tab.

3. For most of the tabs, select the desired field and use the following
buttons to set up the data columns. Figure 3-14 on page 3-16 uses
the Lines Tab options as an example.

e Moveright ( » |) to include the field in the table and
move left ( « |) remove the field from the table.

* Moveup ( weew: |) and move down ( weeten |) to arrange the
order of the selected field.
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For the Road Graphic Views and Images tab options, select the
desired fields to display on a graphic tab. See page 3-18 and
page 3-19 for examples.

Click Ok to save and apply the settings.

2 Tabular View Options

Images |  Horizontal Road Elements |
Road ®-Sections | Road @raphic Yiews

Ports  Lines | GRS Occupations

Show colunns right
\wailable columns

Wertical Road Elements
| %-Section Templates
GP5Obs | T50bs | DLObs | Tape Obs

Selected columns

lcan
Order
Pairt

Ezit azimuth

Distance from start
Distance from prew
Entty azimuth

Show columns left

Awvailable columns

Icon
Tupe
Layer
Color

Line Style
Line Width
Code
String

hiea ‘

selected columns

Ok |

Car

Save Changes

%2 Tabular View Options

Tnages |
Road #-Sections

Points

Show columns right

Aailable columns

Move g~

|
i
Include Field in Tab
Arrange Field in Tab

Hotizantal Road Elements
Road Graphic Yiews |

X-Sec\on Templates |
Lines | GpS Occupations

GP5Obs | T5Obs | DLONs | Tapeobs |

Selected columns

Toon
Order
Point
Distance from start
Distancs from prev

EntlE azimiith

Mave Up |

Area

Show columns left
Ayrailable columng

Selected columng

lcan

Type
Layer
Color

Line Style
Line fidth
Code
Sting

Move Up |

Mave Down

Figure 3-14. Lines Tab Options — Editing Data Columns
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Table 3-2 shows an example of, and the default settings for, each of
the Tabular View options tabs. See Figure 3-14 on page 3-16 for an
example of the Lines options tab.

Table 3-2. Tabular View Options Tabs

Points tab Options GPS Occupations tab Options
12 Tabular View Options. 7l 22 Tabular View Options
tmages | | | mages | I
AoadX-Sections | Road draphicews | -Saction Templotes | Road%-Sections | RoadGeaphicVews | X-Sertion Templates
Points | Lnes | cPScenpations | GPSobs | T50bs | BLObs | Tapechs | Porks | Unes  GPS Occupations | PSobs | TS0bs | 0L obs | TapeObs
Show Courtins Show Cobrns
st cobari Setocten cuirs Awislable cohsmns Sedecten cohains
Corind Cois = Az ez -
Cortrol Code 2 Hame Tifsed Dist Fort Hame
»» LatibudeiHuthrg Move Lp Off et it ”» Osgindl Hame Mo Lip
LnngihadehE ing il Fnlenns | ype
ENHnDlevation Eniene Height
Conks Ant Height Method
Hete Slail T
Phota Hotes Siop T
L= Duegion
Sounce Melfred |
L | Colot Merve Dorem | €« | Maote Move Down
Poml Skl Feceaver
| Sty Irkeves >
| 13 | Cancal I ok | Canced
GPS Observations tab Options TS Observations tab Options
2 Tabular View Options
tmages | tkemontalRosdlements | verticsl Rosd Chmenes images | HorrootalRnad Elements | Vetiool Rosd Elements |
Rosdwsections | RosdGraphiviews | ErSection Temglates RoadX-Sections | Aosd Graphic views. | *-Section Tomploes |
pores | Unes | @ocomstkes GRS Obs | Tsobs | pecks | Tapeobs Porks | Unes | GPSOcapatons | GPSbs  T50bs | 6L Obs | Tapeces |
St Coburiers Show cohimnd in i pane
\Asvndabie pokmns Sedncind cobmn Auvsslable cohsrs: Sbected cohimrs
£ lcen - ch:uom A Ium A
df Purd Ficm il Argle
Fod e | (1S Saellens Moes U | Vesical Dittarce 2 | Peint From MovsUp |
Distance GLONASS Setebtes Ullze fdang Fouil 1o
Elrvaton A Pori 0 Tlfaed 1 Fefiectee Hright
£ St Tie: Ofset Acrass
HOOP g Ullzed Typ Hororial Cacke
VDOP Durston Sxing Slope Distance:
EDOP GFS weck dy Contiol Code Zerith Ange
- [freaee P —— HDwt Rerdad @ | Dale Mo Downy |
il rghe Besidual H
ok Vi Fledidual ~ Code -
a v
Show okt in kit pane
v sabbe cohurs: Selected cohars:
beon
4 Hve U
22 Pl Haiire G|
Inatnumert Height
(14 | Mawe Diown |
ok Conord 0k I Corcel |
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Table 3-2. Tabular View Options Tabs (Continued)

Digital Level Observations tab Options

Tape Observations tab Options

abular View Options

mosdx-Gectons | FosdGrachicviews | XeSection Templates
ports | Unes | G ocomstons | Grsobs | Tscbs DL Obs | Tspecks

S cobamng i nghl pane
{Avalable cobmns

Port Mrve Up

Dittance
Yeil Ulfsel
£ | Mote
Std Dew

Move Dovn

Dt o8

Showr cobamng n lell pane
{Avalable cobmns

Marve Lip

Move Dovn

E2 Tabular View Options

| tonmerslRosdbhements | vetcdmosdBemerts |
Rosdwsetons | RosdGraphcviews | xSecton Temelstes |
Fores | Lnes | GRS occupstons | @sobe | 150bs | DLObs  Tape Obs

Show cohurs mn nghl pare

Awalsbls columes Srdected columns

o

il Ta
Distance
Date
Hole

_—

Murve Dovmi |

Show cohuns m bl pare

Awalsbls columes Srdected columns

loon
Stat Ford

» |rmpm Mowe Lip |

72 Tabular View Options

| lemants |

gz 0| 100 Fexonk Varti
Purks | Unes | GPSOvomations | @sobs | TSCbs | DLcts | Tapeobs ponts | Unes | armocopsins | arsobs | 150bs | oLObs | Tapects |
Hoad X-Sections | Road Graphic Yiews WeSeckion Templates Rosd X-Sections Raoad Graphic Views | K-Gecton Tamplates |
Show Cokmes ¥ Show Giid
Avaiabls cohumns Selecled cohrms Laheds
loon ¥ Shows staton e on stabon
3 |§'::ﬂ"“'°‘ Mewe Lip | ¥ Show stasion name on cursa
Tenpiste ¥ Show stus bar
< | Move Down |
i3 Canced ok Careel
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Table 3-2. Tabular View Options Tabs (Continued)

X-Section Templates tab Options

2 Tabular View Options

Images tab Options

mages | jemerts | ponts | Unes | @5 ocopeons | GRsobs | T50be | Duobs | Tapeobs
onts | Unes | @Psocopsens | Psobs | 150bs | oLobs | Tapechs | Riobd MSactions RosdGraphicviws | Sectin Temolstes
Rosdi-Gections | Robd Graphic wews *-Section Templates tmages | igezontdRosdElements | Vertical Road Chmenes
Shorr cobanng ight. Shoe on mag ¥ Fitea by Sanfinn o Susdnee|
{Avalable cobmns Sedncied columea ¥ Mame Show images
=3 ™ Code F e
" o Mowe Lip | I~ Height g:'::aﬂw
Hz Digt Shaw on cursor = s
Gan
by ¥ Hame:
Hz. Offset from CL ¥ Code
. Ollwet lom CL I He
« | || e
¥ Mame
¥ Code
Shaw cokas et 7 Heght
[Avadable cobrmng Selected colurng
(=
I wonts_|
Fil Shope
2 | Mave Do |
| oK | Carcel | | oK Cancel |

Horizontal Road Elements tab Options

ponts | Unes | @5 ocopeons | GRsobs | T50be | Duobs | Tapeobs

12 Tabular View Options

Vertical Road Elements tab Options

ponts | Unes | @5 ocopsens | Psobs | 150bs | oLObs | Tapeobs |

(2]

mosdx-sections | RosdGraphicviews | iesection Temolstes Rosdnsections | Fosd Graphi: ews Kesechon Tenclstes |
s Harizantal Road Elemeats | verticsl Rosd Chmenes mages | lements
Shorr Cobanrs Shrr Lol
{Avalable cobamns Selncind cobamns {Avalable cobmns Sedncied columea
leen ~ lean
Urder. Order
» | Type Morve Up | b Type Move Up |
| Azinuth S
Lerglh Length
Tum o Giade
Stan Rladus Fnd Grade
End Radus Elevation
Hiiking Flackus
Eastig Move | oo |
@ | Sl ] Len Down < Move
Epial 2 Len
End Sta/Chainage &
oK Cancel oK Carcel
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Arranging Table Columns

The columns in the Tabular views can be sorted and arranged
(Table 3-3) to best display the file’s data. The arrangement is used the

next time you open a file.

To reset the table’s columns to default settings, right-click the

column’s header and click Reset Columns

Sart by selection

Table 3-3. Arranging Table Columns

Column Arranging Options Examples
Sort columns Decreasing Order Increasing Order
Data in .a quumn C_an be sorted in | Ground Northing (LSFE) | | Ground Easting {USFL) |
decreasing/increasing order. 435,759 12654.110
4856.723 10743.594
4856.723 10694.174
Click the column’s header, or right- 4923.512 10693,274
. . 4999,956 10685742
click and click Sort. 500,024 10597.179
S000.024 10594,929
Swap columns Before
o Paints |07 Lnes | of GRS Ocupations | o GPSobs | <, TS obs
Columns can be moved from one L Mame | Ground Northing (USF) | Ground Fasting (LISft) |
location to another in the table. iz 697,95 10259.732
294114 5601762 10282462
$ 29411 5601763 10282466
& 269424 5111.627 10323.941
Click the column’s header and drag it | Puring
. . o painks |7 tnes | o ersocoupations | o spsobs | < Tsobs
to the desired location. L] neme Ground Northing (SiS) Eastaraisid Easting (USFE)|
$ 20412 5697.936 10259.732
& 204114 5691.762 10282 462
$ 29411 5691763 10282 466
& zegqza Siitez? 10323941
After +° Points 1 Lnes | ¢ ePsocaupations | ¢ ersobs | ©, Tsobs
| Hame Ground Fasting (L15ft) | Ground Marthing (UsFt) |
$ 29412 10259.732 5697.936
b zodi1a 10282 462 5691.762
$ 29411 10282.466 5691.763
& zesdza 10323.941 Siil.ez?
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Table 3-3. Arranging Table Columns

Column Arranging Options

Examples

Size columns

Columns can be sized to display/hide
data.

Click the column’s right edge and
drag left to decrease, right to increase
the width of the column.

Before

After

M C:\topcon\TopconLink\Digitall ey

o Points E, DL Obs l

Ic0n|# |Fr0m|T0|l’
-] 1 +BDI 5 1

)

M C:\topcon\TopconLink\Digitall ey

o Points E, DL Obs l

Icon | #‘+|_Fr0m | To | Lewvel Run | '
-] 1 BO1 5 TOPCON

)

Setting CAD View Options

Topcon Link displays data in two views: a tab view and a computer
aided drawing view. The CAD view is a two-dimensional, graphical
representation of linework road and surface data, with associated
points. To view the CAD graphic, click View » CAD View.
Depending on the file’s data and the filters used, the following

information displays:

* Points with associated symbols

If the point does not have a symbol, its survey symbol is used.

* Lines using the associated code/layer color, style, and width.

 Control codes (/AS, /AE, /C) display as an arc or closed polyline,

respectively.

* Codes with a polygon entity display as closed and filled (if a fill

color has been set).

P/N 7010-0522
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* Surfaces and road display in the color applied to the
corresponding layer(s).

CAD View

+ 100

Figure 3-15. CAD View

3 The Roads tab and X-Section Templates tab have
T independent CAD graphical views associated with
the selected data element.

1. To filter (show/hide) points, lines and codes in the CAD view,
click View » Options » CAD View.

On the Window tab, select to show/hide a grid on the CAD view.

3. On the Labels tab, select to show/hide the following information
on the CAD viewmap, as a pop-up with the cursor, or on the
Status bar.

* Name — the name of the point
* Code — any code associated with the point
» Height — the height (elevation) of the point
4. On the Selection tab, check on (off) the following parameters of
the selecting rectangle to show/hide them in the Status Bar:
» Show distance - the length of the selecting rectangle’s diagonal
* Show azimuth - the azimuth of the selecting rectangle’s diagonal

* Show dimension - the dimension (along the Easting and Northing
axis correspondingly) of the selecting rectangle



Setting CAD View Options

» Show area - the area of the selecting rectangle.

5. Click Apply to save changes, then Ok to exit.

[¥ Show grid

Static points

v Name
v Code
[V Height
Show on cur
¥ Name
v Code
¥ Height

L.

Show on stal
¥ Name
¥ Code
v Height

Window I Labels 1 Selection

Window  Labels | Selection

L |

Show on map

Window } Labels Selection

¥ Show distance
¥ Show azimuth
[V Show dimensions

[V Show area size

CP5_Local j NALL { 700,116

E]@ Local [ NAIL [ 700,116 (4805H, S025E)

]

Cancel

Distance: 669,427 USFt; Azimuth: 155°46'50,6311"; Dimensions: 274,264 L
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Notes:
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Chapter 4

Importing Data Files
From a TPS Device

Topcon Link provides a simple interface for importing data files
directly from a Topcon device (instrument). The imported file is saved
to the selected directory, and is immediately available for opening and
viewing in Topcon Link.

A unique feature of the software includes the ability to import data
from a connected device to the computer using Windows® Explorer,
without having to open Topcon Link. Then use Topcon Link to open
the files for viewing, editing, converting, or uploading.

! Before importing data from some devices, the
device must first be set up. See “Adding and
/£

Formatting Devices” on page 2-1 for details.

This chapter first discusses the steps to view device properties, or file
properties on a device’s memory card. The remaining sections in this
chapter detail the steps required to import data files from a connected
device or an inserted memory card.

* See “Importing Files from a Topcon GPS Receiver” on page 4-2.
» See “Importing Files from a Mobile Device” on page 4-5.

» See “Importing Files from a Total Station” on page 4-7.

* See “Importing Files from a Digital Level” on page 4-9.

* See “Importing Files from a Memory Card” on page 4-11.

* See “Using Windows Explorer to Import Files from a Device” on
page 4-13.
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Importing Data Files From a TPS Device

Importing Files from a Topcon
GPS Receiver

The Topcon family of GPS receivers have an internal data storage
device to record data in *.tps format. This family of products includes
the following receivers. Refer to the receiver’s documentation for
details on setup, operation, and connection with other devices.

* Odyssey-E, Odyssey-RS, e HiPer+, HiPer Pro
NET-G3 « HiPer Lite, HiPer Lite+
J H}Per, HiPer GD, HiPer L1, « GR-3
HiPer GGD

. . e Map-HP, Map-RT
e HiPer XT, HiPer XR
When importing files from a TPS GPS receiver, Topcon Link
automatically detects the receiver for importing data, and no further
setups are required.

Before connecting the receiver’s USB port to the computer’s USB
port, the TPS USB driver must be installed on the computer. The
driver is available on the TPS website: (http://
www.topconsupport.com/documents/view/1743)

This section describes data import using the Topcon
Link interface.

To import data using Windows® Explorer, see
“Using Windows Explorer to Import Files from a
Device” on page 4-13.

1. Connect your receiver and computer according to the receiver’s
documentation.

Note that a Bluetooth® connection requires that both devices
have Bluetooth wireless technology capabilities.

With Topcon Link open, click File » Import from Device.

3. In the left panel, double-click Topcon Receivers. Topcon Link
searches for connected devices.
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Importing Files from a Topcon GPS Receiver

Click Stop to quit the search and display detected devices.

A Import from Device

Look in: Q My Computer hd ﬂJ

Q Mobile Device

& Topcon Digital Levels
Topcon Memory Cards

-4 Topeon 5

& Topcon Tatal St

Logkin:  [CJMy Documents = J@

kA Import from Device

k} Lookin: |4} Topcon Receive « ﬂJ Look ir: If]MyDocuments - ﬂ@

(Chenids
[Ch5urveyData
[ Topsury_Files
& [y wicklundsite
My Music
Searching... ﬂmy Fictures
BMy ideos
Stop [@IMy Webs
[y Stuff

Iv¥ Open Files after Import

Cloge

Figure 4-1. Search For Connected Devices

4. Double-click the Topcon Receivers to access the device’s data
storage module and view the collected raw files.

5. In the right pane, navigate to the folder on the computer in which
to save data files.

6. In the left pane, select the desired *.tps file(s) and click the Move
Right button. The file import progress displays.

[~ Import from Device

Look i |} Topcon Receive = ﬂJ Lookin:  {Z3My Documents  ~ ﬂ@

&Search For connected receivers
= HE_GD
&)

kA Import from Device

Lookin: |4} Topcon Receive ﬂJ Look in: |3 SurveyData - ﬂ@
a 1.kps
B logniola.tps
B loghiZzSa.tps
lo 5
a logn228a.tps
a log0304a.tps
[#] lago304b.tps
a log20041117_51538.tps
a logz0041117_S1710.tps
a logZ0041130_2342 tps

*

¥ Open Files after [mport

Close

J

Figure 4-2. Import File from Receiver
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7. If Open File After Import was selected, the import function closes
and the *.tps file opens in Topcon Link:

M C:\raw Data\log0225b.tps <TPS> DEK
&2 GPS occupations |

1..| Paint Mame | Criginal Mame Antenna Type | AntennaH... | Ank Height ... | Skark Time Stop Time Duration Methad Mate lad

& EPOCAID EPOCALD HiPer GD/GGD 1,500 Wertical 05.09.200... 05.03.200. 0:00:50 Static MEpoch=10

@A EPOCA10_K1 HiPer GD/GGD 1,500 vertical 05.09.200... 05.08.200 0:00:35 Kinematic MEpoch=7

® EPOCAS EPOCAS HiPer GD/EGD 1,600 vertical 05.09.200... 05.09.200.. 0:00:30 Static MEpoch=6

-3 EPOCAS KL HiPer GD/GGD 1,600 Vertical 05.09.200... 05.09.200.. 0:00:20 Kinematic MEpoch=4

® EPOCAZ EPOCAZ HiPer GD/GGD 1,600 Vertical 05.09.200... 05.09.200... 0:00:20 Static MEpoch=4

a EPOCAS KL HiPer GD/GGD 1,600 Vertical 05.09.200... 05.09.200... 0:00:15 Kinematic MEpoch=3

® EPOCAL EPOCAL HiPer GD/GGD 1,600 Vertical 05.09.200... 05.03.200. 0:00:10 Static MEpoch=2

LN EPOCAI_KL HiPer GD/GGD 1,600 vertical 05.09.200... 05.09.200.. 0:00:30 Kinematic MEpoch=6

® 1 1 HiPer GD/aGD 1,600 Vertical 05.09.200... 05.09.200.. 0:00:;30 Static MEpoch=6

a 1K1 HiPer GD/GGD 1,600 Vertical 05.09.200... 05.09.200... 0:00:20 Kinematic MEpoch=4

® 2 2 HiPer GD/GGD 1,600 Vertical 05.09.200... 05.09.200... 0:00:30 Static MEpoch=~6

a 2Kl HiPer GD/GGD 1,600 Wertical 05.09.200... 05.03.200. 0:00:30 Kinematic MEpoch=6

< >

Figure 4-3. Display data of the *.tps file

Importing Files from a Sokkia
GPS Receiver

The Sokkia family of GPS receivers have an internal data storage
device to record data in *.pdc format.

When importing files from a Sokkia receiver, Topcon Link connects
to the device and provides a path for the data transfer.

This section describes data import using the Topcon
Link interface.

To import data using Windows® Explorer, see
“Using Windows Explorer to Import Files from a
Device” on page 4-13.

1. Connect your receiver and computer according to the receiver’s
documentation.

With Topcon Link open, click File » Import from Device.

3. In the right pane, navigate to the folder on the computer in which
to save data files.

4. Inthe left pane, double-click Sokkia Receiver to connect with the
recreiver.
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5. Select the desired raw (*.pdc) file in the left panel and click the
Move Right button to start downloading the selected file to the

Computer:
port from Device
Lookin. [ = NewSokkiarec »| <=| ] =i Laok in: [ From_Sokkia_re | <= ] £

00140610,pdc staticl.pdc
>

@ 10_07_09.pdc

B staticl.pdc

™ Open Files after Import

‘W aiting for download...
Downloaded 63946 bytes of 491898

Transfer rate is 7105 bytesd/sec
]

Figure 4-4. Import raw file from Sokkia receiver to Computer

Importing Files from a Mobile
Device

The Topcon family of controller software (such as TopSURV) runs on
several Topcon and third-party mobile devices.

Microsoft ActiveSync needs to be installed on the computer with
Windows XP. For details, see “Installing Microsoft ActiveSync for
Use With CE-based Devices” on page 1-11.

If the user’s computer operates under Windows Vista, ActiveSync is
not needed. A connection between the computer and an external
device with Windows CE will be automatically established after
connecting your device to your PC.

TopSURYV supports two formats of the job files:

* TopSURYV *.tsj. This job is created in TopSURYV version 7.0 and
later.

* TopSURYV *.tsv job. This job is created in TopSURYV version
6.11.03 and earlier
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There is a difference in format of these files and a difference in using
these files in the computer’s software.

In TopSURY version 7.0 and later, the *.tsj file is saved on the
controller, that this file format can be opened by Topcon Link/Topcon
Tools/TopSURYV PC. Topcon Link is used only for transferring the

* tsj file from the controller to the computer without format changes.
Moreover, the user can use a movable memory card to transfer the

* tsj file from the controller to the computer.

In TopSURY version 6.11.03 and earlier, the *.tsv file is saved on the
controller. But Topcon Link/Topcon Tools/TopSURYV PC version can
not open this file format. Topcon Link has to convert mobile device-
based formats to computer-based formats.Topcon Link performs the
conversion during the import process the *.tsv file to the *.tlsv file.
This format (*.tlsv) is opened by Topcon Link/Topcon Tools/
TopSURYV PC.

This section describes data import using the Topcon
Link interface.

To use Windows® Explorer for data importing, see
“Using Windows Explorer to Import Files from a
Device” on page 4-13.

1. Connect your controller and computer according to the
controller’s documentation.

Note that a Bluetooth® connection requires that both devices
have Bluetooth wireless technology capabilities.

With Topcon Link open, click File » Import from Device.

3. In the left panel, double-click Mobile Device. Topcon Link
connects to the internal memory of the controller.
4. Navigate to the location in the controller’s memory where data

files are saved. For example, TopSURYV files are saved to the CF
Card/TopSURV/Jobs directory.

5. Inthe right pane, navigate to the folder on the computer in which
to save data files.

6. In the left pane, select the desired file(s) and click the Move Right
button. The file import progress displays.
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Importing Files from a Total Station

7. If Open File After Import was selected, the import function closes
and the file opens in Topcon Link.

kA Import from Device E]E]
Look in 3 TPS TopSURY ~| | &= Look in (2 TopSURY b - || e

[anternas| 2 Deskiop CI0TM B 07148.tsv

beacons | 3 My Computer [S)Filese F AIRPORT Hsv
) Tepcon Recsivers |

Topcon Memory Cards
Mobile Device
< ) CF Card

] 3 TPS TopSURY [

() Camera
() CustomD

I)Geo
|ZGeoi|

|~ Import from Device

Lookin |2 Jabs -] | & e Lookin: [ TopsURVieb =] 4 (1] 5]

Default tsj " F 07148 sy
108 ts) ¥ AIRPORT tsy
B net tsy B net.tsy

[v Open Files after Import

Close

Figure 4-5. Import File from Mobile Device

Importing Files from a Total
Station

The Topcon family of conventional and robotic Total Stations have an
internal data storage device to record data in various formats. Refer to
your Total Station’s documentation for details on setup, operation,
and connection with other devices.

When importing files from a TPS Total Station, Topcon Link
connects to the device and provides a path for the data transfer. The
actual file transfer is performed at the Total Station.

The connection procedure for TPS Total Stations varies, so refer to
the device’s documentation for details.

When connecting to a CE-based device, Microsoft ActiveSync
automatically starts up and connects with the device. This connection
is required to import files, if your computer operate under Windows
XP. If the computer operates under Windows Vista, ActiveSync is not
needed.
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If you need to install ActiveSync, see “Installing Microsoft
ActiveSync for Use With CE-based Devices” on page 1-

11%Installing Microsoft ActiveSync for Use With CE-based
Devices” on page 1-11 for details.

pam This section describes data import using the Topcon
NOTE Link interface.
L

To use Windows® Explorer for data importing, see

“Using Windows Explorer to Import Files from a
Device” on page 4-13.

1. Connect your controller and Total Station according to the
device’s documentation.
With Topcon Link open, click File » Import from Device.
3. In the right pane, navigate to the folder on the computer in which
to save data files.
4. In the left pane, double-click Topcon Total Stations.
5.

Double-click the desired device to connect with the Total Station

= Import from Device

Laok in }] My Computer - JJ

G Mobile Device:

& Topcon Digital Levels
B Taopcon Memory Cards
@Tupcun Receivers

‘ Topcon Total ':'-t-at'*n:’-

Laok in: ;]SurveyData - J@

&4 Import from Device

Loak in: & Topcon Total St + ﬂJ

& +Add New Station

Laok in ,W J@

[

¥ Dpen Files after Impart

Close

d

Figure 4-6. Select Total Station to Import Data From

Select the “file.txt” file and click the Move Right button.

Follow all steps listed in the Download file from Total Station

dialog box. These steps may vary depending on the connected
device. Click Start.
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8. Press the F3 key on the Total Station to import data.

9. [If Open File After Import was selected, the import function closes
and the file opens in Topcon Link.

A Import from Device @El
Lockin: | & GPT3005W = ﬂJ Logkin: |23 SurveyData - JE
e1.00

>

Download file from Total Station

i

For import fiam Topeon TotalStations GPT-2000, GPT-1000, GTS220, A
75210, GT5-310 series please follow instruction below:

Turn on the Total Station by pressing the POWER buttan

Fress the Menu Key

Press the T3 key for Memory Manager

Fress the F4' key twice(2] unti you arive at page 3

Press the 'F1' key for Data Transter

W Open Files after Impart | [Fress the F1' key to Send data.
I the 'Send Data Scresn’ the user has a choics to either send ta the: 3

Close
File name:  GPT 2005w

Status:  Waiting for start..

Cancel Start
]

Figure 4-7. Import File from Total Station

Importing Files from a Digital
Level

The Topcon family of Digital Levels has an internal data storage
device to record data. Refer to your Digital Level’s documentation for
details on setup, operation, and connection with other devices.

When importing files from a TPS Digital Level, Topcon Link simply
connects to the device and provides a path for the data import. The
actual file transfer is performed at the Digital Level.

The connection procedure for TPS Digital Levels varies, so refer the
device’s documentation for details.

This section describes data import using the Topcon
Link interface.

To use Windows® Explorer for data importing, see
“Using Windows Explorer to Import Files from a
Device” on page 4-13.
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1. Connect your controller and Total Station according to the
device’s documentation.
With Topcon Link open, click File » Import from Device.
3.

In the right pane, navigate to the folder on the computer in which
to save data files.

In the left pane, double-click Topcon Digital Levels.

Double-click the desired device to connect with the Total Station.

kA Import from Device

Look in: EJ My Computer - ﬂJ
Q Mobile Device
" Topcon Digital Levels
B Topcon Memory Cs
& Topcon Receivers

& Topeon Total Stations

Look in: lf]SurveyData hd JE

~] Import from Device

Look in: |4 Topcon Digital L + ﬂJ Look in: |3 SurveyData - ﬂ@
2 Add Mew Digital Level

|

[ Open Files after Import

Close

Figure 4-8. Select Digital Level to Import Data From
Select the “file.dl” file and click the Move Right button.

Follow all steps listed in the Download file from the Digital Level
dialog box (Figure 4-9 on page 4-11) to select a file and begin the
import. These steps may vary depending on the connected device.
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8. If Open File After Import was selected, the import function closes
and the file opens in Topcon Link.

[~ Import from Device @El
Look in: (4@ DL-103 - ﬂJ Lookin: |23 SurveyDiata = JE

>

Download file from Digital Level

i

1. Push [SET] key and enter the sst mods
2. Push [DOWN] kep any times and select the file out.

3 Push [ENT] ke

4. Push [REC] kep to start the file communication. f escape the file aut
made, push [ESC] key

5. I file communication finishes then the display retum to file out.

¥ Dpen Files after Import

Close

File name:  DL-1MC

Status:  Waling for start..

Cancel

Figure 4-9. Import File from Digital Level

Importing Files from a Memory
Card

Most Topcon devices contain internal memory cards. These movable
memory cards are used to collect raw data and to transfer the
collected data from the device to the computer. The memory cards
can be divided into two different types:

* Memory cards formatted in Topcon receiver’s file system. These
cards are used in a TPS receiver, such as the GR-3 or NET-G3

* Memory cards formatted using the FAT32 file system. These
cards used in controllers, such as the FC-200 or GMS-2.

To download data from the first type of the memory card, use Topcon
Link/Topcon Tools. Only these software support such cards.

If a memory (SD) card was used in a TPS receiver, such as the GR-3
or NET-G3, and contains *.tps files, it has already been formatted.
Topcon Link can read files on a memory card formatted in the TPS
receiver file system. The device icon for a formatted card is red.
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Topcon Link can format a memory card for use in a TPS receiver,
such as the GR-3 or NET-G3. The device icon for an unformatted
card is gray. See “Adding and Formatting Devices” on page 2-1 for
details on formatting cards with a gray device icon.

pam This section describes data import using the Topcon
NOTE Link interface.
L

To use Windows® Explorer for data importing, see
“Using Windows Explorer to Import Files from a
Device” on page 4-13.

Insert the memory card into the card reader.

With Topcon Link open, click File » Import from Device.
In the left panel, double-click Topcon Memory Card.
Click the desired, formatted memory card device icon.

Wait while Topcon Link checks the card’s file system and
displays the card’s data.

Sl e

=~ Import from Device

Lookin: | fd My Computer = JJ Lockin:  [CDSurveyData = J@

Q Mobile Device
4& Topcon Digital Levels
Topron Memary Carcs

ﬂTﬂpcnn Receivers

& Topeon Total Stations [

&A Import from Device ‘E‘E‘

Look in: BTopchMemow - ﬂJ Lookire (3 SurveyData - J@
BH:

[~ Import from Device

Laok. in: BH: - ﬂJ Lackire |3 SurveyData - ﬂ@
& |
Mounting...
|
Cancel

¥ Open Files after Import

J

Close

Figure 4-10. Mount Memory Card
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5. Inthe right pane, navigate to the folder on the computer in which
to save data files.

6. Inthe left pane, select the desired file(s) and click the Move Right
button. The file import progress displays.

7. If Open File After Import was selected, the import function closes
and the file opens in Topcon Link.

&A Import from Device @E‘
Laoak in: BH: - JJ Loak in: ;]SurvepData - J@

& DERC-0705¢ tps

ﬁ, statd.tps
ﬁ, statS.tps
ﬁ, state.tps

[

|, stat7.tps
ﬁ, statd.bps

¥ Open Files after Import

J

Clase

Figure 4-11. Import File from Memory Card

To download data from the second type of the memory card, one can
use the standard Windows procedure.

Using Windows Explorer to
Import Files from a Device

After installing Topcon Link, the computer’s hard drive contains up to
five virtual drives for accessing Topcon devices to import/export data.
These virtual drives provide a quick way to transfer data without
opening Topcon Link. Many of the steps are the same as for
importing/exporting data via the Topcon Link interface. See the
corresponding section above for further details on the steps listed in

sections below.
Import from Topcon/Sokkia GPS Receivers using Explorer

1. Connect the receiver to the computer. Turn on the receiver.

2. Navigate to the Topcon Receivers device directory and click the
device icon.
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3.

After discovering devices, click the receiver’s icon.

4. Select and copy, or select and drag-and-drop, the desired files to a

directory on the computer.

8 HIPER =19
;l

Filg Edit Wiew Favorites Tools  Help i
Back - D search | [ Folders
Q- Q-1 J = from Topcon
Address |..r HIPER 3 ‘ Go rece 1
ver
Folders £ I B Ia B
) TL_Data ~
() Topeon Link Data 101h.tps logD101c.tps  logDi0ie.tps
@ Topcon Tools Data m;n];m o
< | >
% New Sokkia receiver
Fle Edt Yew Favortes Iools Help
Qus - © - (3 | O sowe [ roie from Sokkia
cess == ew 5ok recever receiver
Falders B Ia §
| [ElT
{2} My Documents 0014, 10.0.. Staticl
B3 My Computer EES
B = Soklia receivers
= New Sokkia receiver
1 & Terenn Ninkal | awele

Figure 4-12. Import Using Explorer — Receiver

Import from TPS Mobile Device using Explorer

1.

Connect the controller to the computer. Connect to the controller
via ActiveSync.

Navigate to the Topcon Mobile Devices device directory and
click the device icon.

Navigate to the CF card and the desired job file(s).

Select and copy, or select and drag-and-drop, the desired files to a
directory on the computer.
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for the job created by TopSURYV version 7.0 and later

Filz Edt Wew Favortes Tools  Help "

Qe - Q¥ /j]Search -

Adiress |3 \CF Card|TPS TapsURWyJabs

[ Folders

Folders
@ Contral Panel
= [ Mabie Device
() Application Data
) CF Card =

8% lobs (=13
.#

File Edit View Favorites Tools  Help

Qe - Q- ¥ /._U Search

address |2 \CF CardiTRS TopSURYiJobs

[ Folders

v Be

Folders
= [ Mobile Device
I Application Data
15 cF Card
(=R
1) TopsuRy

{3 Jobs v

Copy i Convert to desklop computer farmal...

Q] : g

Jug

Copying lfrom "ok’ bo deskiop computer]
ENENNNENENENEEEE

Cancel

N270405

Copying [rom Wnhs’ ko desking computes]

AENEEEENENNEENENENENENENENEEENEEENNEEE
Corvnting [hom TopSLURY SSCE database’ to TopSLURY Access database’]

L[]
Cancel

Figure 4-13. Import Using Explorer — Mobile Device

Import from TPS Total Station using Explorer

1. Connect the total station to the computer. If needed, connect to

the total station via ActiveSync.

2. Navigate to the Topcon Total Stations device directory and click

the device icon.

3. Click the icon for the connected total station and select the

“file.txt” file.

4. Copy, or select and drag-and-drop, this file to a directory on the

computer.

5. Follow all instructions on the Download from Total Station dialog

box.
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6. Click Start, then press F3 on the total station.

B GPT 3005W

File Edit View Favorites Tools  Help

@ Back = @ i ? -~ Search ||, Folders Download file from Total Station
Address | & GPT 300sw | || [Forimpeart from Topeon TotalStations GPT-2000, GPT1000, GT5-220, &
z —1 |GTS-210, GTS-310 ssfies plasss follow instrcticn below =
Folders @ Tum an the Total Stalion by pressing the POWER bulton.
Press the Marus Key
i F 3
2 Coordnate file B Fress the 'F3' key for Memon Manager
[ Digital level dats . Prezs the F4' key twice(2] until you anive at page 3
& ]From s | & Fress the F1' ke for Data Transfer
=y 4 Priss the F1" key to Send data
g i " ' i
St e = i Inthe "Send Data Sereen the user has a cheice to either send ta the a
(2 Rinex
B8 opcivicter Fils hame:  GPT 3008w
(=13 v Status:  Wating for start...

Cancel Start
sy

Figure 4-14. Import Using Explorer — Total Station

Import from TPS Digital Level using Explorer

1. Connect the digital level to the computer.

2. Navigate to the Topcon Digital Levels device directory and click
the device icon.

3. Click the icon for the connected digital level and select the
“file.dl” file.

4. Copy, or select and drag-and-drop, this file to a directory on the
computer.

5. Follow all instructions on the Download from Digital Level
dialog box.

B pL-101C

File Edit View Favorites Tools Help

Qe - @ (F| O searat

address| & pltoic

=) ES)
o

Download file from Digital Level r'z(

[ Polders

T Push [SET] key and erter the set mode
v/ 2 Push [DOWN] key any timss and selact the fle aut
3. Push [ENT] key.

Folders o 4 Push [REC] kel
.y to start the fils communication. If escape the file out
(=) I3 Topcon Tools Daka -~ made, push [ESC] key.
) Caordinate fie 5. If fle communication finishes then the display retum ta file out
[ =] Dic ata
=) From TS
o0
() Raw data Fils name:  DL-101C
123 Rinex |

Status:  Walting for start..

Cancel

Figure 4-15. Import Using Explorer — Digital Level

Import from Memory Card using Explorer

1. Insert the memory card into the card reader.
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2. Navigate to the Topcon Memory Cards device directory and click
the device icon.

3. Click the desired, formatted memory card device icon.

After mounting the card, select and copy, or select and drag-and-
drop, the desired files to a directory on the computer.

Fle Edit View Favorites Tools  Help

Qe - ) - [T O search |[2 Folders

address | B

Falders

x

= B Topcon Memory Cards Fe-C0U PE-COU
[ ] log0S0Sa.tps  logOS05h tps

Figure 4-16. Import Using Explorer — Memory Card

Viewing File and Device
Properties

The properties of a data file on a device can be viewed after
connecting to the device. Once set up in Topcon Link, device
properties can be viewed at any time.
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To view the properties of a file in a connected TPS controller or
TPS memory card, right-click the file and click Properties.

Figure 4-17 gives an example of the Properties dialog box for a data
file in a connected device.

from_tt_job2.tsv Properties E‘

General |

? from_t_jobi2tsv I

Type. TopSURY $SCE database
Location:  SCF Card\TPS\TopSURYAobs
Size: 1.43MB 1503232 bytes)

Modified: 02.01.2004 10:51:20

Abtributes: O O
= In

Cancel

Figure 4-17. Data File Properties (Example of a TopSURV File on a TPS
Controller)

To view the properties of a GPS, Total Station or Digital Level
device, right-click the device and click Properties. Table 4-1 gives
examples of the Properties dialog box for the different devices.

Table 4-1. Device Properties Dialog Boxes

TPS GPS Receiver TPS Digital Level
Receiver properties } General }

Mame:

Recsivar: Prort; Baud rate:
[cam1 | 3600 |

Model: HE_GD' n
arity:

1o 222333BBERR Even -

Part: 01

oK Caneel | ‘

ak Cancel
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Table 4-1. Device Properties Dialog Boxes

TPS Total Station
Station properties E‘
General | ad d ]
I vanced| Station properties &‘
Mame B
Beneral Advanced |
Mot Baud Rate Q600 hd
Parity ,h‘
Pait comi =l paseis |
Modsl [GPraom ] i
el GPT-3000 SwpBis [ ]
Protocol 0
oK. Cancel | ‘

For details on editing Digital Level and Total Station device
properties, see “Adding and Formatting Devices” on page 2-1.
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Notes:
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Chapter 5

GConverting Files
Between Formats

One of the primary functions of Topcon Link is to convert files from
one format to another. A file format conversion may be required to
access or work with data from multiple, proprietary, or third-party
software or systems. The Topcon Link conversion function allows
data to be cross-functional and multi-disciplinary. For example, a
survey crew may take point measurements in a field adjacent to a city
park in preparation for a new shopping center. Using Topcon Link,
this data can be converted to a shape file for uploading into the city’s
GIS database, or it can be converted to a Topcon GC3 file for sharing
with the construction crew for three-dimensional grading.

When converting files, a custom projection or custom datum may
need to be created. Topcon Link includes a number of pre-defined
projections and datums from which to base a custom projection or
custom datum.

When applying a projection or datum to a data set, transformation

parameters between the jobsite’s “grid” and the projection’s “ground”
can also be specified.
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Converting A File

To perform a format conversion, Topcon Link checks the data and its
format in the selected file and converts it to the default settings of the
selected format. Topcon Link will offer the user to select the desired
format of the file to be created from those which are allowed for the
data included in the file being converted. If it is desired to change the
coordinate system, coordinate order and/or metric units during the
process of transformation, use the Advanced Conversion options.
These options provide further control over the resulting data format.

1.
2.

Click File » Convert Files.

To select the file to convert, click Add files in the Convert Files
window.

In the Open dialog box select the appropriate format name.
Navigate to and select the desired file, then click Open. Also, the
user can activate the option for automatic recognition of the file
format in the process of opening the file. To do this, check the
“Recognize the file automatically” checkbox in the Open window
and do not select the desired file format.

If the selected file format is correct, the File status field displays
“File format is verified” and you can continue converting.

To create the file, select the appropriate format name and desired
folder where this file will be saved.

Topcon Link will use the name of the converted file to name of
the created file (except the RINEX file format). The extension for
the created file will be automatically assigned in accordance with
the selected file format. The Destination file name field displays
the name of the created file. To edit the name, click- pause-click
on this field.

To remove a file from the Convert Files window, select the
desired file and click Remove files.

To remove all files from the Convert Files window, click Clear
all.
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9.

Converting A File

If needed, click Advanced Conversion options and select the
parameters to apply to data during the conversion. See the

following sections for more details.

Available parameters depend on data in the selected
file and the format being converted to.

10. Click Convert.
Topcon Link performs the conversion, saves the file in the

selected directory.

[sowcefietpe f . |@ TopSURY Jobs j J@

Source file path

] Addiles ‘ ‘

Destination folder C
]
Besmele () EREEEEEN Fie varre: 052201
I~ Overwite existing
Faimat name: | TopSURY Jab [".ts)" Hev] j

‘ I¥ Recognize file format automatically
-

83 .
&= Convert Files

Source file path | Si file kype Destination file name | File status
File Format is verified

A TopSURY_Jobsi06-224. bsj - T N 05-224.csv

% Clear all ‘

|C “Creating Files,

o Add files | ¥ Remove files

Destination folder

Destination format

[ Dwenarite existing

e*b Advanced conversion options
2% Convert Close

Figure 5-1. Convert File

If the file conversion is successful, the Convert Files dialog box

displays the following:

s Convert Files

| Destination file name | File status

| Source file bype
File is successfully converted

Source file path
.C:\TDDSURV_Jobs\U&ZZQ.ts] TopSURY 7 Job - TopSURY Job  08-224,csv
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Converting Files Between Formats

To automatically overwrite the previously created file check the
CheCkbOXl v Overviite existing

The user can add unlimited number of files to the Convert Files dialog
box, if these files contain compatible data. If the user added the files
which have incompatible data, the conversion of these files is not
performed and the following alarm message displays:

Destination format |&Souree files contain no compatible data J

To perform a conversion, delete file(s) containing data incompatible
with other file(s).

If the user selects other format for the converted file in the Open
widow, he can select the desired file format from the format list of the
Source file type column. To activate this list, double click on the name
of the selected format:

s Convert Files

Source file path

C:\Examples_for converting files... |f

Source file path | Source file bype | Diestin:
CiiExamples_for converting files. .. ‘ Mame, N,E, Z,Code - Coordinates j,lun
= Al files A

+ Code/Layer Library
] Coordinates
BLH_MMEA-1

[ Add files > Remave files $ Custarn Text Format
Custom_FULL_CODES
Destination folder FullCode_Coord_BLH
Destination format [ KOoF
LandxmL
¥ Overwite existing M GENIO

+ Advanced conversion options

The Advanced conversion option dialog box contains a group of
fields. They are necessary to input the data used for the coordinate
transformation/metric unit/coordinate order, etc. during the file
conversion. Each converted file should be supplied with information
that is absent in the file but needed for the correct transformation. For
example, the user can set the coordinate system, metric units for the
converted coordinate file, if these data are available. These data are
entered to the From fields. For the created file, one should enter the
parameters that appear in this file after conversion. For example, the
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coordinate system in the file should be NAD 83, metric units - US
Feet, orthometric heights - take into account the usage of Geoid 2003.
These data are entered to the To fields.

In general, the data entered to the Advanced conversion option dialog
box can be divided into following groups:

1. Convert coordinate type and system, including Grid to Ground
conversion

Convert ellipsoidal/orthometric height
Convert coordinate order

Convert metric unit

Convert angular unit

Convert vertical angle

Convert distance format

Change geoid bounds

A P AT LR o

Filter raw data

Topcon Link analyses the data type of the converted/created file,
automatically selects the needed group parameter(s) used for each
format. Advanced conversion option will display only those
parameters which are needed for given types of input/output data.

The groups are independent in selecting and can be enabled/disabled
independently.

Depending on the data type of the converted/created file some fields
of any group can be disabled or not presented.

Convert Coordinate Type and System

Using the fields in the Convert coordinate type and system tab the
user can specify a coordinate system for converting and creating file.
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Depending on the data type of the converted/created file, the user can
select the following coordinate type in the To/From fields:

Coordinate type: | Grid j
Ground or Localization

Projection:

Grid, EILH

Lat, Lon, EILH
w584 Lat, Lon, EILH
Lat. Lon, Elevation

If the user selected the Ground or Localization coordinate type, the
coordinate system is set to None for the converted/created file:

Coordinate type; ‘ Ground or Localization i

Coordinate system: Mohe

If the user selected the Grid (Grid coordinate system with orthometric
heights) or Grid Ell (Grid coordinate system with ellipsoidal height)
coordinate type, the user can select a desired projection type from the
list of projections available or create a new projection. For details on
how to create a projection, see “Adding a Custom Projection” on
page 5-34:

Coordinate tpe: ‘ Grid j

Prajection: California [£aned) = Custom.. |

* If the user selected the Lat,L.on,Ell.H (a datum with ellipsoidal
heights) or Lat,Lon,Ellevation (a datum with orthometric heights)
coordinate type, the user can select a desired datum from the list
of datums available, or create a new datum. For details on how to
create a datum, see “Adding a Custom Datum” on page 5-38.

Coordinate type: |Lat, Lon, EILH j

D aturm: | Custom..
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If the user selected the WGS-84 Lat,Lon,Ell.H coordinate type, the
datum will be selected automatically:

Coordinate type: |WGSB4 Lat, Lon, EILH j

Daturn: WESE4

Using this tab the user can perform transformation between Grid and
Ground coordinate systems. The transformation will be enabled if:

* the converted file contains points in the Ground coordinate
system but a created file has to contain points in a Grid or a
Datum coordinate system. In this case Topcon Link performs
Ground to Grid transformation:

Convert coordinate type and system

Fram To
Coordinate type; Ground or Localization j Coordinate type: Grid, EllLH -
Projection: Calitornia [Zoned | Custarn.
v i [Zane3]
o Coordinate system: Mohe Q
Datum; |naDgz =l
(ﬁ Grid to ground |

* the converted file contains points in the Grid coordinate system
but a created file has to contain the point in the Ground
coordinate system. In this case Topcon Link performs Grid to
Ground transformation:

Convert coardinate twpe and system

From To
Coordinate type; ‘ Grid j Coordinate type; Ground or Localization j
Projection: % Blaska [Zone 8] | Custom...
o Q Coordinate system: Mone
Datum [MaDE3 |
@ Grid to ground

For all other combinations of coordinate systems for input/output
files the Grid and Ground is disabled:

For details on setting these parameters, see “About Grid->Ground
Parameters” on page 5-39
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Convert Height

The conversation of heights is enabled if is needed to obtain
orthometric heights for the points of the created file from the
ellipsoidal heights of the points in the converted file and vise versa.

The transformation will be enabled if:

* the converted file contains points in the Ground or Grid/Datum
coordinate system with orthometric heights, but a created file
must contain points in a Grid/Datum coordinate system with
ellipsoidal heights:

Convert coordinate type and system

From To

Coordinate type: Ground or Localization j Coardinate type: Girid, EILH
Projection, Calitornia (Zore) = Custom...
4 Coordinate system: Mone
Datum: [mape3

* the converted file contains points in the Grid/Datum coordinate
system with ellipsoidal heights, but a created file has to contain
points in a Grid/Datum coordinate system with orthometric
heights:

From To

Coordinate type: I1||:I EllH Coordinate type: |Lat Lon, Elesvation J
Projection: Alaska (Zone 8] Custom...

Dalum. NADB3 :I Custam.
Datum: [napez

In these cases Topcon Link offers to select the desired Geoid from the
list of geoids used. The user can add any Geoid file to this list by
clicking the Geoid List button (see“Adding a Geoid” on page 2-13):

From <Elevation: Tao <ENLHt

W Use geoid hd Geoids List..

TopSURYV Job is the most informative file format. This format can
contain both ellipsoidal and orthometric heights and also the name of
the geoid used for height calculation. If TopSURYV Job is converted,
Topcon Link automatically uses the height information contained in
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the job. The height conversion will be available if the geoid used in
TopSURY is presented in the Topcon Link geoid list. In an example
below, the geoid selection from the geoid list is not available:

Use geoid

If the geoid used in TopSURY is not presented in the Topcon Link
geoid list, the following message will appear:

Topcon Link

1 CGG2000e : Geoid model is not in the list. Elevation calculations will work incorrectly if you do not load this geoid
LY

Convert Coordinate Order

This type of conversion allows one to select the order of the
horizontal coordinate (Easting and Northing) for the points of the
created file if Ground/Grid/Grid Ell coordinate system is set for this
file:

Convert coordinate order

v Ta [MEH j’

ENH

If the user selected Name,N,E,Z,Code or Name,E,N,Z,Code
coordinate file format, the fields of coordinate order selecting will
display the order which defined by the corresponding file format:

Convert coordinate arder

v From‘ JTol J

Convert Metric Unit

This type of conversion allows one to select the desired metric unit
for converted and created files:

Carwert metric unit
[ From |Mele|s j To |L|SFeat ﬂ
Meters
IFect
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Convert Angular Unit

This type of conversion allows one to select the desired format of
angular values for converted/created Total Station raw files:

Canvert angular unit
3 To |oms =]

Gons
Mils

Convert Vertical Angle

If TS raw data file does not have information about vertical angle
mode, the user can select the mode under Advanced conversion option
when such file is converted/created by Topcon Link:

Convert vertical angle

[ From ‘Auto [Z4 if angle » 45 degress) j e |ZA j

[

* ZA — vertical angles are from zenith

* VA- vertical angles are from horizontal

* Auto — no information available on vertical angle mode. In an
example below, angles from 0 to 45° are considered “vertical”
and angles more than 45° are considered “zenith.”

-
90

270
Figure 5-2. Vertical Angle from Horizontal (A) and Zenith (B)
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Convert Distance Format

This type of conversion allows one to select the desired format of
distance values for a created Total Station raw file: the distance
between a station and a measured point can be recorded either as
slope distance and vertical angle or as horizontal and vertical
distances. Selecting Auto records distances into the created file using
the distance format of the converted file:

Corwert distance format
i3 Te [Ho gD |
Auto
5D & Angle

Change Geoid Bounds

This option allows one to define the area of a created geoid file from
any supported geoid model. When converting from a Geoid file, the
following parameters are available in the right pane:

* Minimum / Maximum Latitude — enter the minimum and
maximum latitude of the points that limit the use of this model.
Latitudes are positive for the Northern hemisphere.

Minimum / Maximum Longitude — enter the minimum and maximum
longitude of the points that limit the use of this model. Longitudes are
positive for the Eastern hemisphere.

Filter Raw Data

This option allows one to include:
* GPS or GLONASS satellites

* pseudorange and phase measurements on L1 or L2 frequency
to created RINEX/Compact RINEX/Topcon TPD file formats:

Channels
¥ GPS

| W GLOMASS
b L1
v i3

To remove any item, uncheck a desired checkbox.
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The following sections describe the file format conversions, as well
as list which files can be converted to which format.

“Code Library File Conversion Parameters” on page 5-12
“Coordinate File Conversion Parameters” on page 5-13
“Example of Conversion Coordinates File” on page 5-14
“Geoid File Conversion Parameters” on page 5-20

“GPS+ Raw Data File Conversion Parameters” on page 5-21
“Localization GC3 File Conversion Parameters” on page 5-24
“Road File Conversion Parameters” on page 5-24

“Topcon XML File Conversion Parameters” on page 5-26
“TopSURYV Job File Conversion Parameters” on page 5-27
“TS Obs File Conversion Parameters” on page 5-33

“X-Section Template File Conversion Parameters” on page 5-34

Code Library File Conversion
Parameters

A code library file contains a description of codes, such as code
name, plotting style, and attribute. Table 5-1 lists the formats that a
code library can be converted to.

Table 5-1. Code Library File Conversion Formats

From a... To a...

Code Library file: Code Library file

DBF Code Library, TDD Code Library, | TopSURYV Job file
XML Code Library, Autodesk Layer
States Code Library

TopSURYV Job file Code Library file

When converting from a Code Library file, no further parameters are
required.
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Coordinate File Conversion

Parameters

A coordinate file contains a list of points in some coordinate system.
Table 5-2 lists the formats that a coordinate file can be converted to/

from.

Table 5-2. Coordinate File Conversion Formats

From a...

To a...

Coordinate file:

Custom Text Format; Topcon FC-4;
Topcon FC-5; Topcon GTS-210/310-10;
Topcon GTS 210/310-12; Topcon GTS-
7; LandXML; Topcon XML; TopSURV;
Name,E,N,Z,Code; Name,N,E,Z,Code;
Name,Lat,LL.on,Ht,Code; SBG Geo; SBG
Pxy; TDS; KOF

Coordinate file
Design

GIS: ESRI Shape
Topcon XML file
TopSURYV Job file

TopSURYV Job file

Coordinate file

Design

Coordinate file

TS Obs (if the format contains point
coordinates)

Coordinate file

GIS: ESRI Shape

Coordinate file

@

Available parameters depend on the data in the
selected file and the format being created.

When converting from/to a coordinate file the user can select the

following parameters:

1. Convert coordinate type and system (see “Convert Coordinate
Type and System” on page 5-5)

Convert height (see “Convert Height” on page 5-8)

3. Convert coordinate order (see “Convert Coordinate Order” on

page 5-9)

4. Convert metric unit (see “Convert Metric Unit” on page 5-9)
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These parameters are selected independently and can be enabled/
disabled independently:

for converted coordinate file:

= Ebvanced corveision opliors
Conves coodngns s snd tyrlen
Frem
Coorrdnate lype: [rewrt or Lnesizancn =
S e — Hone
& B in grewrd
Corvest gt
From (Elvaiisns To (ELHE
b Use gasid [82002u01 *|  Gcids Lisk..
Conves coordingte order
o A =l for created coordinate file
Convent metsc und
o Fom s
Ta
D3 Conven
Conuinain bype G FIH =]
Pupction (I ~|  cision
Dzt MADER =
& Biidto ground |

To <EL He

Uom g [$£0050T ] o Lt
Ta | J

T2 [UsFe |

Figure 5-3. Convert Coordinate File — Example

Example of Conversion Coordinates File

The following pages describe the example of conversion of the
coordinate file (‘lat_lon_ell.txt”), which contains the points in the
datum coordinates (NADS83). This file has Lat, Lon, Ht, Code file
format, and height is ellipsoidal height in meters:

Latitude -H
5 P4

I lat_lon_ell.txt - Notepad

File Edit Format Wiew Help P
BASEZ,40 06 OF.52051,-82 50 12.47055,208.176, BasE,

Cp2,40 06 11,08726,-82 59 16.18872,247, 004,

CP4,40 06 13,12269,-82 59 10.68572, 246,934,

CP3,40 06 OF,23787,-82 59 06.52397, 246, 268, P44, 4 BASEZ

CPG,40 06 05,22798,-82 59 12.11035,246,429, 5 CPS
40°06/05N %‘ &R
T
‘ GeSdSw  arEElOW  BRURASW

The task is to convert this file to other coordinates file, which will
contain the points in Grid coordinates system (SPC83-Ohio (North)),
with orthometric height in US Feet.

5-14 Topcon Link Refenence Manual



Converting A File

To create such a file, we do the following steps:
1. Click File->Convert Files and click Add Files in the
window. The Import window appears.
2. Navigate to the desired file, highlight it and select the
corresponding file format in the Format name field:

¥ Convert Files

Source file path Source file bype

Laok in: ]k':'} Raw Data

[T Columbus RTK Survey

(T3 Columbus Total Station Survey
gCMH Static Unprocessed

115 at_lon_ell st

(2 Add fles

Destinatior folder

Destinatior format

[ (Laniile s File name: |lat_lon_elltst

| Format name: 1_ Mame,Lat Lon Ht,Cade - Coardinates [* cav] Li

¥ Recognizs file farmat automatically

Open J\I Cancel

.}
3. The converted file appears in the list of the converted
files:
Source file path | Source file bype | Diestination file name File status I
CiiRaw Datallat_lon_ell bzt Mame,Lat,Lon,Ht,Code - Coor,,, lat_lon_ell.csy Mot converted

4. Check the Advanced conversion option checkbox:

i v Advanced conversion options I
1

_____ X

5. Select the format name for the grid coordinate system of
the created file in the Destination format field:

Destination format
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6. Select or create the folder where this file will be saved

(by clicking =} ):

Destination folder Ch

Browse For Folder. Elﬁ‘ = I

Select foldsr

Desktop
ur_‘ My Documents

‘-J My MNebwark Places

I Make Mew Folder It [ 0K ] [ Cancel ]

7. Change the name of the created file in the Destination
field name field:

Diestination file name
' Grid_Ortha csv

8. Select the Grid coordinate system and Ohio (North)
projection in the corresponding fields:

Destination file name
Jat_lon_ell.csv

To
Coordinate type: |Gnd j

Projection Ohio [Morth] = Custom...

9. Add the ‘g2003u07.bin’ geoid file to the list of geoids
used. To do this, click the Geoid List button, click Add
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and select the folder where the desired geoid file is
located:

2003004

File hamme: |92003007 bin
27 Geoid394Genid2003 Files (g7 bin) Ll

Open Cancel
- =]

Then activate this geoid for conversion of the coordinate file:

Format name:

Usze geoid e
—> Use geoid |2
Eqmak

10. Select ‘Meters’ for the converted and ‘Us Feet’ for the
created file in the Convert metric unit fields:

"Emvelt metnic it

f From IMelels LI To [UsFest Ll

Meters
IFect

11. Click the Convert button.If the file conversion is
successful, the Convert Files dialog box displays the
following:

Source file path | Source file type | Diestination file name | File status |

.C:\Raw Datallat_lon_ell bxt.csv Mame,Lat,Lon,Ht, Cade - Coor...  Grid_Ortha.csy File is successfully converted

12. The created file has the following coordinates and
heights:
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File Edt Format WYiew Help
BASEZ,159015.452,1832310. 524,794,107

CP2,159382.018,1832023, 596,021, 785,
CP4,159585.613,1852452. 388,021, 270,

CP3,158988.274,1832772.486,919. 090, P#44

CP6,158787.298,1832336.522,919. 609,

Marthing,
USFest 4P
159500

e
, BasE

4-BASEZ 0
:1 $Fe

T T T T T

= 1832500 1533000

Design and Surface File Conversion

Parameters

A design file contains CAD information (points, linework, surfaces).
Table 5-3 lists the formats that a design file can be converted to/from.

Table 5-3. DWG, DXF, LandXML Design File Conversion Formats

From a...

To a...

Design file: AutoCAD Drawing,
AutoCAD DXF; KOF; LandXML,
Microstation 95/ISFF, MX GENIO Line,
SBG Geo, SBG Pxy, Topcon 3D
Linework, Topcon 3D Surface,

Design file
* Coordinate file
TopSURYV Job file

Surface file

Coordinate file

Design file: AutoCAD Drawing,
AutoCAD DXF; KOF; LandXML,SBG
Geo, SBG Pxy,

TS Obs

Design file: AutoCAD Drawing,
AutoCAD DXF; KOF; LandXML,SBG
Geo, SBG Pxy,

TopSURV Job file

Design file: AutoCAD Drawing,
AutoCAD DXF; KOF; LandXML,SBG
Geo, SBG Pxy, Microstation 95/ISFF,
Microstation V8, Topcon 3D Linework

Topcon XML file Design file: AutoCAD Drawing,
AutoCAD DXF; KOF; LandXML,SBG
Geo, SBG Pxy,

GPS Obs Design file: LandXML
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Table 5-3. DWG, DXF, LandXML Design File Conversion Formats (Continued)

From a... To a...

Design file, Topcon 3D Surface Design file: AutoCAD Drawing,
AutoCAD DXF; LandXML

] Available parameters depend on the data in the
NOTE selected file and the format being created.

When converting from/to a Design file, the user can enable and select
the following parameters:

1. Convert coordinate type and system (see “Convert Coordinate
Type and System” on page 5-5)
Convert height (see “Convert Height” on page 5-8)

3. Convert coordinate order (see “Convert Coordinate Order” on
page 5-9)

4. Convert metric unit (see “Convert Metric Unit” on page 5-9)

for converted design file:

= Advanced conenion cpbiorn
Conven cosdinge hips end 1ysten
From
Coorrdnate lype: [rewrt or Lnesizancn =
7 Coedomemysme Hone
& Gadio grerd
Conves hesght
Fram <Evaiians To (ELHE
= e . oo
Use gecd 3209201 =] Gesds i for created design file:
Conved codingte crder
w Foom | Ta
Conven metsc und Consdinale bpe: Gad, FIH =
R From [Meies Pupction (I ~|  cision
D3 Conven Dot MANE =
& B to groumd |

To <EL He

Uom g [$£0050T ] o Lt
Ta | J

T2 [UsFes |

Figure 5-4. Convert Design File — Example
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Topcon Digital Level File Conversion
Parameters
A digital level file contains level measurements from a station to

points. Table 5-4 lists the formats that a digital level file can be
converted to.

Table 5-4. Topcon Digital Level Conversion Formats

From a... To a...
Topcon Digital Level: * Topcon XML file
DL, LEV, TXT, Topcon XML * TopSURYV Job file

When converting from Topcon Digital Level file the user can select
only the Convert metric unit option (see “Convert Metric Unit” on
page 5-9).

Geoid File Conversion Parameters

A geoid file contains data on a physical reference surface. The shape
of the geoid reflects the distribution of mass inside the earth. The rise
and fall of the surface in a geoid is important for converting GPS-
derived ellipsoidal height differences to orthometric height
differences.

Using Topcon Link, you can create a Topcon geoid file (*.gff) for a
defined area from any supported geoid model—creating a sub-section
of the selected geoid file. This file can then be exported into
TopSURV. Table 5-4 lists the formats that a geoid file can be
converted to.

Table 5-5. Geoid Conversion Formats

From a... To a...

Geoid file Topcon Geoid file

When converting from a Geoid file, the user can enable and select
only the Change geoid bounds option (see “Change Geoid Bounds”
on page 5-11)
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GPS+ Raw Data File Conversion
Parameters

RINEX is the standard format for exchanging GPS raw data between
devices and software. For a static/kinematic observation session
(occupation), two or three files are created.

¢ The first file stores the observations and has a *.0* extension.

* The second and third files store GPS and GLONASS navigation
data (orbits) for those observations and has a *.N* or *.G*
extension, respectively.

A Compact RINEX file (or Hatanaka compressed file) is the
compression of a RINEX observation file, and has a *.D* extension.
TPD (and TPS/JPS) files are a Topcon proprietary format for storing
and transferring GPS raw data.

Table 5-6 lists the formats that a GPS+ raw data file can be converted
to/from.

Table 5-6. Compact RINEX File Conversion Formats

From a... To a...
Compact RINEX file ¢ RINEX file
* TPD file
RINEX file * Compact RINEX file
» TPD file
GPS+ TPS/JPS and TPD e RINEX file
¢ Compact RINEX file

When converting to a RINEX or Compact RINEX file, the user can
enable and select only the Filter raw data option (see “Filter Raw
Data” on page 5-11).

Example of Conversion TPS File to RINEX File

The following pages describe the example of conversion of the TPS
file (‘DER1-0303b.tps’). This file was collected by dual frequency
GPS/GLONASS Topcon receiver. It needs to create the RINEX file
with GPS L1 raw data only.
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To create this file, do the following steps:
1. Click File->Convert Files and click Add Files in the
window. The Import window displays

2. Navigate to the desired file, highlight it and select the
corresponding file format in the Format name field:

Source file path J Source file type J Destination Folder ... ! File status

| & TPs data

%5
B A [DERT 0303 tps
[restination | Format name: ]7 GPS+ Raw Data [“.tpd” 2707 776G, 77N 770 " tp=:" ips] j

W Recogrize file format automatically

ors_|

] ‘ bl ‘ Y

L) File rarne:

Destination

v Overi

3. The converted file appears in the list of the converted
files:

%2 Convert Files

bource file path Source file type ! Destination folder ... J File status
CihExamples_For converting files For TLiNK\TPS data\DER1-0303b.kps  TPS - GPS+ Raw Data i1 File Format is verified

4. Check the Advanced conversion option checkbox:

i v Advanced conversion options )
L

5. Select the RINEX file format for the created file in the
Destination format field:

Diestination format

6. Type in a name of a new folder in the Destination folder
name field:

Destination folder |C “Examples_for converting files for TLinkARIMER DAl
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The created files will be stored in the folder.
7. Uncheck the desired channels:

Charnels
W GPS

[~ GLOMWASS
v L1

Lz

8. Click the Convert button. The following message
appears:

Topcon Link

1] Folder C:\Examples_for correerting Files For TLiInk\RIMEX DATAY not Found, Create?
ey

Ves Mo

Press Yes to create this folder. If the file conversion is successful,
the Convert Files dialog box displays the following:

&% Convert Files

| source file path | source fils type | Destination Folde.... | Fils status [
‘@C:\Examp\es_ﬁ:r converting files for TLINK\TPS datalDER1-0303b.tps  TPS - GPS+ Raw Data | File is successfully converted

9. The created file has the following data:

2.18 OBSERUATION DATA G (GPS) RINEX UVERSION / TYPE
Topcon Link 7 21-HOU-B7 28:58 PGH / RUN BY / DATE
build July 25, 2862 (c) Topcon Positioning Systenms COMHENT
DER1-8383b_JFGE HARKER HNAHE

HARKER HUHBER
-Unknoun- —Unknown- OBSERUVER / AGENCY
AFFRRRF JFGG —Unknown- -Unknown- REC # / TYPE / VERS
-Unknoun- —Unknown- ANT # / TYPE
2850716.2627 21993741797 5247224 3437 APPROX POSITION X¥2Z
0.0000 08.0000 0.0000 ANTENNA: DELTA H/E/H
1 a WAVELENGTH FACT L1/2
208085 3 3 1 8 8.80688088 GPS TIME OF FIRST 0OBS
2005 3 3 1 59 59.0000000 GPS TIME OF LAST OBS
1.008 INTERVAL
13 LEAP SECONDS
13 # OF SATELLITES
4 c1 P1 L1 D1 # / TYPES OF OBSERV
(L = a4 TO0A a4 a4 PRN 4 # NE NRT
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Localization GC3 File Conversion
Parameters

A localization file contains coordinate points in both the local and
global coordinate systems. These systems are used in the calculation
of localization points. Table 5-7 lists the formats that a localization
file can be converted to.

Table 5-7. Localization File Conversion Formats

From a... To a...
Localization file: Topcon 3D TopSURYV Job file
TopSURYV Job file Localization file

If the TopSURY file contains pairs of
point coordinates in WGS84 and local
system for each Control point.

When converting from a Localization file, no further parameters are
required.

When converting to a Localization file, the user can enable and select
only the Convert metric unit option (see “Convert Metric Unit” on
page 5-9)

Road File Conversion Parameters

A road file contains information about the stations/chainages,
alignments, cross-sections, and grades required for creating a road.
Table 5-8 lists the formats that a road file can be converted to/from.

Table 5-8. Road File Conversion Formats

From a... To a...

Road file: CLIP, ISPOL, LandXML, ¢ Road file
MX GENIO, SBG, SSS, TDS, Tekla, + TopSURYV Job file
Topcon 3D, Topcon XML, TopSURV |, Topcon XML

¢ X-Section Templates
¢ Design file: LandXML

TopSURYV Job file Road file
If the TopSURY file contains road data.
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When converting from a Road file, the user can select:

1. Convert coordinate type and system (see “Convert Coordinate
Type and System” on page 5-5)
Convert metric unit (see “Convert Metric Unit” on page 5-9.
3. Convert coordinate order (see “Convert Coordinate Order” on
page 5-9)

4. Convert metric unit (see “Convert Metric Unit” on page 5-9 no
further parameters are required.

Conwert coordinate type and systern
From

Coordinate type: ‘Ground or Localization j

- Coordinate system:  Mone

w for created road file:

Convert metric unit

To
[¢ From |Melels
Coordinate type: A
By -
) Eemat > et Dbia [Narth] | Custom
for converted road file: Datum: [NADE3 =]
To [NEH ~|
To |UusFest =

Figure 5-5. Convert Roads File — Example
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Topcon XML File Conversion

Parameters

A Topcon XML file can contains points, roads, TS measurements,
DL measurements, and/or any GPS observations. Table 5-9 lists the

formats that a Topcon XML file can be converted to/from.

Table 5-9. Topcon XML File Conversion Formats

From a...

To a...

Topcon XML file

Coordinate file
Design (except TN3) file
GIS: ESRI Shape file

¢ TopSURYV Job file

* GPS Obs

e DL Obs

* TS Obs

* Road

* X-Section

¢ Topcon XML
Coordinate file Topcon XML file
Design (except TN3and LN3) Topcon XML file
TopSURYV Job file Topcon XML file
DL obs Topcon XML file
TS Obs Topcon XML file
GPS Obs Topcon XML file
Land XML Topcon XML file
Road Topcon XML file
X-Section Topcon XML file

Available parameters depend on the data in the

selected file and the format being created.

When converting from/to a Design file the user can select the

following options:

5-26
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1. Convert coordinate type and system (see “Convert Coordinate
Type and System” on page 5-5)
Convert height (see “Convert Height” on page 5-8)

3. Convert coordinate order (see “Convert Coordinate Order” on
page 5-9)

4. Convert metric unit (see “Convert Metric Unit” on page 5-9)

5. Convert angular unit (see “Convert Angular Unit” on page 5-10)

6. Convert vertical angle (see“Convert Vertical Angle” on page 5-
10)

TopSURYV Job File Conversion
Parameters

A TopSURY Job file can contain the following measurements:

* Total Station measurements (the distance, vertical angle, and
horizontal angle measurements from a station to a point).

* Digital Level measurements (the level measurements from a
station to a point).

¢ GPS Observation (the coordinate increment in the current
projection and solution type for the measurement).
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Table 5-10 lists the formats that a TopSURYV Job file can be

converted to/from.

Table 5-10. TopSURYV Job File Conversion Formats

From a... To a...
TopSURYV Job file: ¢ Code/Layer Library
TopSURYV 7 Job, ¢ Coordinate file
TopSURYV PC Job ¢ GPS Obs
* TS Obs
* DL Obs

¢ GIS: ESRI Shape file

¢ Design file

* Topcon XML file

* Localization file (if the TopSURYV file
contains pairs of point coordinates in
WGS84 and local system )

* Cut Sheet file (if the TopSURYV file
includes Stakeout points)

* Road file (if the TopSURYV file
includes road data)

* X-Section Template file (if the
TopSURY file includes an X-section
template)

* TopSURYV Job file

Coordinate file TopSURY Job file
DL Obs TopSURYV Job file
TS Obs TopSURYV Job file
GPS Obs TopSURYV Job file
Topcon XMLr TopSURYV Job file
Localization file TopSURYV Job file
Design file TopSURY Job file
Road file TopSURYV Job file
X-Section Template file TopSURYV Job file
Code/Layer Library TopSURYV Job file

TopSURYV 7 Job/TopSURYV PC Job

TopSURYV PC Job/TopSURYV 7 Job
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- Available parameters depend on the data in the
selected file and the format being created.

When converting from a TopSURYV Job file, no further parameters
are required.

When converting to a TopSURYV Job file the following parameters
are available:

1. Convert coordinate type and system (see “Convert Coordinate
Type and System” on page 5-5)

2. Convert height (see “Convert Height” on page 5-8)

3. Convert coordinate order (see “Convert Coordinate Order” on
page 5-9)

4. Convert metric unit (see “Convert Metric Unit” on page 5-9)

5. Convert angular unit (see “Convert Angular Unit” on page 5-10)

6. Convert vertical angle (see“Convert Vertical Angle” on page 5-
10)

Example of Conversion TopSURV File to
Topcon Vector File

The following pages describe the example of conversion of the
TopSURYV 7 Job file (‘columbus_rtk_ts.tsj’). This file was collected
by Topcon Controller FC -200 with TopSURYV version 7.0 and was
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saved on the controller’s removable flash memory card. This job
contains the TS measurements and GPS RTK observations:

Latitude

40°06'12.5N  —

40°06'10.0M —|

40°06'07.5M  —|

/b PS5

/

e
(T3l
G2°59'15.0W 82°50'12.5 82°53'10, 04 82°59'07.5W a2o59

The task is to create the Topcon Vector file and save this file on the
computer.

To create this file, we do the following steps:

1. Insert the controller’s removable flash memory card into
the computer’s card reader.

2. Click File->Convert Files and click Add Files in the
window. The Import window displays.
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3. Navigate to the desired file, highlight it and select the
corresponding file format in the Format name field:

bl it
| i Ope |
e i Aot B (=9 topSURY_Job_7 | _!«I gfj =
olumbus_rtk_ts.tsj
I« b
£ Add files | 2
beslimalian folder o File name: !culumbusﬁltkﬁts.tsi :1
Diestination format Format name: ]-;'T:- TopSURY 7.Job - TopSURY Jab [".tsj) :j a
W Overwiite exicting ¥ Recognize file format automatically
[ ad d conver Cancel
A Slop Llose ] &
4. The converted file appears in the list of the converted
files:
‘ta Convert Files |EHE|
I
1 Source file path ! Source file bype I Destination file name ] File status ]
‘ G:\bopSURY_Job_7lcalumbus_rtk_ts.ksj TopSURY 7 Job - TopSURY Job columbus_rtk_ts.xml  File Format is verified

5. Check the Advanced conversion option checkbox:

i v Advanced conversion options

6. Select the Topcon vector file format for the created file in
the Destination format field:

Drestination format ‘ Topeon Wectors - GPS Obs (7 tf] j

7. Type in a name of a new folder in the Destination folder
name field:

Destination folder |C:hraw DataAGPS OF| =] I

The created files will be stored in this folder.
8. Select the desired metric unit for the created file:

Carwert metric unit
¥ To [UsFeet |

USFeet

P/N 7010-0522 5-31



Converting Files Between Formats

9. Click the Convert button. The following message

appears:

Topcon Link

1] Folder C:iraw DatalGPS OBSY not found. Create?
LY

fes Mo

10. Press Yes to create this folder. If the file conversion is
successful, the Convert Files dialog box displays the
following:

%% Convert Files

Source file path
@ Gr\topsURY _Tob_7icolumbus_rtk_ts.tsj  TopSURY 7 Job - TopSURY Job

Source file bype

Columbus_rtk_ts tvf

| Destination file name | File status

File is successfully converted

11. The created file has the following data:

W Ponts @9 GPS Obs Iq? GRS Occupations |

Latitude |
] ?11
06'12.5N
1 110
] 109
°08'10.0N —|
] C{m 01
1 100
J 02
057N ase2
4 04
1 13
060500 —|
: B e e 7
B2o59'20W B2°59'15W B2°59'10W B2°59'05W

9-32

Tcon | Paint From | Poin... | Start... | Dur... | Horizontal Preci... | Vertical Precis... dr () | dE (m’
&, Bassz 11z 0.004 0.003 10.950 -38.82%
@ Basez 114 0.005 0.007 -11.428 a7.221
@, Base2 110 0.004 0.004 127.133 57,401
e R st T S
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TS Obs File Conversion Parameters

A total station observation file contains the distance and vertical/
horizontal angles measurements from a station to a point. Table 5-11
lists the formats that a total station observation file can be converted
to.

Table 5-11. TS Obs File Conversion Formats

From a... To a...
TS Obs file: ¢ Measurement file
Custom Text Format, FC-5 Raw, ¢ Coordinate file

GTS-210_310 Raw, GTS-6 Raw, GTS- |+ Design file
7 Raw, GTS-7+ Raw, Topcon XML TS |, GIS: ESRI Shape file

Ob.
s * Topcon XML file

* TopSURYV Job file

e TS Obs file
TopSURYV Job file * TS Obs file
Topcon XML file * TS Obs file
TS Obs file * TS Obs file
] Available parameters depend on the data in the
— selected file and the format being created.

When converting from/to a TopSURYV Job file, the following
parameters are available:

1. Convert coordinate system (see “Convert Coordinate Type and
System” on page 5-5)
Convert height (see “Convert Height” on page 5-8)

3. Convert coordinate order (see “Convert Coordinate Order” on
page 5-9)

4. Convert metric unit (see “Convert Metric Unit” on page 5-9)

5. Convert angular unit (see “Convert Angular Unit” on page 5-10)

6. Convert vertical angle (see“Convert Vertical Angle” on page 5-
10)

P/N 7010-0522 5-33



7. Convert distance format (see*“Convert Distance Format” on
page 5-11)

X-Section Template File Conversion
Parameters
A cross-section template file contains information used for creating a

road. Table 5-12 lists the formats that a cross-section template file
can be converted to/from.

Table 5-12. X-Section Template File Conversion Formats

From a... To a...
X-Section Template file * X-Section Template file
* TopSURYV Job file
TopSURYV Job file X-Section Template file
If the TopSURY file contains cross-
section data.

When converting from/to X-section Template file, the user can select
only the Convert metric unit option (see “Convert Metric Unit” on
page 5-9).

Adding a Custom Projection

A projection contains pre-defined transformation data that is used for
conversions between local and global positions. While Topcon Link
includes a number of pre-defined projections, a custom projection
may be needed for your jobsite or geographical area. Custom
projections are included in the projection list.

1. On the Convert Files dialog box, click Custom next to the
Projection selection box.



Adding a Custom Projection

2. Click Add.
%A Custom Projections List
Mame ‘ Region Datum Mote
< >

Add L\} ‘ Remove | Close:

Figure 5-6. Custom Projections List

3. Enter a name for the new projection.

Select the type of projection and edit the parameters to create a
custom projection. See Table 5-13 on page 5-36 for details and a
description of editable parameters for each projection type.

5. Set remaining information for the custom projection.
* enter a region for the projection (for example: USA)

e enter any applicable notes, such as the projection used (for
example: CA, Zone 5)

* select the datum for the projection

¥4 New Custom Projection : Projection None E|E|
General I
Mame [My New Prajection ‘: _e
Projection Type ‘Tranwer:e-Mercatol j
Mame | Yalue
Central meridian 0°00'00,000
Srale 1.5
Lat0 0°00'00.000
Eastd {m) 50
Narkh {m]) 50
—
MNarne: | Region | Datum | Mote Projection Type |
My New Proje... CA WGS84 Mynotes  Transverse-Mercator
L3 2 Add | Remove |
Region |EA
by nates
Hote ‘—e
Datum [wGsed |
oK k Cancal ‘ Apply‘_‘_ _e

Figure 5-7. Enter Custom Projection Parameters — Example

6. Click Apply to set the information, then Ok to add the projection
to the list of custom projections.

7. Click Close to exit the custom datum function.
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The following table (Table 5-13 on page 5-36) describes
projection types and lists the parameters available for creating a
custom projection. A map projection is a systematic representation of
all or part of the surface of a round body (the Earth) on a plane. Each
projection is specified using a particular set of parameters and can be
used for different territories or customized uses.

Table 5-13. Projection Types

Projection Type and Editable Settings

Examples (With Defaults)

Transverse-Mercator

A cylindrical projection of the Earth
rotated at 90° relative to the equator.
This projection creates little distortion of
scale where the projected surface is
tangent to the sphere representing the
Earth. This projection is useful in areas
of narrow longitudinal range.

&4 New Custom Projection : Projection None

General |

Hame My New Frojestion

Frojection Type | Transverse Mereator |
Narme: [ value

Central meridian 0°00'00.000

Scale 1

Lato 0°00'00.000

Eastd {m) 1}

Mortho {m) 1}

Lambert

A conic conformal projection of the
Earth. This projection is useful in areas
with a predominant east-west expanse.

&4 New Custom Projection : Projection None

General |

Hame My New Frojestion

Frojection Type | Lambert |
Narme: [ value

South Lat 0°00'00.000

Morth Lat 30°00'00.000M

LonQ 0°00'00.000

Lato 0°00'00.000

Eastd {m) 1}

Mortho {m) 1}

Double Stereographic

A spherical projection of the Earth first
on conformal sphere, then on a plane,
from a single point. This projection
provides a perspective view while
conformally mapping a sphere onto a
plane. This projection is useful in single
hemispheres.

&4 New Custom Projection : Projection None

General |

Hame My New Frojestion

Frojection Type | Double Steromraphic |
Narme: [ value

Lato 0°00'00.000

Lon 0°00'00.000

Scale 1
Eastt {m)

[
Morthd () i
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Table 5-13. Projection Types (Continued)

Projection Type and Editable Settings

Examples (With Defaults)

Stereographic

A spherical projection of the Earth on a
plane from a single point. This
projection conformally maps shapes and
angles, but creates areal distortion
farther from the projection point. This
projection is useful in single
hemispheres.

Name:

General |

kA New Custom Prajection : Projection None

[My New Projection

Projection Type [ stereoaraphic ~|
Mame [ value
Lat0 0°00'00.000
Lon0 0°00'00.000
Scale 1
East0 (m) o
North () o

Oblique Mercator

A cylindrical projection of the Earth
rotated at some angle relative to a central
line. This projection creates little
distortion of scale where the projected
surface is tangent to the sphere
representing the Earth. This projection is
useful in areas that are oblique from a
other Mercator projections, that is an
area predominantly neither east-west nor
north-south.

& New Cu

General |

stom Projection : Projection None

Name [My New Projection
Projection Type | Oblique Mercator ~|

Mame | value

fiis azimuth 00000000

Scale 1

Lon 0°00'00.000

Lat0 00000000

East0 (m) i

Northd {m) 0

Albers Equal Area

A conical, equal area projection of an
area that uses two standard parallels to
minimize distortion. This projection
creates little distortion of angle and scale
between two parallel lines. This
projection is useful in equal-area,
predominantly east-west regions.

&4 New Custom Projection : Projection None

General |

Mame [My New Projection

Frojection Type | Albers Equal Area |
Narme: [ value

South Lat 0°00'00.000

Morth Lat 30°00'00.000M

LonQ 0°00'00.000

Lato 0°00'00.000

Eastd {m) 1}

Mortho {m) 1}
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Table 5-13. Projection Types (Continued)

Projection Type and Editable Settings

Examples (With Defaults)

Cassini-Soldner

A cylindrical, equidistant projection of
the Earth rotated at 90° along the central
meridian with lines plotted along an X,Y
graph. This projection creates little
distortion of scale along the meridian
and lines perpendicular to the meridian.
This projection is useful in simple
mappings.

kA New Custom Prajection : Projection None

General |

Name:

Proisction Type

BIX

[My New Projection

[ cassini-olner

Mame

| alue

Latn

LonD

futs azimuth
East0 (m)
Mortho {m)

0°00'00.000
0°00'00.000
0°00'00.000
a
a

Adding a Custom Datum

While Topcon Link includes a number of pre-defined datums from
around the world, a custom datum may be needed for your particular
jobsite or geographical area. Custom datums are included in the

datum list.

1. On the Convert Files dialog box, click Custom next to the Datum

selection box.
2. Click Add.

kA Custom Datums List

Mame ‘ Mote

Ellipsoid

D

Add % ‘ Remove |

»

Close

Figure 5-8. Custom Datums List

¢ enter the new datum name

* select the ellipsoid used for the datum
* enter the DX, DY, DZ values for the ellipsoid’s shift

Set the following information for the new datum:

parameters (the default values are zero)

* enter the RX, RY, RZ values for the ellipsoid’s angle rotation
parameters (the default values are zero)
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About Grid->Ground Parameters

* enter the Scale by which to adjust the ellipsoid (the default
value is zero)

* enter any identifying notes for the datum

ST

X
Y

The shifts, rotations and scale parameters specify a
coordinate transformation from the newly created

reference datum to WGS84 according to the
following equation:

DX

1 RzZ -RY| [X

= |py +(1+Sca|e-1076)- _RZ 1 RX|'|y

Zlwes-gs |DZ

RY -RX 1 A new —datum

General l

Mame
Ellipsoid
]

D [m)

D2 [m)
R

RY [

RZ [
Scale [ppm]

Mote

=

[wiGsas |
B

B

B

[15

[15

& Custom Datums List

Mame | Mots | Elipsoid | Dx(m) | 0¥ m) | 02 (m) | Re( ] RY (Y]

[E
[E

by Mew Datum

@CA My M. WGES84 30000 30000 3.0000 15, 15

< b

Add | FRemove | i Close %

oK | Cancel ‘ Apply N-\-

 © o

Figure 5-9. Enter Custom Datum Parameters

4. Click Apply to set the information, then Ok to add the datum to
the list of custom datums.

5. Click Close to exit the custom datum function.

About Grid->Ground
Parameters

A ground projection is a grid mapping projection re-scaled, rotated
and shifted to convertpoint coordinates to another reference surface
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(up to average project elevation) to produce near ground values. To
set a grid-to-ground transformation, Topcon Link rotates the ground
system relative to the origin of the grid coordinate system.

1. To enter grid->ground parameters, enable the corresponding
check box and click the browse button.
2. Set the scale factor using one of the following methods:
 Select Avg. Job Height. Then enter an average height from
all points in the job and enter the value of the Map Scale
Factor.
¢ Select Scale Factor. Then enter the value of the Map Scale
Factor.
3. Enter the northing and easting offsets in meters from the origin of
the grid coordinate system.
4. Enter the azimuth rotation angle in degrees/minutes/seconds
between the grid and ground coordinate systems. This angle
defines the reference direction for ground azimuths.

5. Click Ok.

8 Grid->Ground Parameters E]E] # Grid->Ground Parameters E]
Scale Factor Scale Factor

‘Avg Job Height j |Sca|e Factar j

Ava Job Height (m] [8.23 Awa Job Height (m) [0

Scale Factor [ Seale Factor |3

Mapping Seale |1 tapping Scale [

Maoithing Offset [m] \5 Morthing Offset [m] \5

E asting Offzet [m] \5 E asting Offzet [m] \5
Azimuth Rotation  [9°15'00.0000 Azimuth Rotation  [8°015'00.0000

Cancel 0K Ek Cancel

Figure 5-10. Enter Grid->Ground Parameters
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Chapter 6

Editing Data in Topcon
Link

After opening a file in Topcon Link, you may want to edit some data
before saving it for post-processing or exporting it to a device. The
following list describes just some of the edits you can perform to
prepare data for other activities.

* Add a point

 Edit/add a GPS antenna

* Assign photo notes

* Add codes/attributes

« Edit total station observation offsets

Because many editing activities are similar, the sections in this
chapter are set up to provide editing details based on data tables.

Editing Points

Among other editing activities, Topcon Link can be used to edit
coordinates or point names, delete a measurement taken for another
point, edit or enter the antenna height.

Add a Point

Open a file (excepting a GPS+ Raw Data file)
Click Edit » Add » Point (or click Add Point on the toolbar).

Enter a new name for the point.

sl LSS

Edit other parameters as needed. See “Edit in the Point Properties
Dialog Box” on page 6-3 for more details.
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5. Click Apply to save the new point. Click Ok to exit.
The new point is added to the end of point listing.

- Add Point : Point User1

General l Coordinates 1 Codes and Style

Marne |Usert

Miote ‘

Conral ‘None j
Code ‘tt j
Source [

aK | Cancel | Apply |

Figure 6-1. Edit New Point Parameters

If the user added a point with a code into a TopSURY file, the CAD
View displays this point:

F_: 5 o e . ATonSL T aﬂ@
+” Points I & codes ‘
I..| Name Ground Mor... | Ground Easting ... Elevation () \ Code | Moke
o Userl Egol 500,000 | 1,000t
< ¥

o Lsert [t

Figure 6-2. Points tab and Cad View
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Edit on the Points Tab

You can edit all fields directly on the Points tab except the Icon and
Photo note. Click-pause-click to access editable fields. Figure 6-3
shows an example of editing fields on the Points tab.

pd opthin ing ... ade
2064444.891 B179355.110 ERISTING

L]
® 2064448.588 6173345.339 379.512  E=ISTING Mane a
@ S00z 2064451.546 B179335.728 379.531  ERISTING Mone: o
® 5003 2064454.473 6173325.560 379.445  ERISTING Morne: a
@ S004 2084457.738 B179315.822 379.483  ERISTING Mone: o
® 5005 2064461.034 6173306.053 379.528 ERISTING Morne: a
@  EnA PNA44FA.M19 F17979F.77F A79.55A  FRISTING Mrne: n ™

USFeet DMs Ground PROJECT RTK. tlsw Localization

Figure 6-3. Editable Fields on the Points Tab — Example (Coordinate File)

Edit in the Point Properties Dialog
Box

The available property tabs depend on the information in the file. For
example, the Offset tab is only available if a point-to-line offset was
measured.

Note the following restrictions when editing a point
in a coordinate file:

* If the file currently lacks the data being edited in
the Properties dialog box, Topcon Link will ask
to save to another format before continuing.

1. To edit a point’s properties, double-click the desired point.
2. Edit the point’s general properties:

¢ Name — the name of the point
* Note — any notes associated with the point

e Code — the code of the point
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3. Edit the point’s coordinates (Latitude\Northing,
Longitude\Easting and Elevation).

+ Properties : Point occ E|E|

General] Coordinates I Codes and style ]

Name Joce
+ Properties : Point occ

]

Mate Gengral  Coordinates I Codes and Style
Graund

Contral |Nnne Ground Maithing [m] |500
Code [Station Ground Easting (][50
Source [ Elewation [m] |145.06

aK | Cancel Apply

0k Cancel ‘ |

Figure 6-4. Edit General and Coordinate Properties

4. Edit the point’s CAD information. The user can edit the data in
the following field: Code, String, Control Code and Control
Code2, Color and Point Symbol.

- Properties : Point 500

General I Coordinates I Fhoto Motes  Codes and Style 1

Codes

Code String Attribute | Yalue |

- I - Lamp 1

< »
Stiing ]
Cantral Cade [Lamptri a2z ~]
Control Code 2 | j
Colar | j
Puoint Symbol | A j

akK Cancel | Apply |

Figure 6-5. Edit CAD and Style Properties

5. The Photo Notes tab is available only for points of TopSURV
Job. The user can select a desired photo note from the list, or add/
remove a photo note for the point. (The user can add *.jpg or
* bmp files of type).

* To add a photo note, click Add Photo Note. Browse for and
select the desired photo, click Open. The photo is added to
the list, in the order added, and automatically applied to the
point.
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* To delete a photo note, select the photo from the list and click

Delete Photo Note.
- Properties : Point 500
General | Coordinates  Photo Notes | Codes and stye |
Photo Mate Mumnber.
Laok in: | [ Mew_Pictures
My Recent
Documents
T Add Photo Note Femove Photo MNote
Add Phato Note Desktap 2 - [E— Boply ‘
o | Picture 006.jpg
} d]Plcture 009.jpa
|.

Figure 6-6. Edit Photo Note and Offset Properties

6. For PTL (point to line) points, edit the point’s offset. To obtain
new coordinates of the point after editing offset parameters, need
click Calculate Coordinates. See (“About Editing Offsets in
Topcon Link” on page 6-46) for more details

7. Click Apply to save the changes. Click OK to exit.

P/N 7010-0522

Properties : Point ptl1

General | Coordinates  Offset | PhotoMotes | Codesandstyle |

Oifset Dist [m] |15

(ftset Ht (m) [

Offset Across (m)] |B

From Faint ‘F_1 2 j

To Fairt =
Height is

" Relative

" fbsolute

aK | Cancel | Apply |

Figure 6-7. Edit Offsets for the PTL point
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Editing GPS Occupations

Among other editing activities, Topcon Link can be used to edit the
height of the antenna and the point name, associated with the
occupation. A custom antenna can also be created and applied to an
occupation.

Edit on the GPS Occupations Tab

You can edit the Point Name, Antenna Type/Height/Height Method,
and Note fields directly on the GPS Occupations tab. Click-pause-
click to access editable fields. Figure 6-8 shows an example of editing
fields on the GPS Occupations tab.

&' HiPer LitejLit

4" Mone
= 4" Topcon

&Y
& Regency-sﬁ [Vertical =]

&7 TOP7Z110
" More..,

'

opco opcon\Topco opSURVAP R opSURY PC Job |

" File Edit View Process Window Help E

B U s R | a a [ & Bk

L]
x

o” Paints @ GPS Occupations | o 6ps o}(} & codes }/ \

L.. i ... il Stop Time. | Duration | Method  Vellakemtgterval | Receiver | @
< T : e f e T It
-\ 50315089 HiPer L. Vertical | 2/2/2004 i3, 2/2/2004 13, 00045 AuteTopo

@, SOFO-S128 HPerli. 6562 Vertcal 2022004 1:3.. 2/2l2004 13, Aukonomous

@ CHRPT1  CHRPTL HPerli. 6562 Vertical  2/2/2004 3., 2/2/2004 13... Tapo

q CHKPTZ  CHKPTZ HiPer Lit... 6.562  Vertical 2§2}2004 1:3 2/2/2004 1:3... Topo

q P2 P2 HiPer Lit... 6.562  Vertical 2jz}2004 12 2/2/2004 12:... Topo

@ P3 P3 HiPer it f.5A7  Vertical 21NN 17: iztznng 17 Tnnn b

USFeet | DMS Ground PROJECT RTK. tsv Localization

Figure 6-8. Editable Fields on the GPS Occupations Tab — Example
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Edit in the GPS Occupations
Properties Dialog Box

The available property tabs depend on the information in the file. For

example, the Offset tab is only available if a line with known azimuth
offset was measured.

Note the following restrictions when editing a GPS
occupation:

* If making changes to a GPS occupation in a
TopSURYV PC Job file, the file must be saved to
the same file format.

* If the RTK base station does not have any
information about the antenna, Topcon Link will
recalculate the coordinates of the rover’s points
from the phase center of the base antenna. In the
given case, after clicking Compute Coordinate,
the following message appears:

Topcon Link

1 There is no antenna information For some of the RTK Bases
L) Phase center coordinates will be used to compute rover positions

1. To edit a GPS occupation’s properties, double-click the desired
occupation.

2. Edit the GPS occupation’s general properties. The Point Name
and Note can be edited.
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3. Edit the GPS occupation’s antenna. To create/edit a custom

antenna type, see “Add a Custom GPS Antenna” on page 6-9.

* Properties : GPS Occupation Start_Pt

RIX)

General | occupation | antenna | offset |
Poirt Hame [Start_POINT] -]
Original Mamme ‘Slart_Fl
Note: ‘
Method [Tapa
Start Time: [1212.2007 10:01:43
Stop Time: [1212.2007 10:01:58
Duration | 0x00:09
0k Cancel ‘ Apply |

# Properties : GPS Occupation Start_Pt

General 1 Occupation Antenna ] Offset ]

Antenna Type | & GR-3 hd Custam.

Antenna Height [m) |2 06

#nt Height Methad [ Vertical

Ok Cancel |

Apply

Figure 6-9. Edit General Coordinate Properties

4. Edit the GPS occupation’s offsets. See (“About Editing Offsets in
Topcon Link” on page 6-46) for more details.

* Properties : GPS Occupation Start_Pt |E|rg‘

General 1 Occupation I Antenna Offsetl

Azimuth
(ffset Dist [m) [25
Offset Ht (m) |0.43838

Offset deross (m) |

0k | Cancel

Figure 6-10. Edit Offset Properties
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5. View information for the occupation (the number of epochs, the
record interval, the GPS week and day of the occupation start

time):

# Properties : GPS Occupation topo @E‘

General  Occupation 1 Antenna ] Offset ]
MEpoch 10

Interval [1000

GPS week.day [1457 345

|BREBSNASL34

Receiver

]

Cancel | ‘

Figure 6-11. View Occupation Properties

6. Click Apply to save the changes. Click OK to exit

Add a Custom GPS Antenna

Each antenna type has unique phase center parameters obtained
through factory calibration. These parameters are not viewable nor
editable, but a custom antenna can be added to the Topcon Link list of
antennas. You will need the measurements (calibrations) shown in
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Figure 6-12 to properly add a custom antenna and ensure correct

coordinate computations.

Phase Center (L1/L2)

Antenna Radius

A
C1/C2
Y

E

T

A1/A2

)

%
)
%

"~ Antenna Reference Point
(ARP, Base of Antenna)

Vertical Height

_- Survey Point or Marker

.
.

Figure 6-12. Determining Antenna Parameters

1. Measure or record the antenna’s offset parameters as shown in

Figure 6-12.

To add a custom antenna, double-click a GPS occupation.

# Properties : GPS Occupation CHKPT1

Custom.... N

General  Antenna | offset |

@ HiPer Lite/Lite+

Antenna Type

RIx

On the Antenna tab, click Custom. Then click Add.

Antenna Height USH] [6.562

Ant Height Method  [Vertical

&4 Custom Antennas List

Icon | NGS Mame | Name | Radius {mm) | L1 Base offset(a1) (mm) | L2 Bar

< >

Add [k ‘ Close

Cancel | pply ‘ I

e |

[« |

Figure 6-13. Add Custom Antenna

Enter the NGS name for the antenna and the display name for
Topcon Link. NGS (National Geodetic Services) provides a
common database for distributing official antenna designators
and offset measurements.
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5. Enter the measured offsets for the antenna and select the method
used to measure the height.

#' New Custom Antenna

General | Parameters | pcy |

NGS Hame [Cost_Ant
Name: #' New Custom Antenna
Manufacturer Arywhere Inc.

General Parameters} Py |

My custom anterna Radius [mm] [0.4
Note
L1 Base offsetfal) (nm) |05

12 Base offsetis2 (nmn]  [05
L1 Plane oftselC1) ] [0.2
L2 Plane oftsstC2) fmm]  [013
L1 Easting offsel(E1) () [0.2
L2 Essting offsel(E2) (mm) |
L1 Northing offset 1) ) [2.1]
oK Cancel | L2 Northing offset2) () |

Measured Height Method [ vertical ~|

oK Cancel | Apply |

Figure 6-14. Enter General and Offset Parameters

6. Enter the PCV values. These values represent the antenna phase
center variations.

7. Click OK to save the custom antenna and exit.

# New Custom Anienna |E|E‘

General | Parameters  PCY |

PCV. GPS LT (mm) FCY, GPS L2 (mm]
o 50 | o | 500 |
5 55° [ 5 55° [
L) g0 | 10 [ g0 |
15 85" [ 15° [ 85" [
20 | 70 [ 20 | 70 [
25 75 [ 250 [ 75 [
i) g0 | a0 | g0 |
ol a5 [ 5 | a5 [
40 | 0 | 40 | a0 |
i T

0K [% Cancel Apply

Figure 6-15. Enter PCV Parameters
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To edit a custom antenna, double-click the antenna on the antenna
in the custom antenna list. The antenna’s properties dialog box
displays.

A Custom Antennas List

Icon | MGS Mame | Tame | Radius {mm]) | L1 Base offset{a1) {mm} | LZ Ba:

&' Cust_ént At 0.4 0.5

< ¥
Add Remove ‘ Cloze

Figure 6-16. Custom Antennas

Editing TS Observations

Among other editing activities, Topcon Link can be used to edit the
height of the reflector, the number of the observation, the point the
observation was made to. You can also apply sting and control code
values to the observation.

Edit on the TS Observations Tab

In the left panel, you can edit all fields except the Icon directly on the
TS Observations tab. In the right panel, you can only edit the
following fields: Point To, Type of measured point (except BKB

points), Azimuth (only for BKB points measured from the point with
unknown coordinates), Reflector Height, Note, String and Control
Code, Offsets, etc.—directly on the TS Observations tab. Click-
pause-click to access editable fields. Figure 6-17 shows an example
of editing fields on the TS Observations tab.
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a1 I
Mare... ]

o]
x

T File Edt ¥ew Profess Window Help -
] %X & b B AR o F Bk

+° Foints TS Ohs‘l ¥ Images | & codes |

1con | # | PointFrom | Point To§ | Reflector Hei.,. | Azimuth | Horizontal Circle | Slope Dist... | zeni
=
1

o 27 356756, 356756'12,0000

(), 2 27 1 356°56'12,0000 G298
R e ﬂ e S
K(): 4 27 356°56'., 356°56'12,5000

R S 27 0.000 356°56'12,5000 azo1g 3
o - e e rerverim oo prv———
<

USFeet DM5 | Ground | None

Figure 6-17. Editable Fields on the TS Observations Tab — Example

Edit in the TS Observations
Properties Dialog Box

The available property tabs depend on the information in the file and
in the selected observation. For example, the Image tab is only
available if an image is associated with the observation.

Edit Left Panel TS Obs Properties

1. Toedit a TS observation’s left panel properties, double-click the
desired observation in the left panel.

2. Edit the TS observation’s general properties (point name,
instrument height, order number).

+ Properties : TS Occupation 1.27

General

Point Narne [2A =]
Instument Height (USH) [5.18
f [i =

0K Cancel |

Figure 6-18. Edit General Properties for the Left Panel
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Edit Right Panel TS Obs Properties

1. Toedit a TS observation’s right panel properties, select the
observation in the left panel then double-click the desired
measurement in the right panel.

2. Edit the TS observation’s general properties. The following
information can be edited in the General tab: Note, Code, String
and Control Code.

+ Properties : TS Obs 1.occ-8.101

Observation  General | offset | adjustment | Image |

[ =
8 @
for 1243 ared

Mote

Date |

L]

Code [pane

Stiing Il
Control Code |

L]

0K Cancel | Apply |

Figure 6-19. Edit General Properties

3. Edit data in the Observation tab. The following information can
be edited:

¢ Point To,

* Type of measured point for side shot point (SS), backsight point
(the previous occupation point) (BS), foresight point (the next
occupation point) (FS), Horizontal/Vertical Resection/Resection
points,

* Azimuth only for backsight bearing point (BKB)
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+ Properties : TS Obs 1.occ-8.101

Observation ] General I Offset } Adjustment I Image }

Paint To [t =
Type [ss ~|
Rieflector Height (m)  [1.45

Hurizortal Circle [o0nan,qoon

Zerith Angle [30°0000.0000

Shope Distance (] [20

Wettical Angls [

Horizantal Distance [m) |ZU

Wettical Distance (m] [0
Exclude

I Horizontal Circle

[ Wertical Angle

I Slope Distance

ok Cancel | Apply |

Figure 6-20. Edit Observation Properties

4. Edit the TS observation’s offset properties. See (“About Editing
Offsets in Topcon Link” on page 6-46) for more details.

+ Properties : TS Obs 1.0cc-8.101

Obseryation I General Offsetl Adjustment 1 Image I

Offset Along [m) |24

Offset Across (m) |42

Dffset dHE [m] Joad

Offset Type |From Dbsservation Line

oK Cancel | Apply |

Figure 6-21. Edit Offset Properties

5. View the image(s) associated with the observation measurement
in the Image tab.

6. View the adjustment results for the observation measurement in
the Adjustment tab.
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+ Properties : TS Obs 1.A-21.17

Observation | General | Offset | adjustment Image |

+ Properties : TS Obs 1.A-21.17

Observation | General | Offset Adjustment | Image |
SDist Residual [m) [0.000

Héngle Residual [6°0000,0000

Aazimuth Residual [

WAngle Residual (TS

ZAngle Residual 00000789

HDist Residual (m) ~ [0,000

WDist Residual [m) [0.000

Cross Residual (m) [0.000

oK Cancel |

0K Cancel

Figure 6-22. View Image and Adjustment Properties

Editing GPS Observations

Since GPS observations are based on GPS occupation measurements,
the user can select/add antenna parameters for the base and the rover
stations of the observation and can edit notes for the observation. To
edit an occupation, see “Editing GPS Occupations” on page 6-6.

Edit on the GPS Observations Tab

You can only edit the Note field directly on the GPS Observations
tab. All other fields are static in this tab. Click-pause-click to access
editable fields. Figure 6-17 shows an example of editing this field on
the GPS Observations tab.
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T File Edt ¥ew Process Window Help

i (usfe) | o (Usfe) | dHt Usee) | Method ~

FEHE HHR & @ 4 B F & & M &Rk
o Paints | 52 GPS Oceupations &% Gp5 Obs } 4 codes | /

teon | Point Fram | Paink To | Start Tme Duration | Mote Harizantal Preci... | Vertical Precisia... |

P 3 2fzfa004 12:52.,. 0:00:02 0,019 004 eEs 1027
@ ot P2 2/2/2004 12:53... 0:00:02 0.024 0018 5866 -0.103
@ ot P4 2/2/2004 12:56.,. 0:00:02 0.023 0017 428.578  -93.436
@ ot s 20202004 1011, 0:00:02 0.032 0,024  -47.046 421114
§ = 2(2/2004 1:041...  0:00:02 0,024 0,017 173419 175162
(o] P PR FirtOng 1:10: Menn:nz nNz3 nnz -R7T SR F4T.TR4
<

RTK Topo
RTK Topo
RTK Topo
RTK Topo
RTK Topo
RTK Tnnn

Ready

UsFeet | DMS | Ground

PROJECT RTK. tsw Localization

Figure 6-23. Editable Field on the GPS Observations Tab — Example

Edit and View in the GPS
Observations Properties Dialog Box

The antenna parameters for the base and the rover stations and the
notes associated with a GPS observation can be changed; all other
fields are informational.

1. To edit a GPS observation’s properties, double-click the desired

observation.

2. Asneeded, edit the GPS observation’s note in the General tab.

P/N 7010-0522

* Properties : GPS Obs Base1-Pt2

General ] Quality ] Observation 1 Base Antenna Rover Ankenna 1

Paint Fram |Basel
Pirt Tar Ptz
for Road_A34
Note
Start Time: [12.12.2007 10:01:43
Diuration [0:00:08
Stop Time: [1212.2007 10:01:58
GPS week, day [1457,346
M ethod [RTK Topo

aK | Cancel Apply

Figure 6-24. Edit General Properties
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3. Asneeded, edit the antenna parameters for the base/rover stations
in the corresponding tab:

® Properties : GPS Obs Base1-Pt2 E”i_(‘
izeneral ] Quality I Observation  Base Antanna] Raver Antenna ]

Antenna Type +' CR-3 = Custarn,

Antenna Height (m) [1.77 General 1 Quality ] Observation 1 Base Antenna  Rover Antenna]

Ant Height b ethod |Vsrt\ca| Antenna Type %" GR-3 - Custom....

Yertical
_I Anterna Height [m) [2.08

Ant Height Method |Vertica\ ﬂ

* Properties : GPS Obs Base1-Pt2

(1] Cancel Apr]

118 | Cancel Apply

Figure 6-25. Edit Antenna Parameters

4. View the quality information about the observation measurement
in the Quality tab (Precision, RTK Solution Type, Number of
epochs, the common number of SV’s observed by the base and
rover in the last common epoch, the horizontal/vertical/total
position dilution of precision in the last common epoch for RTK
observation).

5. View the GPS observations solution components in the
Observation tab.

® Properties : GPS Obs Base1-P{2 E‘E|
General  Quality | Observation | Base Antenna | Rover Antenna |
Harizental Precision (m) 0,040 —
# Properties : GPS Obs Base1-Pt2 I
T [ L
Saiution Type [Fred Frass OFF General | Quality Observation | Base Antenna | Rover Antenna |
o [m) |2033.293
Epochs [1o
dr (m) [3544738
GPS Satellites E]
oz [m] [506.747
GLONASS Satelites |2
Azimuth |231 ©38'25,9879
PDOP [1.a15
Elevation Angle [-or0a0z.m 11
HDOR [0343
[Biksaries ) [4356 671
vDOP [1.666
N [m) [58a.407
aK Cancel ‘ dE m) 36 965
dHt [m) [a77a
| oK | Cancel ‘ Apply

Figure 6-26. View Quality and Observation Properties
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Editing Digital Level
Observations

Among other editing activities, Topcon Link can be used to edit the
level run of an observation, the point, and the vertical offset.
Figure 6-27 shows typical observations taken with a digital level.

M
"L BS
A SS
\\\"‘ ~ ,D
N .
9 N /
M- Traverse point %@5, N el v 4
s ~
[] - SideShot ‘“’m\ s
- e
S~ ™ .

<. FS

*--..\_ "'—o; . "
C5ight .
sty e ~.

Figure 6-27. Example Digital Level Observation

The DL Obs tab displays a table containing two panels. The left panel
displays the start and end level points of a job, and the right panel
displays all level measurements of the selected job.

Edit on the DL Observations Tab

In the left panel, you can directly edit order, note, and level run fields
directly on the DL Observations tab. In the right panel, you can only
edit fields that correspond to available data and non-static
information—such as Point, Vertical Offset, and Note—directly on
the DL Observations tab. Click-pause-click to access editable fields.
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Figure 6-28 shows an example of editing fields on the DL
Observations tab.

i
5 1]

Mare. ..

opco opcon\Topco Digitall eve e e opcon DL Ob =]

o
X

"] Fle Edit view fProcess window Help E
= =3 5B & R 5 ok Bk
o7 Points . n’,ohs |

rom | To | Levell "[1.[#
, 1 B0t 14.829 35.000
2 i

| Point 85 (USFt) | Instrument Elev. . | 55 (Usf) | FS (U~

ot 5 TORCC
35,000 17,

I

a,

l,_é_l 16,699 34,850

g, ¢ 34,850 17,
<

, 5 z 14,797 33,900

Ready USFast

Figure 6-28. Editable Fields on the DL Observations Tab — Example

Edit in the DL Observations
Properties Dialog Box
The available property tabs depend on the information in the file and

in the selected observation. For example, the Image tab is only
available if an image is associated with the observation.

If making changes to a digital level observation in a
TopSURYV PC Job file, the file must be saved to a
* tlsv or *.tgj file.

Edit Left Panel DL Obs Properties

1. To edit a DL observation’s left panel properties, double-click the
desired observation in the left panel.
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2. Edit the DL observation’s general properties (level run name,
note and level run order).

- Properties : DL Run 1.J0111 EFx

General l

Level Run poi11]

From |B001
Ta |4
Date [
Mote ‘

[ I

Distance (m)  [36.138
Balance (m) |0,025

0K Cancel |

Figure 6-29. Edit General Properties for the Left Panel

Edit Right Panel DL Obs Properties

1. To edit a DL observation’s right panel properties, select the
observation in the left panel then double-click the desired
measurement in the right panel.

2. Edit the DL observation’s general properties.

+ Properties : DL Obs 1.J0111-2.1

Ohbservation General} Adjustment 1

Level Run [Jo111

# |2

Note ‘

Date |01.01.1993 19.57.00

0K Cancsl

Figure 6-30. Edit General Properties for the Right Panel
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3. Edit the Vertical offset and the measured point for the DL

observation in the Observation tab.

+ Properties : DL Obs 1.J0111-2.1

Observation ] General ] Adjustment I

Type

Faint

Ht. Measurement [m)]
Wert. Oftset [m)

Distance [m]

Instrument Elevation [m] |11,41 7

Std Dev [m]

|1

[1.42

jo

BE]

=

Cancel

Figure 6-31. Edit Observation Properties

4. View the adjustment elevation for the DL observation.

Editing Codes

+ Properties : DL Obs 1.J0111-2.1

Elesvation [m)

Observation 1 General Adiustment}

3

EEER

.

Cancel

Figure 6-32. View Elevation Adjustment Properties

Among other editing activities, Topcon Link can be used to edit codes
and their attributes. New codes can also be created.

Edit on the Codes Tab

In the left panel, you can edit code and layer fields directly on the
Codes tab; you can also add codes and attributes to codes using the
pop-up menu. In the right panel, you can only edit the attribute name
and default value fields directly on the Codes tab. Click-pause-click
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to access editable fields. Figure 6-28 shows an example of editing
fields on the Codes tab.

B & b B A8

vpations | o Grsobs & Codes |

|uer [ A Tcon | Attributs Name Y Default Valus Type [
5 el umber

)DDGG]:

Ready USFeet  DMS | Ground | PROIECT RTK.Hsv Localization

Figure 6-33. Editable Fields on the Codes Tab — Example

Add a Code

1. To add a code, right-click in the left panel and click New Code.
The new code is added to the bottom of the code list.

2. Double-click the new code and edit code/layer and plotting
properties. For more information, see “Edit in the Code or
Attribute Properties Dialog Box™ on page 6-24.

&4 Topcon Link - [C:\topcon¥TopeonLink\To pSURVAPROJECT
:lF\Is Edit “iew Process ‘Window Help
HP| B3R &S| FMN: L Topcon Link - [C:\topcon\TopconLink\TopSURVAPROJECT
. Foints 1 o2 &P Occupations 1 o8 arsobs & ¢ "] Flle Edit View Process Window Help
— B -
Code Layer ~t = & ﬁ 6 &
i Pl o ] Lall o2 points | g GPsoccupations | @ ePsobs & Codes 1
+ oz M [oe [ioer a e
+ P3 New Attribute »
. PT4 FIND o
+ P4
. PS5 Copy Crrc * TK a
+ TPAY PT 2 0
+ Fo
e 2 + TRAVPT 1 0
Properties... . BLDG PAD ELEY 1
Ready . New Code ]
k w
Ready

Figure 6-34. Add New Code

P/N 7010-0522 6-23



Editing Data in Topcon Link

Add an Attribute

As many attributes can be assigned to a code as needed. Attributes
can be an integer, a real number, a text string, or selected from a
menu.

1.

H Topcon Link - [C:MopconiTopconLinkATopSURVIPROJECT RTK.tlsy <T¢

To add an attribute, right-click in the left panel, click New
Attribute, then click the type of attribute.

Enter a name and default value for the attribute. Click Ok to save.

A Topcon Link - [C:\opcon¥TopconLinkYTopSURVIPROJECT
T File Edit View Process Window Help

SHE 35 % S0 - %@

o2 Points | o GPSOccupations | g2 GPsobs & Codes |

Icon Zode Layer A~ Icon
* New Code
Mew Code I

PT1 FIND

P72 FIND Mew Attribuke %
Cuk Chrl+i Real Number

.
.

. PT3 FIND

. Cerl+C Text
.

PT4 FIND Copy

i Delete Del Merns B Properties : Attribute New Attr... E|g|

Properties...

General l
Attribute Mame  |Sancke

Default Walue |4

Ready

Type |Integer

"] Fle Edit View Process MWindow Help
— = QK P Cancel Apply
FEHE s & 0 & By PR |
o© oints | o2 GPsOcepations | o Gesobs & Codes |
Icon Code Layer ~lt Icon | Attribute Name | Defaultvalue | Type [
e cads T Sancke 4 Integer
PT1 FIND [ B
PTZ FIND 0
PT3 FIND 0
PT4 FIND o
STE o
AL AT A . ]
Ready UsFest | DM5 | Ground | PROJECT RTK.tsw Localization

Figure 6-35. Add New Attribute

Edit in the Code or Attribute
Properties Dialog Box

The property tabs create or edit a new code and assign plotting styles
to lines and points associated with that code.

Edit Left Panel Code Properties

1.

To edit the properties for a code, double-click the desired code in
the left panel.
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2. [Edit the Code’s general properties (code name and layer).
3. Edit the Code’s plotting styles for line and points.
4. Click Ok to save.

e coisovcoe— (B0

General l Flatting styles ] General  Plotting styles
Code [New Codel Line Style ([BvLaveER -
Layer 0 =l Unewidh  [BYLAYER 1pt -
Color [ BvLavER -
Point Symbel | BYLAYER » -~
|

(] 8 | Cancel ‘ ‘ (] 8 | Cancel ‘

Figure 6-36. Edit Properties for the Code

Edit Right Panel Attribute Properties

1. To edit the attribute properties for a code, select the code in the
left panel then double-click the desired attribute in the right
panel.

2. For Integer, Real Number, Text, and Menu attributes, edit the
name and default value properties.

RIX]

B Properties : Attribute Sanoke

General l
Attribute Mame  |Sancke
Default Yalue &) Properties : Attribute test E]
Type Integer General l
0K | Camcel || Attribute Name | Test
Default Yalue 2 Properties : Attribute fert E]
Type Real Number General l
I 0K | Camcel || Atribute Mame | it
Default Walue ||
Type | Temt
QK | Cancel Apply

Figure 6-37. Edit General Properties for Integer, Real Number, and Text Attributes

3. To add a value to a Menu attribute, type the value and click Add.
The value is saved in the file and with the attribute to be selected
for other attributes with the same name.

P/N 7010-0522 6-25



Editing Data in Topcon Link

To delete the value, select it and click delete.

" Properties : Attribute Mew Attr... @g|

General l

Attribute Hame  [Mew

Default i alue

1 ~| |

Add

| Remove ‘

Type |Menu

0K ‘

Cancel ‘ Apply ‘

Editing Line

Among other editing activities, Topcon Link can be used to edit layer,
line type (line or area), and line segments.

Edit on the Line Tab

Figure 6-38. Edit General Properties for a Menu Attribute

In the left panels, you can edit line type, plotting style (Line Style/
Line Width/Line Color), select new layer directly on the Line tab.

6-26

Topcon Link Reference Manual



Editing Line

In the left panels, you can edit only the name of the line’s vertex.
Click-pause-click to access editable fields. Figure 6-28 shows an
example of editing fields on the Line tab.

-~
I |Bviaver — ‘[i 4Pt —
{: Spt e—
6Pt —
I —_— - 7PC —
______________ Spt
Cuskomn Spt I
EYLAYER, [ -t topt The left panel
BYCODE I ot - BYLAYERL, —
- BYLAYER —— BYCODEL.—
° Poin¥ <7 Lines | o Ko
oo | Typ\ | La... | Colar \ | Line Skyle | Lingf Width | Code lString | Distan. .. | Area (Sg.m) |
BYLAYER T e WER T Pt — | CODE 1 150,523
BYLAYER— GYLAYER1pt— Copfl 1 10,554
| B | biLgee— Jopr oommm e 1 13,672
BYLAYER BYLATER— 1 18,657
BYLAYER BYLATER— 2 3,000 0,56
BYLAYER BYLAYER— BYLAYER1pt— CODE3 3 3,225 0,65
I BYLAYER——  BYLAYER1pt— (CODEZ 2 43,103
I..| Order | Paint | Distance f .
: The right panel

4
3
4

Figure 6-39. Editable Fields on the Line Tab — Example

Line segments (in the right panel) can only be
edited in the Tabular view as shown above.

Edit and View in the Line Properties
Dialog Box

Only line information and plotting styles can be changed; all other
fields are informational.

Edit Left Panel Line Properties

1. To edit the properties for line, double-click the desired line in the
left panel.
Edit the line’s general properties and view its length.

3. Edit the line’s plotting styles.

4. View CoGo information.
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5. View and edit the photonotes of this line.

6. Click Ok to save.

Properties : Line 0

Photonotes  Line } Plotting styles | CoGo |

Type Line -
(o -

Layer

¥ Properties

CoGo |

Photanates I Ling I Plotting styles
Distance [m] 133,304
Area [5q.m) 372

Cancel

(o |

Properties : Line 0

Photonates 1 Line:

Line Style

Line Wwidth

Color

oK

Plotting styles } coco |

BYLAYER —040839 ———— =

BYLAYER gt
EYLAYER: I -

-

R~

Add Photo Note

Remove Photo Note

0K

Cancel | Apply |

Figure 6-40. Edit Properties for the Line

Editing Tape Dimensions

Among other editing activities, Topcon Link can be used to edit start
and end points, tape distance, and point to for a tape dimension.

Tape dimensions are measurements of lines perpendicular to a
reference line. The reference line is defined using two points with
known coordinates. Figure 6-41 shows tape dimensions measured
from a reference line (between points 1 and 2).
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Latitude
1 100 e 2
55242'00,0"N —
55°41'59.0"M —_ 102 101
55°41'58.0"N —
B 103 104
55941'57.0'"N  —| 1105_. 106 , 1
- T T T | T T T T | T T T T | T T
37°33'55.0'E 37°3357.5'E 37°34'00.0'E

Figure 6-41. Example Tape Dimension Measurements — CAD View

Edit on the Tape Dimensions Tab

In the left panel, you can edit all fields, except the Icon, directly on
the Tape Dimensions tab. In the right panel, you can edit all fields,
except the Icon and Date, directly on the Tape Dimensions tab. Click-
pause-click to access editable fields. Figure 6-42 shows an example
of editing fields on the Tape Dimensions tab.

T =
B8
opco Documents and gs\amanda 0 dEd p P P =
T File Edt ¥ew Process Window Help -8 x
FEHJE 35 S & B la s il B k&
o Paints | 42 GpSOccupations B, Tae Dimensions I & codes
Tcon | Start Point *[1con [ # Paint To | Distance im) [foate hote
8 g t L0000 3/30/2004 9:20,06 &M
E; 3i30/2004 9:20:16 AM
o 3 3 20,000 3{30/2004 9:20:23 AM
g 4 20,000 3{30/2004 9:20:32 A
Ready Meters | DMs | WGSE4Lat, Lan, ELH
Figure 6-42. Editable Fields on the Line Tab — Example
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Edit in the Tape Dimensions
Properties Dialog Box

Available tabs depend on the selected object, either a tape or a
dimension.

Edit Left Panel Tape Dimension Properties

1. To edit the properties for the tape dimension, double-click the
desired tape in the left panel.
Edit the tape dimension’s start and end point.

3. Click Ok to save.

Properties : Tape Dimension Re... @

General l
Start Paint [100 |

End Foint |2 |

(] 8 | Cancel ‘ ‘

Figure 6-43. Edit Properties for the Tape Dimension

Edit Right Panel Dimension Properties
1. To edit the properties for the dimension, double-click the desired
dimension in the right panel.

2. Edit the dimension’s general properties and view the date it was
measured.

3. Click Ok to save.

- Properties : Tape Dimension 2 EIE'

General l

Paint To |2 |
Distance [m) |2D

Date |3/30/2004 2016 AM

# [z =]

(] 8 | Cancel ‘ ‘

Figure 6-44. Edit Properties for the Dimension
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Edit Image Properties

The Images tab displays when the file contains data associated with
captured images, such as data obtained using the GPT-7000i total
station.

Adding a photo note to data will also cause the Images tab to display.

@ Note the following restrictions when editing Images:

» Topcon Link expects images to reside in a folder
with the same name as the data file. For
example, data from the “050119.tlsv” file will
be associated with images in the “050119”
folder.

* The data file and image folder must reside in the
same directory for the images to display.

The image tab contains thumbnails of images in the file in the left
panel and the selected image, with associated points and line, in the
right panel. Figure 6-42 shows an example of the fields on the Images
tab.

* A red cross indicates the point that the image is associated with.
* The currently selected point(s) is indicated with corner edges.

* The currently selected line(s) is highlighted.
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I Topcon Link - [C:\MopconiTopconLink\TopsURVI05011 9.tksv <TopSURY PC Job=] (X
T Flie Edt View Process Window  Help - & x

AN B8 8 A 5 % @&

Point image
is attached to

Select point
and line

Meters | DMG | Ground | None

Figure 6-45. Viewing Images

While photo images cannot be edited, any points or lines associated
and displayed on the image in the right panel can be edited. Double-
clicking the point/line will open the corresponding Properties dialog
box. See the following sections for editing this data:

» “Edit Image Point Properties” on page 6-33
» “Edit Image Line Properties” on page 6-34

View Image Properties

1. To view the properties for the image, double-click the desired
image in the left panel.

View the image’s general properties.

3. View a larger size of the image without associated points/line.
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4. Click Ok to exit.

A Pro perties

General | Image |

Edit Image Properties

Name [100

Point 100

Cancel

> ]

Apply

Ok | Cancel Apply

Figure 6-46. View Properties for the Image

Edit Image Point Properties

1. To view the properties for a point on an image, double-click the
point on the image in the right panel.

Dialog Box” on page 6-3.

Edit desired fields as described in “Edit in the Point Properties

3. View the image associated with the point.

Click Apply to save the changes. Click OK to exit.

+ Properties : Point 100

General | Coordinates | CAD | String | Images | Photg

100

Name

Mote

Code |

Control [Hone

Layer o

Cancel | E

+ Properties : Point 100

General | Coordinates | CaD | Strng  Images | photomotes |

0K I

Cancel |

Apply

Figure 6-47. Edit Properties for Point on Image
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Edit Image Line Properties

1. To view the properties for a line on an image, double-click the
line on the image in the right panel.

2. Edit the line’s general properties (line or area type, ordered
sequence, layer assigned to). View the line’s code and its from/to
points.

3. Edit the line’s plotting styles.

Edit the control codes used to for the line View the string
assigned to the code.

5. Click Apply to save the changes. Click OK to exit.

Properties : Line 0 Properties : Line 0

Photanaotes Line I Plotting styles 1 CaGo I Photonates } Line  Plotting styles} CoGo ]

Line Style BYLAYER —M8™M8 — =

Lire ‘width BYLAVER 1t
hpertios : Line Color BYLAYER I

Type Line A

Layer E =

notes} Line | Plotting styles

ote Murnber. 1

oK Cancel ‘ |

‘ e
Add Phato Nate Remave Phota Hote

oK | Cancel | Apply ‘

oK Cancel

Figure 6-48. Edit Properties for Line on Image
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Editing X-Section Templates

Among other editing activities, Topcon Link can be used to edit much
of the information associated with cross section template, including
the slopes, distances, and grades of the template items.

Edit on the X-Section Templates Tab

In the left panel, you can edit all fields, except the Icon, directly on
the X-Section Templates tab. In the right panel, you can edit all fields,
except the Icon and Hz/V Offset, directly on the X-Section Templates
tab. Click-pause-click to access editable fields. Figure 6-49 shows an
example of editing fields on the X-Section Templates tab.

| -
1 I .
LT ] EsP E
—] =
Yflo
«” Poirts ] Roads  dSection Templates 1 & Codes ]
Icon | Mame | Cut Slope... | ill Slope,., 4 * | Icon | Qrder | Code ‘ Iz. Dist ‘ W, Dist {m) | Grade (%) | HIOFfset..‘ | W, Offset Fron s
’_‘ 831500 0.000 0.00C “ 1 0.003 -1.219  -40000.000 0.000 i
- 88150R, 0,000 0,000 =2 6,703 1119 16,659 0,003 ]
Eaal 882000 0,000 0,000 = 3 1219 0.0439 3,995 6,706 <
’_‘ BE200R. 0.00C d 4 1.219 0.049 3.998 7.925 REY
-~ sss00L 0.000 0.00C < 3
= 83500R 0.000 0.00C
Eaal 887000 0.000 0,000
’_‘ B58800R. 0.000 0.00C
’_‘ 892000 0.000 0.00C
’_‘ 89200R 0.000 0.00C %
<

>

Figure 6-49. Editable Fields on the X-SEction Templates Tab — Example

Edit in the X-Section Templates
Properties Dialog Box

Much of the information associated with cross section templates can
be edited, except segment offsets.

Edit Left Panel X-Section Template Properties

1. To edit the properties for the x-section template, double-click the
desired template in the left panel.
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2. Edit the x-section template’s name and cut/fill slopes.
3. Click Apply to save the changes. Click OK to exit.

Properties : X-Section Templat... @

General l
Mame |33200R

Cut Slope [1:n] |D
Fill Slope [1:n] |D

(] 8 | Cancel

Figure 6-50. Edit Properties for the X-Section Template

Edit Right Panel Segment Properties

1. To edit the properties for a segment of the cross section template,
double-click the desired segment in the right panel.

You can also double-click the segment in the graph
to open the Properties dialog box.

2. Edit the segment’s order, horizontal/vertical distance, percentage
of grade, and code. View the horizontal/vertical offsets from the
centerline.

3. Click Apply to save the changes. Click OK to exit.

Properties : X-Section Segment 3

General l

Order [ = |
Hz. Dist [m] [1.219
. Dist [m)] |0.043
Grade [%) |3.993

Hz. Offzet from CL [m) |B.?DB
. Offzet from CL [m) |-D.‘ID‘I

Code | j

(] 8 | Cancel ‘

Figure 6-51. Edit Properties for a Segment of the X-Section Template
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Editing Roads

Among other editing activities, Topcon Link can be used to edit
alignment and cross-section information for a road.

A road as an object can be described through the horizontal and
vertical projections of the center line, called alignments, and the line
describing the surface of the road and lying in the plane perpendicular
to the center line, called a cross section (x-section). An alignment can
be divided into sections, each of which can be described using
algebraic functions.

* The horizontal alignment can be described through lines, spirals,
curves and intersection points.

* The vertical alignment can be described through either parabolas
long sections or arc long sections.

* The cross-section can be described using templates. (To edit the
templates for cross-sections, see “Editing X-Section Templates”
on page 6-35.)

1. To edit the properties for a road, double-click the desired road in

v
Cut Chrl+
Capy Chrl+C
Delete Del

the left panel of the Roads tab:

Propetties. ..

2. [Edit the name of the road, the coordinates of the start point, Start
Sta/Chainage and Stationing Stakeout Interval.

P/N 7010-0522 6-37



Editing Data in Topcon Link

3. Select a horizontal/vertical alignment and X-section from the list
of the used alignments/ X-sections in the given TopSURYV job.

# Properties : Road CONVEYANCE2
« Properties : Road HIAA EOG

General | Alignment names }

Name W General  Alignment names I

Start Coordinates Horizantal Alignment Name |H-1 j
Start Point Wertical Aligrment Name [v-22 ~|
Horthing [LUSH) 408,30 % Section Set Name [<-17_teft_ighi] -
E asting (USH) [i7srin
Elevation (LUSft) o

Start Sta/Chainage [USft) 10
Stationing Stakeout Interval [USF) |20
Layer E

oK C:

Figure 6-52. Edit Properties for the Road

Edit on the Roads Tab

In the horizontal alignment panel, you can edit the following fields
directly on the Roads tab. Click-pause-click to access editable fields.

* order * tangential to * tangent
e azimuth previous element e mid ord
« length * spiral direction e external
* turn * delta * start degree chord
* start radius * chord * start degree curve
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Figure 6-53 shows an example of editing fields on the Roads tab,
horizontal alignment panel.

+” FPaints Roads }h ¥-¥erti
= 6220-AlzGradet * [ 1con | ordNr | Type [ azimuth | Length £ [ Tum [ Start Rad... | frd Rad... | Maorth... | East... &
B¢ Horeontalal | o Line 60°57'59,0000 250.9
EEETEHE_ 2 Spiral TS ... 60°57'59,0000 55,392\ Right 873,190
[Z] Graphic e Clrve £3°51'58, 0063 s2t.177 [Right [ 575.150] 873150
I verted alon | o7 5 Spiral €5, 10494921 9835 56,392 Right &73.150 v
FFH Tatle .
Graphic 1% =
=+ %-Sections
FFH Table

Figure 6-53. Editable Fields on the Roads Tab — Horizontal Alignment Example

* In the vertical alignment panel, you can edit only the Sta/
Chainage, Length, and Elevation fields directly on the Roads tab.
Click-pause-click to access editable fields. Figure 6-54 shows an
example of editing fields on the Roads tab, vertical alignment

panel.
1 I
2077285 I|48?.681T [| [ze7.73 T |
] 1
»” FPoints Roads 1«"\ X-Section Templates I & Codes
=/ 6220-Al2Gradet * [ Tcon | Type N[ StafChainage (m) [ OrdeN | Length im) [ Start Grade (%) | End Grade () [ Elevation (m) [ Radiu
=12, Horzontalsl [Ty parah,.. 616849 1 a.000 000 0,003 478,66
FH Table (T Parab... 25670165 2 304,801 3,000 -1.500} 381,269
G”aph" (TY  Parab... 20772.850 |3 -1.500 4,500
ol Yerticalalon | 1y papp, 30047171 4 0,000 4,500 4,500 360,074
FEH Table
[Z] Graphic = %
=1~ X-Sections
FH Table
< »

Figure 6-54. Editable Fields on the Roads Tab — Vertical Alignment Example

In the x-sections panel, you can edit all fields, except the Icon,
directly on the Roads tab. Click-pause-click to access editable fields.
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Figure 6-55 shows an example of editing fields on the Roads tab, x-
sections panel.

| bEaa3.414

7 Points Roads | - wefction Templstes | & Codes |
= 6220-Al2Gradet * [Tcon | JotajChainage (m) | Side: [ 1froplate [ / ~
=1-'¢. Horizontal al | 26868.174 Right
Tah'eh - 26868.174 _ Left
Graphic. | -}
= m]]&t:aéla"g” - 268E3.414  Left 882001
FHH Table =
o 26074854 Right 3500R v
51 - ¥-Sections
FEH Table
< >

Figure 6-55. Editable Fields on the Roads Tab — X-Sections Example

Edit in the Horizontal Alignment
Properties Dialog Box

The user can edit the type of element in the Properties dialog box. The
user can select the following horizontal element:

Type ‘ Line ﬂ

Intersection

If the current type of element is changed, the corresponding
Properties dialog box will be appeared for the selected element.

Edit Line Segment Properties

1. To edit the properties for a line segment, double-click the desired
segment in the horizontal alignment table.

N In the graph view, double-click the segment to open
the Properties dialog box.

2. View the end position for the line segment.
3. Edit the general properties for the line segment.
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» The tangential to previous element is unavailable if the first
segment is a line.

* Edit the type of element, the azimuth, order, and length as
needed.

4. Click Apply to save the changes. Click OK to exit.

Properties : Horz Element EI§|

General} End Position ]

Type =

Properties : Horz Element i 512

[T Tangential to prev element
General  End Position l

Azimth |21 4722'57.2313
End Sta/Chainage [m] |5,‘| 03

End Noithing [m] |-7.709 ak | Cancel | ‘

End E azting [m) |—2,22?
End Azimuth |214°2257 2513

0K Cancel | |

Figure 6-56. Edit Properties for a Line Segment in a Horizontal Alignment

Edit Curve Segment Properties

1. To edit the properties for a curve segment, double-click the
desired segment in the horizontal alignment table.

In the graph view, double-click the segment to open
the Properties dialog box.

2. View the end position for the curve segment.
3. Edit the general properties for the curve segment.

* Select whether or not the segment is tangential to the
previous element.

* Edit the type of element.
 Edit the azimuth and order of the curve segment.

Edit the length for the curve segment.

Edit the radius of the curve segment.
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4. Click Apply to save the changes. Click OK to exit.

Properties : Horz Element

General  End Position ]

End Sta/Chainage [m] |3.983
End Morthing [m) 3,484
End E asting [m) 0.664

Properties : Horz Element EJE|
General | End Position |
Type Curve v | [ Curve
Length [m) ,39837 Deg Curve ,W
Tum m DegChard [
I Fadius T — Delta W
- Chod(m] [3547

Azimuth 121°56'03,0668 Tangent (m] |2.613
MidOrd (m] [0776
External [m) |1.144

End Azimuth 216°28'34 9366

oK | Cancel

oK | Cancel |

Figure 6-57. Edit Properties for a Curve Segment in a Horizontal Alignment

Edit Spiral Segment Properties

1. To edit the properties for a spiral segment, double-click the
desired segment in the horizontal alignment table.

In the graph view, double-click the segment to open
the Properties dialog box.

2. View the end position for the spiral alignment.

3. Edit the general properties for the spiral alignment.

¢ Select whether or not the segment is tangential to the

previous element.

* Edit the type of element

Edit the azimuth and order of the spiral segment.

Edit the length and spiral constant for the spiral segment.

* Edit the spiral direction.
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4. Click Apply to save the changes. Click OK to exit.

Properties : Horz Element

Generall End Position }

Type Sl T Curve

Lengthfm) [3341  opisl Constim] [3139

Tun [Roht ] Peatue [Z251°45'52. 2433
Radus [26 Deg Chord [

[™ Tangential to prev element

Azimuth | 34°2339,7735

(1] 4 | Cancel ‘ Apply

Properties : Horz Element

General  End Position ]

End Sta/Chainage [m] |408.334 L
End Morthing [m) \-8,355

End E asting [m] [10.723

End Azimuth |79°3317 6938

oK | Cancel ‘ Apply ‘

Figure 6-58. Edit Properties for a Spiral Segment in a Horizontal Alignment

Edit in the Vertical Alignment
Properties Dialog Box

1. To edit the properties for the vertical alignment, double-click the
desired alignment in the vertical alignment table.

In the graph view, double-click the alignment to
open the Properties dialog box.

2. Edit the type of the alignment (Parabola Long Section and Arc
Long Section), alignment’s station/chainage, length/radius, and
elevation.

3. Click Apply to save the changes. Click OK to exit.

Properties : Vert Element Elf@ Properties : Vert Element E|E|
General ] General I
Type Parabola Long Section Type ‘An: Long Section ﬂ
Lenath [m] [10 Fadius [m) [100
Sta/Chainage [m) [41.632 Sta/Chainage [m] [41.632
Elevation [m] [134.07 Elevation (m]  [134.07

ok Cancel | 0K Cancel ‘ Apply

Figure 6-59. Edit Properties for the Vertical Alignment
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Edit in the X-Section Properties
Dialog Box

Edit Template Properties

1. To edit the properties for the x-section template, double-click the
desired template in the x-section table.
View the name of used x-section template for the road.

3. Click Apply to save the changes. Click OK to exit.

< Properties : X-Section Set C @@

General 1

Name [E—|

0K | Cancel | ‘

Figure 6-60. Edit Properties for the X-Section

Editing Layers
Among other editing activities, Topcon Link can be used to edit the

layers in a file, including the layer name, line and point styles, and the
color to use for objects on the layer.
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Edit on the Layers Screen

In the Layers screen, you can edit all fields directly on the screen.
Figure 6-61 shows an example of editing fields on the Layers screen.

[ — I
Auto hd
™ | -
5/Brk | | Breakline
y —_-—- Boundary
——— e Exxclusion
opco opCo d oad O
Mame sible: Line Skyle Lihe width Color Point 5ymial | Breakline Type Mote Fill area
=) es 1pt Auto Mo
== hes — 1pt —— Auto Mo
1 it — Mo
= Yes — ipt — Auko Mo
=2 fes —_— 1pt —— Auto Mo

Figure 6-61. Editable Fields on the Layers — Example

Edit in the Layer Properties Dialog
Box

Use a color other than black (or the background
color) for lines and points.

1. To edit the properties for the layer, double-click the desired layer
in the Layers screen.

2. Edit the general properties for the layer.
* The notes.
* Whether the layer is visible or not.
* The layer’s breakline type.
3. Edit the plotting styles for the layer.
* The line style and width.
* The color to use for lines and points.

* The point symbol.
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4. Edit the fill for areas in the layer, either filled or not filled.
5. Click Apply to save the changes. Click OK to exit.

= Properties : Layer L1

Mame

| Hies
Mote Caolar
Line Style — — | General ] Flotting styles Area l

Breakline Type  |Auto Line Width 2nt ¥ Fill Area
v Visible
Paint Symbol [ ]
(] 8 | Cancel
| (] 8 | Cancel

QK | Cancel Apply

Figure 6-62. Edit Properties for the Layer

About Editing Offsets in
Topcon Link

Using the associated Properties dialog box, you can edit the offsets
for TS or GPS measurements and for PTL (point to line) points.
Topcon Link recognizes offsets from an observation line, point-to-
line offsets, and offsets from a line with a known azimuth.

Offsets from an observation line in Total Station measurements

* Offset Along — the distance from the Prism Point to the projection
of the Offset Point along the line of sight

e Offset Across — the distance from the offset Point to the line of
sight, either to the left or to the right of the line
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» Offset Height — the height difference from the prism point to the
offset point

+ Properties : TS Obs 1.CP_3-7. TRAV1

izeneral 1 Observation  OFfset 1 Skring ] Adjustment 1
(ffset Along [m) 1
(ffset Acrass [m) |05
(Qffset dHt (m) [22
|
|
ﬁdHt =
_______ P
-
Offset -
- " Paint -~ ‘(‘D
Ok | Cancel -~ g /OQ\§8
- @ - \0,;@
< acrosg offset

Occupation
Point

Figure 6-63. Measuring/Editing Offsets From Observation Line

Offsets from the reference line formed by reference points
(point-to-line offsets) in TS and GPS measurements

* From Point — the start point of the reference line (Point 1)
* To Point — the end point of the reference line (Point 2)

* Offset Dist — the distance along the reference line from the prism
or the rover GPS antenna point to the offset point

Offset Across — the distance perpendicular to the reference line
from the prism or the rover GPS antenna point to the offset point

» Height is relative — the height difference from the prism point to
the offset point
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» Height is absolute — the absolute height of the offset point

TopSURYV sets only absolute elevation for a PTL

= point.

e Wl 21_ along offset

] Offsat —_—
%]
& .
5 Across @
]
gl
o
C
¥ D ]
Prism Point or Properties : Point Of_1 E]g\
FRE o General | Coordinates  Offset | PhotoMates | Codes andStyle |
Offset Dist m] [15
Dffset Ht (m) i

Offset Aeross (m] &
Fiom Paint [Paint 2 |

To Point =

Height is
" Relative
" Absolute

ok Cancel ‘ Apply

Figure 6-64. Measuring/Editing Offsets From Point-to-Line

Offsets from a line with a known azimuth in TS and GPS
measurements
* Azimuth — offset line azimuth
 Offset Dist — the distance along the line with known azimuth
from the rover GPS antenna point to the offset point

» Offset Across — the distance perpendicular to the line with known
azimuth from the rover GPS antenna point to the offset point

» Offset Ht — the height difference from the rover GPS antenna to

the offset point
» Height is relative — the height difference from the prism point to

the offset point

Topcon Link Reference Manual
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* Height is absolute — the absolute height of the offset point

< Properties : GPS Occupation 5031-5069

General I Antenna Offset]

FIX

Azimith 3
Offs=t Dist [USFE) 128
Offset HE (USF) |0.as

Offset Across USH] |74

Ok | Cancel

Apply

T Morth

L Offget
Azimuth

Prism
| Point

Occupation
Paint

Figure 6-65. Measuring/Editing Offsets From Observation Line
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Notes:
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Chapter 7

Working with Point
Data in Topcon Link

Topcon Link includes a function for working with point data:
computing coordinates of TS and GPS network.

Computing Point Coordinates
for Raw Data and TopSURV
Files

Topcon Link allows computing point coordinates for raw data and
TopSURY files.

Compute Coordinates

Note the following restrictions for coordinate computations:

When editing data, coordinate computations
(re-calculation) are not automatic. You must
manually select the Compute Coordinate function.

_f"- If there is no antenna information (‘Antenna Type’
field is empty) for Base RTK station, the phase
center of the Base station will be used to compute
Rover positions.

[WARNING )

For details on setting the parameters for computations, see “Set
Process Properties for Computations” on page 7-2.

1. Open araw data or TopSURYV PC Job File.
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2. Click Process » Compute Coordinates.

Any new point coordinates are added and written to the file.

B C:\topcon¥TopconLink\TopSURVAPROJECT TS.tlsv <TopSURY PC Job>

+" Points } Tsobs | & Codes |
Icon | Marne Grid Narthing (m) ‘ Grid Easting {m) ‘ Elewatian (m) ﬁ\[cantrol | Mote ‘ Phata Nokes ‘ Layer | ~
al ARG 633365663 1353133272 113,985 [ il :
& cPacH] Pz None i}
¢ CPacHK] P3 Mone 0
O CP4T.. P4 HNone i
¢ CPSCHE| = 0
4 CPECHK] Grid Morthing {m} | Grid Easting {m) | Elevation {m})
A P 629327.354 1883339.863 117.22 EeE e THen1 53 595 115 age
A Pz 629329.167 1853339.866 117,38
& cP3 629324,386 1863340,138 117,35 629329.161 1883339.873 117.381
. 629324.374 1553340.150 117,347
629455,395 1553313.262 114,566
629314,678 1883211,333 127466
G29275.289 1553285739 129,502
629327, 384 1883339,868 117,226
629329, 167 1553339.866 117,383
629324, 386 1883340,138 117,350

Figure 7-1. Coordinate Calculation — Before and After Example

Set Process Properties for
Computations

Typically, the default parameters are sufficient for most coordinate
computations of TS network. In the Process Compute Coordinates
pane, the user can set distance and angle measurement errors to take
them into account when computing the coordinates of the station
using directions observed from the station to points of known
positions (resection method):

2 Process properties

= Pracess EDOM |3 mm + |3 ppm
L Coordin SR S R -

Computations
WA Sigma, [sec] [10

Figure 7-2. Apply Coordinate Computation Parameters

3. Click TS Computations in the left pane and select the refraction
coefficient for total station observations.

The refraction coefficient corrects the vertical angle between the
earth’s curvature and refraction in the atmosphere.
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4. Click OK to save the settings.

2 Process properties

= 5 Frocess Refraction Coefficient
Compute Coordinz [~ [
T5 Computations [IECETRTY
oz
" ‘Without Curvature

=
%

Figure 7-3. Apply Total Station Computation Parameters
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Notes:
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Chapter 8

Exporting Data Files to
a TPS Device

Topcon Link provides a simple interface for exporting data files
directly to a Topcon device (instrument). Topcon Link exports any
file type to a hand-held controller, coordinate files to a total station,
and an option authorization file (OAF) to a GPS receiver.

Before you can export data to a total station, the
T device must first be set up. See “Adding and
Formatting Devices” on page 2-1 for details.

This chapter discusses the steps to export data files to a connected
device.

* See “Exporting Files to a Mobile Device” on page 8-2.
» See “Exporting Files to a Total Station” on page 8-3.
* See “Exporting an OAF to a GPS Receiver” on page 8-5.
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Exporting Files to a Mobile
Device

The Topcon family of controller software runs on several Topcon and
third-party mobile devices. Microsoft® ActiveSync® is used to read
the data on the mobile device.

TopSURY supports two formats of the job files:

* TopSURV *. tsj. This job is created in TopSURYV version 7.0 and
later.

* TopSURYV *.tsv job. This job is created in TopSURYV version
6.11.03 and earlier

There is a difference in format of these files and a difference in using
these files in the computer’s software.

In TopSURY version 7.0 and later, the *.tsj file is saved on the
controller, that this file format can be opened by Topcon Link/Topcon
Tools/TopSURYV PC. Topcon Link is used only for transferring the

* tsj file from the controller to the computer without format changes.
Moreover, the user can use a movable memory card to transfer the

* tsj file from the controller to the computer.

In TopSURY version 6.11.03 and earlier, the *.tsv file is saved on the
controller. But Topcon Link/Topcon Tools/TopSURYV PC version can
not open this file format. Topcon Link has to convert mobile device-
based formats to computer-based formats.Topcon Link performs the
conversion during the import process the *.tsv file to the *.tlsv file.
This format (*.tlsv) is opened by Topcon Link/Topcon Tools/
TopSURYV PC

When connecting to a CE-based device, Microsoft ActiveSync
automatically starts up and connects with the device. This connection
is required to properly export files. If you need to install ActiveSync,
see “Installing Microsoft ActiveSync for Use With CE-based
Devices” on page 1-11 for details.
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This section describes data export using the Topcon
Link interface.

To use Windows® Explorer for data exporting, see
“Using Windows Explorer to Export Files to a
Device” on page 8-7.

1. Connect your controller and computer according to the
controller’s documentation.

Note that a Bluetooth® connection requires that both devices
have Bluetooth wireless technology capabilities.
With Topcon Link open, click File » Import from Device.

3. In the right panel, double-click Mobile Device. Topcon Link
connects to the internal memory of the controller.

4. Navigate to the location in the controller’s memory in which data

files are saved. For example, TopSURYV files are saved to the CF
Card/TopSURV/Jobs directory.

5. In the left pane, navigate to the folder on the computer in which
the file is saved.

6. Select the desired file(s) and click the Move Right button. The
file export progress displays.

Exporting Files to a Total
Station

The Topcon family of conventional and robotic Total Stations have
an internal data storage device to record data to in various formats.
Refer to your Total Station’s documentation for details on setup,
operation, and connection with other devices.

When exporting files to a TPS Total Station, Topcon Link simply
connects to the device and provides a path for the data transfer. The
actual file transfer is performed at the Total Station.

The connection procedure for TPS Total Stations varies, so refer to
the device’s documentation for details.
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When connecting to a CE-based device, Microsoft ActiveSync
automatically starts up and connects with the device. This connection
is required to properly export files. If you need to install ActiveSync,
see “Installing Microsoft ActiveSync for Use With CE-based
Devices” on page 1-11 for details.

This section describes data export using the Topcon
= Link interface.

To use Windows® Explorer for data importing, see
“Using Windows Explorer to Export Files to a
Device” on page 8-7.

1. Connect your controller and Total Station according to the
device’s documentation.

With Topcon Link open, click File » Export to Device.

3. In the left pane, navigate to the folder on the computer in which
the file is saved.

4. In the right pane, double-click Topcon Total Stations.
5. Double-click the desired device to connect with the Total Station.
6. Select the coordinate file to export and click the Move Right

button.
[~ Export to Device @E‘
Loskin: [ CJCoodinac e +] 4| ] tookin [goPTamsw -] || ey
b2 5_7,pnt # Filet et
ELIENU-111.c5

enu _pZZ.xye
me—SDDD.pnt
@fmm_am_fln\andljr]‘csv

Clase:

Pl

Figure 8-1. Select File to Export and Total Station

7. Follow all steps listed in the Upload file(s) to Total Station dialog
box. These steps may vary depending on the connected device.
Press the F3 key on the Total Station.
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Exporting an OAF to a GPS Receiver

8. Click Start in Topcon Link to export the data and save it in the
Total Station.

Upload file(s) to Total Station @

For export to Topcon TotalStations GPT-3000 series please follow ~
instruction below:

Tum on the Total Station by pressing the POWER button.

Press the Menu Key

Press the 'F3' key far Memary Manager

Press the F4' key twice(2) until you arive st page 3

Press the 'F1' key for Data Transfer

Ir the Thata Transfer' the user has a choice to either receive from the

computer data in GTS format 'F1°, orin 555 fomat (GTS-7) by pressing F2*

File name:

Status:

Figure 8-2. Export File to Total Station

Exporting an OAF to a GPS
Receiver

Topcon Positioning Systems issues an Option Authorization File
(OAF) to enable the specific options that customers purchase. An
Option Authorization File allows customers to customize and
configure the receiver according to particular needs, thus only
purchasing those options needed.

Typically, all receivers ship with a temporary OAF that allows it to be
used for a pre-determined period of time. When the receiver is
purchased, a new OAF permanently activates desired, purchased
options. Receiver options remain intact when clearing the NVRAM
or resetting the receiver.
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The OAF enables the following kinds of functions. For a complete list
of available options and details, visit the TPS website or consult your
TPS dealer.

* Type of signal (standard L1;  * Co-Op tracking

optional L.2) + Advanced multipath
* Memory (standard OMb; reduction

optional up to 128Mb) » Wide Area Augmentation
» Update rate (standard 1Hz; System (WAAS)

optional 5, 10, or 20Hz) » Receiver Autonomous

* RTK at 1Hz, 5SHz, 10Hz, and Integrity Monitoring (RAIM)

20Hz 1 PPS (Pulse-Per-Second; a
* RTCM/CMR Input/Output timing signal)

¢ Event marker

As job requirements expand, new options can be purchased and
uploaded to a Topcon GPS receiver as an OAF. The Topcon Link
installation creates a virtual directory for connecting to GPS
receiver’s via the Windows Explorer interface. Use this directory for
uploading an OAF to a connected receiver.

1. Connect the receiver to the computer. Turn on the receiver.

2. Navigate to the Topcon Receivers device directory and click the
device icon.

3. After discovering devices, right-click the receiver’s icon and
click Transfer options file.

4. Navigate to and select the OAF file for this TPS receiver. Click
Open to upload the file.
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Lok ir:

I oat1
) =

B Topcon Receivers

File Edit ‘iew Favorites Tools Help ",'
O Back + < ir /s ) search [1 “ Folders
Address | &) Topcon Receivers v . Go
Folders £ & @
& Topcon Digital Levels -~
&) Topron Receivers Search far
i connect...
& Topcon Total Stations
& My Metwork Places Transfer
2 Recydle Bin
My Bluetooth Flaces 2
=)
My Network — File name: [AEBOIPEZUO0 o = Open |
Flaces
Files of type: ‘Tupcun Options file [*.tpo; *jpo] j Cancel

Figure 8-3. Export OAF to GPS Receiver

Using Windows Explorer to
Export Files to a Device

After installing Topcon Link, the computer’s hard drive contains up
to five virtual drives for accessing Topcon devices to import/export
data. These virtual drives provide a quick way to transfer data without
opening Topcon Link. Many of the steps are the same as for
importing/exporting data via the Topcon Link interface. See the
corresponding section above for further details on the steps listed in
sections below.

Export to a TPS Mobile Device using Explorer

1. Connect the controller to the computer. Connect to the controller
via ActiveSync.
On the computer, navigate to and copy the file(s) to export.

3. Navigate to the Topcon Mobile Devices device directory and
click the device icon.

4. Navigate to the CF card and the desired job file(s).
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5. Paste, or drag-and-drop, the desired file(s) to the controller.

for the job created by
TopSURYV version 7.0 and later

& Jobs E\EIEI
Fle Edt View Favortes Tools Help "
e Back - O - \ﬁ‘ /"\J Search | [ Folders -

Address || 1CF Card\TRS\TopsURY Jobs v B
Folders &3

= [ Mobile Device ~
() Application Data
I CF Card
= s
(53 TopsUry
3 Jobs ~
for the job created by

TopSURYV version 6.11.03
version and earlier

Copy & Convert to mobile device format...

airport

Copying (from ‘TopSURV_T format’ to Jobs')

NENNNNNNENENEEEN

Copy & Convert to mobile device format... E\
(8 i

points_d3

Converting (fiom 'TopSURY Access database’ to TopSURY S5CE database’]
MENENNNNENNENENNENNNENENNNNENNEENNENER

Copying [from desktop computer to Uobs?)

Cancel

Figure 8-4. Export Using Explorer — Mobile Device

Export to a TPS Total Station using Explorer

1. Connect the total station to the computer. If needed, connect to

the total station via ActiveSync.

2. On the computer, navigate to and copy the coordinate file to

export.

3. Navigate to the Topcon Total Stations device directory and click

the device icon.

4. Click the icon for the connected total station.

5. Paste, or drag-and-drop, the file to a directory on the computer.

6. Follow all instructions on the Upload file(s) to Total Station

dialog box.
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7. Press F3, then click Start to upload the file.

eBack M 7

File  Edit ‘Wiew Favorites  Tools  Help

)
7 Search

[F‘ Folders

Address | & GPT 3005w

Faolders

‘3 My MNetwork Places

- @
@ & Topcon Total Stations A~

Filel.txt
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Upload file(s) to Total Station

For expoit to Topeon TotalStations GFT-3000 seties please follow
instruction below

Tutn on the Tatal Station by pressing the POWER buttan.

Fress the Menu Key

Fress the 3" key for Memory Manager

Fress the F4' key twice(2) unti you arive al page 3

Press the 71" key for Data Transfer

In the ‘Data Transier' the user has 3 choice ta sither receive from the

computer data in GT5 format F1% or in 555 format (GT5-7) by pressing F2.

File name:

Status:

Figure 8-5. Export Using Explorer — Total Station



Exporting Data Files to a TPS Device

Notes:
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Appendix A

Data Views Reference

Topcon Link has up to three views for displaying job file data: a
tabular view, a CAD view, and a layers view. The view that
displays—and any data in that view—depends on both the file format
and the data contained in the job.

For coordinate, total station raw data and digital level files, the same
tabs will always open, whether or not the data is present. However,
when opening a TopSURYV database file, Topcon Link reads the file
and displays the appropriate tabs and graphical views associated with
the data.

¢ Coordinate file tab — Points
¢ Total Station raw data file tabs — Points and TS Obs
* Digital Level file tabs — Points and DL Obs

* TopSURYV database file tabs — Points
— GPS Occupations, if the job contains GPS occupations
— TS Obs, if the job contains total station observations
— GPS Obs, if the job contains GPS observations
— Codes, if the job contains codes
— Linework, if the job contains linework
— Tap Dimensions, if the job contains tape measurements

— Images, if the job contains images (such as data obtained
using the GPS-7000i total station)

— X-Section Templates, if the job contains road data

— Roads, if the job contains road data

When viewing a TopSURYV database file, the CAD view displays
points and linework, and a Layers view can be displayed if the job file
contains layers.
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Coordinate File Data View

Coordinate files contain data on points taken with total station, digital
levels, or GPS receivers. The coordinate file data table contains only
one tab to display data. Because coordinate files do not store unit and
system information, you can select these settings using the advanced
options while opening or in the status bar.

For details on editing coordinate information, see Chapter 6
(coordinate data can be contained in TS, DL, or GPS measurements).

Points Tab

For coordinate files, the Points tab has the following default columns.

* Icon — the symbol used for the point

* Name — the name of the point

 Latitude\Northing — the measured northing coordinate for the
point and coordinate type

* Longitude\Easting — the measured easting coordinate for the
point and coordinate type

* Elevation — the elevation of the point

* Note — any notes associated with the point

* Code — any codes associated with the point

+” Points l
1, | Marme | Latitude | Longitude | Ell.Height {rn) | Code Mok
& BASEZ 4006 07.52051M 52 59 12,47055W 505,095 Base
& Cp2 4006 11.06726M 82 59 16, 158724 10,591
F ) 4006 13122694 52 59 10,68572W 809,265
& CPS 4006 07, 237587M 82 59 06, 52397W 07,545
& CPR 4006 05227930 5259 12,11935W a0s,409 Base for TS
Meters Mone

A-2

Figure A-1. Coordinate File Data Table
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Icon Descriptions

Table A-1 lists the icons used to represent different information in the
data table.

Table A-1. Coordinate File Icons

Location Icon Description

Unknown point

Points Tab a Fixed coordinates point

Offset point (only for GTS-7 Points)

TS Observations File Data
Views

Total Station observation files contain data on points and
observations taken with a total station instrument. The TS
observations file data table contains two tabs to display data. Because
total station files do not store system information, you can select these
settings using the advanced options while opening or in the status bar.

For details on editing total station observation information, see
“Editing TS Observations” on page 6-12.

Points Tab

For TS Obs files, the Points tab has the following default columns:
¢ Icon — the symbol used for the point
* Name — the name of the point

* Latitude\Northing — the measured northing coordinate for the
point and coordinate type

* Longitude\Easting — the measured easting coordinate for the
point and coordinate type

* Elevation — the elevation of the point
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* Code — any codes associated with the point

* Control — the coordinate fix of the point (None, Horizontal,
Vertical, Both)

* Note — any notes associated with the point

[ € Topcon Link Data'M062502.raw <GT5-6 Raw> =1o1x]
+° Paints | &, 75 0bs |

Tcon | Tame | Ground Marthing {m) | Ground Easking {m}) | Elesation {m | Code | ¥ Contral | Noke

< 1 9.938 13.391 1.122 TREE None

<+ 10 15.474 15,984 -0.086  TREE Maone

¢ 2 3111 15.239 4.290 TREE MNone

¢ 3 4.000 9.992 -0.095  TREE MNone

¢ 4 6.913 7.632 0.407 TREE Maone

<4 S 2.554 3.574 0.731 TREE Mone

¢ [:] 12.070 3.740 -0.889 TREE MNone

¢ 7 15.548 1.402 2238 TREE Maone

<4 g 21.133 2.555 0.443 TREE Mone

¢ 9 17.476 8.531 -1.408 TREE MNone

£ MARE 10,000 10,000 0,500  STAT Both

& 371 13.545 7.055 -0.256  STAT Harizontal

o 572 14,859 10,678 -0.202  STAT Vertical

o BT

Figure A-2. TS Obs File Data Table — Points Tab

TS Obs Tab

For TS Obs files, the TS Obs tab has two panels, the left for points
with known coordinates, the right for points with unknown
coordinates measured from the point selected in the left panel.

The left panel contains the following default columns:
* Icon — the symbol of the point
* # — the number of the point
* Point Name — the name of the point

¢ Instrument Height — the height of the instrument in the selected
units (ft, m)

The right panel contains the following default columns:
¢ Icon — the symbol of the point
* # — the number of the point

* Point From — the beginning of the vector
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* Point To — the end of the vector
» Reflector Height — the height of the reflector

* Azimuth, Horizontal Circle, Zenith Angle, Slope Distance —
angular and linear measurements in the selected units (DMS, qon,
mil, radian, ft, m)

* Note — any notes associated with the point
* Code — any code associated with the point
* Type — the type of point
— SS: side shot point
— BS: backsight point (the previous occupation point)
— FS: foresight point (the next occupation point)
— BKB: backsight bearing point

— Horizontal/Vertical Resection: plane or vertical coordinates
of station point are computed using measurements from two
(or more) points with known coordinates

— Resection: plane and vertical coordinates of station point are
computed using measurements from two (or more) points
with known coordinates

[ C: Topcon Link Data'MO62502.raw <GTS-6 Raw= i ] 4
«" Points <% TS5 Obs |
Icon | # | Point Mame | Instrument Height ... Icon | k3 | Point From | Foint To | Reflector Heig... | Azitnth
LA 1 TMARK 1520 |, 1 MARK 5T1 1,600
k3 2 |sTi 1460 | €, z  MARK 3Tl 1,500
< 3 STz 1.410 | <@ 3 MARK aTZ 1.500
< 4 1 1510 | <, 4 MARK a1z 1.600
< 5 z 1.520 | <, 5 MARK 1 1.600
< ] 1.460 | <@ 6 MARK z 1.500
< 74 1410 | <, 7 MARK k] 1.600
< G MARK 4 1.600
K |

Figure A-3. TS Obs File Data Table — TS Obs Tab
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Icon Descriptions

Table A-2 lists the icons that represent different Topcon Link
parameters in the data table.

Table A-2. Total Station Raw Data File Icons

Location Icon Description

{} TS station

TS point

Points Tab

Fixed coordinates point

Fixed Horizontal control

Fixed Vertical control

S O3 E S

TS Obs Tab, Left TS station
Panel
{} ForeSight measurement
A
TS Obs Tab, {I} SideShot measurement
Right Panel L
{} BackSight
A
TS Obs Tab, E@ BackSightBearing point measurement
Right Panel Sa
(Continued) TS Resection Observation

g
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Digital Level File Data Views

Digital Level File Data Views

Digital level files contain data on points measured with a digital level
instrument. The DL observations file data table contains two tabs to
display data.

For details on editing level measurements, see “Editing Digital Level
Observations” on page 6-19.

Points Tab

For a Digital Level file, the Points tab has the following default
columns:

¢ Icon — the symbol used for the point
* Name — the name of the point

* Latitude\Northing — the measured northing coordinate for the
point and coordinate type

* Longitude\Easting — the measured easting coordinate for the
point and coordinate type

* Elevation — the elevation of the point
* Code — any codes associated with the point

* Control — the coordinate fix of the point (None, Horizontal,
Vertical, Both)

* Note — any notes associated with the point

M C:\topcon\Topconlink\Digitall eve \37wcent1.lev. <Topcon DL Obs=>

«” Points ] =, oLobs |
Icon | Marne | Ground Morthin... | Ground Easting ... | Elevation (LISFE) | Code Caontral | Take

1 Mone
2 Mone
20 Mone
21 Mone
Mone
3 Mone
4 Mone
S 100.000 Mone
BO1 100,000 Werkical

opooaeeaoe
r
£

A
v

Figure A-4. DL Obs File Data Table — Points Tab
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DL Obs Tab

For a Digital Level file, the DL Obs tab has two panels, the left for
start and end points of a job, the right for all level measurements for
the job selected in the left panel.

The left panel contains the following columns:
* Icon — the symbol of the leveling job
* # — the number of the leveling job
* From — the start leveling point of the job
* To — the finish leveling point of the job

* Level Run — the name of the leveling job created in a Topcon
digital level

* Date — the start date (day/month/year) and time of job creation
* Note — displays user comments
* Distance — the sum of all backsight and foresight distances

* Balance — the sum of differences between DL to BS point and DL
to FS point of the job

The right panel contains the following columns:
* Icon — displays a symbol associated with turning points
* # — the number of the measurement
 Point — the name of the turning point
* BS - the measurement for backsight point
* FS — the measurement for foresight point
* Distance — measured distance

 Elevation — the orthometric heights of the point (or the height of
the point is calculated from a point with known height)

* Vert. Offset — displays the vertical offset from the horizontal
plane for traverse and sideshot points

* Note — any comment for the level measurement
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¢ Std Dev — standard deviation for the level measurement. This
value is created in the digital level

¢ Date — the date and time of level measurement

* Level Run — the name of the leveling job created in a Topcon

digital level

B C:\topcon\TopconLink\Digitalleve\37wcent1.lev =Topcon DL Obs=

«” Points B, DL Obs I

1] # [From [To [Levelrun *[1.[# [Paont | B3 (usft) [ instrument Elev... | 55 (st | Fs(usit) | Eleva s
il e s ToRcon (@, 1 et 14.629 35.000

g,z 1 35.000 17.192

B3 1 16,603 34,850

o4 2 34.850 17.913

[ RS- 14,797 33.900

m o6 @a00 18.274

L7 OO0 20.046

ms 2 :[I00 19718

[+RETE 33.900 17.552

o103 17.487 33.880 3
< s |€ >

Figure A-5. DL Obs File Data Table — DL Obs Tab

Icon Descriptions

Table A-3 lists the icons that represent different Topcon Link
parameters in the data table.

Table A-3. DL OBS File Icons

Location Icon Description

r Traverse Point for digital level observation
N Side Shot

Points Tab
A Fixed coordinates point
u Fixed Horizontal control
n Fixed Vertical control

DL Obs Tab, Left o Leveling job

Panel -
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Table A-3. DL OBS File Icons (Continued)

Location Icon Description
o BackSight level measurement
Eal
DL Obs Tab, 0 ForeSight level measurement
Right Panel "
o) SideShot level measurement

TopSURYV File Data Views

A TopSURYV database file contains information on the various GPS,
total station, digital level, tape dimension, and cross-section template
data measured/recorded with an instrument running TopSURV. The
type of information in the TopSURYV database file determines the tabs
that will display. TopSURYV database files also display linework and
points in a graphical CAD view. If the TopSURY file includes layers,
another view is available for managing this data.

If TopSURY job contains localization, Topcon Link displays the
point coordinates in the both coordinate systems (WGS-84/Datum
and Ground/Localization). Topcon Link does not recalculate
localization parametes which were ctreated in TopSURV.

«° Points | Gps ocepations | o Psobs | & codes |

Tcon | Mame | Ground Morthing (1Ft) [ Ground Easting ... | Elevation (Ift) | Code [ hate [

s & 3273761800 4142.383900 100.00000 1

& B 3313.552600 4038.771800 100.00000 1

&  BASEFI 4934.179000 4983.953000 200.00000 13 :

s c 3415.514200 3632426300 toosopo 111 local coordinate system
@ Fl1 4010.038539 4449902470 20000000 2

&  Fl2 4011.286855 4432716598 200.00000 2

<
Ready IFest | M5  Ground | 06_D76STCL_GPS_7.Hsv Localization

+° Points | g G5 Occupations | @2 G obs | & Codes |

Icon | Mame Latitude | Longitude | EllHeight (1ft) | Cade | nate | Phata Motes

A A IaEzAS,.  11EEAL.., 143819224 1

a4 B IIEEII., 111 145317121 1

&  BASEFL 33°3829.8,.,  111°5532..., 144357057 110 Datum coordinate syster
a LIS, 111, 144311179

& Pl 325, 1IEEE.., 1445.00057 2

@ Rz 2L, 111, 143660310 2

<
Ready IFeet | DMS | DatmlatLom ELH | wGsS4

For details on editing TopSURYV data file information, see Chapter 6
(TopSURYV data files can contain TS, DL, or GPS measurements).
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CAD View for TopSURY Files

The CAD view is a two-dimensional, graphical representation of
linework road and surface data, with associated points, in a
TopSURY file. To view the CAD graphic, click View » CAD View.
Depending on the file’s data and the filters used, the following
information will be displayed. To set filters, see “Setting CAD View
Options” on page 3-21.

Points display with the associated symbols. If the point does not
have a symbol assigned, its survey symbol will be used.

Lines display with the associated code/layer color, style, and
width.

Control codes (/AS, /AE, /C) display as an arc or closed polyline,
repectively.

Codes with a polygon entity display as closed and filled (if a fill
color has been set).

Roads display in the color applied to the corresponding layer(s).

Figure A-6. TopSURYV File CAD View

The Roads tab and X-Section Templates tab have
BT independent CAD graphical views associated with
the selected data element.
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Layers View for TopSURYV Files

The Layers view lists all layers in the file with associated properties.
To view the layers, click View » Layers. The following information
will be displayed for each layer. To edit a layer’s properties, see
“Editing Layers” on page 6-44.

Name — the name of the layer

Visible — if the layer is visible in the CAD view
Line Style — the style used for lines in this layer
Line Width — the width of lines in this layer

Color — the color of points and lines in this layer
Point Symbol — the icon used for points in this layer

Breakline Type — the type of breakline for the layer (Auto,
Breakline, Boundary, or Exclusion)

Note — any notes associated with the layer

Fill Area — any closed polylines will be filled with the color
associated with the layer

# | ayers : C:Mopcon\TopconLinklgradework_road.tlsv

Mame Wisibile Line Style Line Width Color Poink Symbol | Breakline Type Moke Fill Area
= Yes 1pt futo Mo
7 EP Yes —  lpt —— Auto Mo
£F Esp Yes — ipt —— Auto Mo
F SiErk Yes — ipt —— Auto Mo
7 o Yes — ipt —— Auto Mo

Figure A-7. TopSURYV File Layers View

Points Tab

For a TopSURYV database file, the Points tab has the following default
columns:

Icon — the symbol of the point

Name — the name of the point
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Latitude\Northing — the measured northing coordinate for the
point and the coordinate type

* Longitude\Easting — the measured easting coordinate for the
point and the coordinate type

* Elevation — the elevation of the point
* Code — any codes associated with the point

* Control — the coordinate fix of the point (None, Horizontal,
Vertical, Both)

* Note — any notes associated with the point

Il C:\Topcon Link Data'081202a.tlsy <TopSURY files= =101 x|

+” Points |o? GRS Occupations | < T50bs | Q@,ﬁ GRS Obs I & Codes I B, Tape Dimensions |

Icon | Mame | Grid Morthing (m) | Grid Easting (m}) | Elevation {m) | code | ¥ cControl | Mote ;I
<+ 1000 235252,160 559029.916 244,423 Mone

<+ 1001 235255.868 559044586 244,619 Mone

& 1100 235236.378 550020.5944 245,866 Mone

k4 1101 235236.215 559015.540 246.114 Mone

L4 110z 235236219 559018.850 245,860 Mone

<+ 1110 235236.374 559020,856 245,670 Mone

<+ 1111 235236.351 S59020.578 245.471 Mone

& 1112 235236,379 550020.5945 245,471 Mone

k4 2000 235229.574 559056.119 743,832 Mone

L4 2001 235229.374 559056.119 241.832 Mone

< i} 235238.062 559052,102 242,673 Mone

iy a9 235255.5863 559044.905 242.619 Eioth

L4 90 235255.864 559044,905 244,619 Mone

€B E4 Mone

4 Office_2 Mone

R Office_3 Mone

<+ Office 4 MNone _ILI
4| | >

Figure A-8. TopSURYV Data Table — Points Tab

GPS Occupations Tab

For a TopSURYV database file, the GPS Occupations tab has the
following default columns:

* Icon — displays a symbol associated with the occupation
* Point Name — displays the name of the occupation

* Original Name — displays the original occupation name
* Antenna Type — the antenna type used on the occupation

* Antenna Height — the antenna height
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Antenna Height Method — the method used to measure the
antenna height, either Vertical or Slant

Start Time and Stop Time— displays the beginning and end dates
(day/month/year) and starting and stopping epoch time of the
occupation

Duration — the duration of time in which the observational data
was acquired (duration = start time - stop time)

Method — the surveying method used at the occupation; either
Static or Kinematic

Note — displays user comments

Source — displays the path of the source information on the
computer disk drive, local area network, or storage media

Interval — displays the occupation logging interval

Receiver — displays the TPS receiver serial number used for the
occupation

Offset Azimuth — defines the direction from occupation other
horizontal offsets (distance and cross) are given

Offset Dist — displays the occupation’s distance offset
Offset dHt — displays the occupation’s height offset

Offset Across — displays the occupation’s across offset

M C:\topcon\TopconLink\TopSURYPROJECT RTK.tlsv =TopSURV PC Job=

" Foirts @ GPS Occupations ]o@; aPsobs | & codes |

" PONDL FOND1L Hifer ... 2.000 KR 2j2f2004 1:27:...  2[2j2004 1:27:... %
2

Icon | FPaint Mame | Qriginal Name | Anten... | Ant... ‘ Ant Height Met. .. ‘ Statt Time ‘ Stop Time: i
L=} S000-5030 Hifer ... 2.000 Vertical zjzfzo04 1123, 2)2jz004 1124,
L=% 5031-5069 HiPer ... 2,000 Vertical 2i2/2004 1:35:,,,  2/2i2004 11368,
& S070-5125 Hifer ... 2.000 Vertical 2jzf2004 1:37:...  2(2j2004 1:39:...
@ CHEPTL CHEPTL HiPer ... 2,000 Vertical 2jzj2004 1:33:,,,  2)2j2004 11338,
& CHKPTZ CHKPTZ HiPer ...  2.000 Vertical 2i2j2004 1:340,,, 24202004 1334,
@ sz sz Hifer ... 2.000 Vertical zjzj2004 12:53...  2J2j2004 12:53...
& P3 P3 HiPer ...  2.000 Vertical 2i2j2004 12:52,.,  22/2004 12:52..,
@ P4 P4 Hifer ... 2.000 Vertical zjzj2004 12:56...  2J2j2004 12:56...
@ iP5 iP5 HiPer ... 2,000 Vertical 2i2f2004 1:01:,,,  2)2i2004 1:01:..,
& RS RS Hifer ... 2.000 Vertical 2jzf2004 1:04:...  2(2j2004 1:04:
@ cP7 cP7 HiPer ... 2,000 Vertical 2jzj2004 1:18:.,,  2)2j2004 1:18
& e} e} HiPer ...  2.000 Vertical 2i2j2004 1:10:,, 2/2/2004 1:10:,.,
@ CP_1 CP_1 ‘ertical

Loy P 1 P 1 Vertical 2i2j2004 12:52,,,  2/2j2004 11368,
<

Figure A-9. TopSURYV Data Table — GPS Occupations Tab
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TS Obs Tab

For a TopSURY database file, the TS Obs tab has two panels, the left
for points with known coordinates, the right for points with unknown
coordinates measured from the point selected in the left panel.

The left panel contains the following default columns:
¢ Icon — the symbol of the point
* # — the number of the point
* Point Name — the name of the point
e Instrument Height — the height of the instrument in the selected
units (ft, m)
The right panel contains the following default columns:
* Icon — the symbol of the point
* # — the number of the point
* Point From — the beginning of the vector
* Point To — the end of the vector
» Reflector Height — the height of the reflector

» Azimuth, Horizontal Circle, Slope Distance, Vertical Angle,
Zenith Angle — angular and linear measurements in the selected
units (DMS, gon, mil, radian, ft, m)

* Code — any code associated with the point
* Type — the type of point
— SS: side shot point
— BS: backsight point (the previous occupation point)
— FS: foresight point (the next occupation point)
— BKB: backsight bearing point

— Horizontal/Vertical Resection: plane or vertical coordinates
of station point are computed using measurements from two
(or more) points with known coordinates

— Resection: plane and vertical coordinates of station point are
computed using measurements from two (or more) points
with known coordinates
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Note — any notes associated with the point

Date — date and time of the point measurement

[ C:\Topcon Link Data',081202a.tsy <TopSURY files> i =)
o° Points | g GPsoccupations 4 TSObs | crsobs | & cCodes | B, TapeDimensions |
Iton # | Point From | Point To_| Reflector Heig... [ Azi... | Horizontsl C... | Slops Distan... | Wertical Angle | Zenith Angle | Date |
& 3 Tala 8 1.770 129°26'24.... 34,130 35895845,  S1°0U'IS0...  8/12/2002 11:14:33
<. 4 Tala ) 1.770 129°26.22.... 34.130 27, 91°01'330... sflzfznnzn:m:aeJ
& s Taa 8 1770 14874242.... 5.830 . GPSTIE0..
S 6 TalA 8 1.770 148°4232.... 5.830 359°0300.... 90°5700.0...
& 7 Tda 8 1770 129°26'23.... 34.130 3585835, SLP01'ZS.0...  8/12/2002 11:14:33
S 8  Taa 8 1.770 129°26'27.... 34.130  358°58%5.. 91°01'35.0... B/12/2002 11:14:39
P Ca—T pos \on (amsaniaa Sxw o | overan gp.qhnmﬂ.u.zl;l

Figure A-10. TopSURYV Data Table — TS Obs Tab

GPS Obs Tab

For

a TopSURYV database file, the GPS Obs tab has the following

default columns for baseline measurements from the Base station to
the Rover point:

Icon — the symbol of the point

Point From — the starting point of the baseline measurement
Point To — the ending point of the baseline measurement
Start Time — the date and time of the start of the measurement
Duration — the time during which the measurement was taken
Note — any note for the baseline measurement

Horizontal Precisions, Vertical Precisions — the horizontal and
vertical precisions of the measurement

dN, dE, dU — the coordinate increments of the measurement in
the current projection

Method — the measurement method (RTK Topo or RTK
AutoTopo)
Solution type — the type of solution used for the measurement
— Float,Phase Diff: float phase difference measurement
— FixeMd,Phase Diff: fixed phase difference measurement

— Float,Phase Diff, mm GPS: float phase difference
measurement with mm GPS
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— Fixed,Phase Diff, mm GPS: fixed phase difference
measurement with mm GPS

i C:\Topcon Link Data},1014C.Hsv <TopSURY files> I [ 5
o2 Foirts | o2 GPsOccupations | <, T50bs o GPs Obs | & Codss |

1. [ PointF... | Point To [ Start Time [ Duration | Mote [ Horizontal Pre... | Wertical Pre... | b (mb [ de tm) [ dhie (m) [ Method [ Sohution Type |
B Topol  10{14f... (0000 pipe... 0.004 0.002 26,118 -19.522 5809 RTKTopo  Fixed,Phass DIff
& Topaz | 1014j... | 0:00:00 0.004 b0z 26118 15,523 5804 RTK Topo | Fixed,Phase Dift
a0 Topsd  10{14f... | 0:00:00 0.004 0.002 26121 -19.524 3801 RTKTopo  Fixed,Phass Diff
& 0 Autol  10/14/... | 0:00:00 0.005 0.003 26116 -19.522  3.907 RTKAuL... Fixed,Phase DIff
Qo Auto2  10{14f... | 0:00:00 0.005 0.003 26121 -19.526 3913 RTKAUt. Fixed,Phass DIFf
& 0 Auto3 10/14/... | 0:00:00 0.005 0.003 26117 -19.522 3911 RTKAUL... Fixed,Phase DIff

Figure A-11. TopSURV Data Table — GPS Obs Tab

Codes Tab

For a TopSURYV database file, the Codes tab has two panels, the left
for all available codes, the right for all attributes associated with the
object (code) selected in the left panel.

The left panel contains the following default columns:
¢ Icon — the symbol of the object
* Code — the code of the object
 Layer — display the layer in which the code is used
The right panel contains the following default columns:
¢ Icon — the symbol of the attribute
* Name — a unique name for the attribute
* Default value — the value of the attribute

» Type — the type of attribute (integer, real number, text, or menu)

M D:\codes_for_linework.tisy <TopSURV.PC files> =1
o° Pants | 2] Lnewark & Codes ]
Icon | Code | Layer | * | Icon ‘ Akkribute Marme ‘ Default Yalue ‘ Type ‘
. -1 For Linel EE Lisk For ob1& pipe Menu
-2 for_Points @ exam 4 Real Mumber
_ For Points 3 quiz lamp Text
@ kest ] Inkeqger

Figure A-12. TopSURYV Data Table — Codes Tab
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Linework Tab

For a TopSURYV database file, the Linework tab has two panels, the
left for all lines (codes, layers, and strings) in the job, the right for all
line segments associated with the line selected in the left panel.

The left panel contains the following default columns:
* Icon — the symbol associated with the line
* Code — the primary code used for the line
* String — (enable in Tabular view options) the string for the line
» Layer — the layer for the selected line

* Color/Line Style/ Point Symbol/Line Width — the plotting style of
the selected line

The right panel contains the following default columns:
* Icon — the symbol associated with the line segment
* Order — the order of points associated with the line segment
* From — the beginning point of the line segment

* To — the end point of the line segment. If the line is closed, the
“To” point for the last segment will be the same as the start point
of the line.

* Control Code — (enable in Tabular view options) the control code
of the point
— Arc Start: the starting point of the arc
— Arc End: the ending point of the arc

— Close: the last point in a closed line

M [ \from_tiZ. sy <TopSURY PC files =

o foines ) Linework | & codes |

kon | Code | Sming | Layer | Color | tneSrde | bine width Poirk Symbol | * [ feon [ Onder | From | To Control Code | Contrel Code 2|
--l z Live L2 BYLAYER I BYLAYER -~ BYLAYERS o= BYCODE = . 1 UserlD  Userld

Leerld  Userl2
HAFLY uarll

- 3
+ O e Usenin chee

Figure A-13. TopSURYV Data Table — Linework Tab
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Tape Dimensions Tab

For a TopSURYV database file, the Tape Dimensions tab has two
panels, the left for all tape dimensions in the job, the right for tape
measurements of the tape dimension selected in the left panel.

The left panel contains the following default columns:

* Icon — the symbol associated with the tape dimension

* Start Point — the name of the starting point for the dimension

* End Point — the name of the ending point for the dimension
The right panel contains the following default columns:

* Icon — the symbol of the point

* #— measurement sessions

* Point to — measurement direction

* Distance — the length of the line
— the “-” sign stands for a left turn

— the “+” sign stands for a right turn relative to the direction of
the measurement the last line

¢ Date — the date and time of the measurement finished

* Note — any notes associated with the measurement

B C: Topcon Link Data', Jobs'\tape.tlsy <TopSURY files> - |EI|1|
«" Points Io? GPS Occupations I <, TS Obs IO@; GPS Obs I & codes O, Tape Dimensions |
Icon | Skark Poink | End Poink | Icon | # | Faint To | Distance {m) | Date | Tote |
B im S o 11 10,000 3{30/2004 09:..,
o z oz 20,000 3{30/2004 09:,.,
o 33 20,000 3{30/2004 09:,.,
nﬂm 4 4 20,000  3f30/2004 09:...

Figure A-14. TopSURYV Data Table — Tape Dimensions Tab
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Images Tab

For a TopSURYV database file, the Images tab has two panels, the left
for a thumbnail of all images in the job, the right for larger version of
the thumbnail image selected in the left panel.

* Topcon Link expects images to reside in a folder
= with the same name as the data file. For
example, data from the “050119.tlsv” file will
be associated with images in the “050119”
folder.

* The data file and image folder must reside in the
same directory for the images to display.

The left panel contains a thumbnail image of all images in the job,
with the lowest image title (either numerically or alphabetically)
listed first.

The right panel contains the selected image with measured points and
linework associated with the image. The symbols of the points
correspond to the settings selected in the Line and Code properties
dialog boxes. The size of the symbol depends on the distance from the
station.

Figure A-15. TopSURYV Data Table — Images Tab
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X-Section Templates Tab

For a TopSURYV database file, the X-Section Templates tab has two
panels, the left for all cross-section templates in the job, the right for
segments used in the cross-section template selected in the left panel.

The left panel contains the following default columns:
* Icon — the symbol associated with the template
* Name — the name of the template
* Cut Slope (1:n) — the percentage of cut for the slope
* Fill Slope (1:n) — the percentage of fill for the slope

The right panel contains the following default columns and a graph
for the x-section template selected in the left panel:

* Icon — the symbol of the segment
* Order — the sequential order of the segment
* Code — the code used for the segment

e Hz. Dist — the horizontal offset from the central line for the
segment

* V.Dist — the vertical offset from the horizontal plane for the
segment. If a value is entered for this parameter, the Grade will be
automatically calculated.

* Grade% — the ratio of Hz. Dist and V.Dist multiplied by 100%. If
a value is entered for this parameter, the V.Dist will be
automatically calculated.

¢ Hz. Offset from CL (m) — horizontal offset from the central line
for the segment start point. Calculated using the corresponding
values of the previous segment(s).
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* V. offset from CL (m) — vertical offset from the horizontal plane
for the start point of the segment. Calculated using the
corresponding values of the previous segment(s).

M [:\road 03ty <TopSURY PC files =

o Points | 4 Roads o X-Section Templates | & codes |

1| Mame | Cutstopeim}| FlSlope (i} | *[1] Cuder [ Code Mg Dist .. | . Dzt {m) | Crade (4] | Mz, Offser From... | W, Offser from ..

o Slabion121 0.000 0.000 1 1.000 0000 2.000 0.000 0.000
0.000 0.000 2 4.000 <0.200 5,000 1.000 <0.020

Figure A-16. TopSURYV Data Table — X-Section Templates Tab

Roads Tab

For a TopSURYV database file, the Roads tab has two panels, the left
for all roads in the job, the right for horizontal alignments/vertical
alignments/x-section templates for the road selected in the left panel.

The left panel contains a data tree with the following entries for each
road in the job.

» Horizontal alignment — select to show both table and graph;
expand to select and show just the table or graph

* Vertical alignment — select to show both table and graph; expand
to select and show just the table or graph

* X-Sections — select to show both table and graph; expand to
select and show just the table or graph
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The right panel contains information for the object selected in the left
panel, whether a road or an alignment/x-section.

M C:\topcon\Topconlink\eradework_road.tlsy <TopSLRY PC Joh> E@@
¥-Section Templates I $ Codes 1
I.‘l Order | Type i
f 1 Lire:
[T Table oz Spiral TSta s
Graphic F 3 Curve
=1l Vertical alignmenk 4 P
FEH Table < S
Graphic
Zrm d-Sections I.‘l Type | StafiChainage (n
FH Table Ty Parabola Long ... 2561694
(T Parabola Long ... 28E70.1€
(T Parabola Long ... 29772.85
(T4 ParabalaLong ... 30047.17
4 *
I.‘l StafChainage {m) | Side: -~
— 26865.174 Right
— 26865.174  Left ~
< > < >

Figure A-17. TopSURYV Data Table — Roads Tab

The horizontal alignment table has the following default columns
and/or a graph for the road or horizontal alignment selected in the left
panel.

Icon — the symbol associated with the element of the alignment
Order — the order of the element in the horizontal alignment
Type — the type of element (line, curve, spiral, or intersection)
Azimuth — the azimuth of the element

Length — the length of the element; editable for all types of
elements except Intersection, where the length is calculated for
the compound curve consisting of two spirals and one curve

Turn — the direction of the turn for a curve, a spiral, and
intersection; “Right” is a clockwise direction, “Left” is a counter-
clockwise direction

Start Radius/End Radius — the radius of the curve or spiral

Northing/Easting — the grid/ground coordinates of the
intersection point

Spiral 1 Len/Spiral 2 Len — the length of the spiral at the
intersection point

End Station — the number of the end station for the element
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* Intersection Pt — the name of the intersection point

» Tangential to prev element — displays “True” if the azimuth for
this element is the end azimuth for the previous element; displays
“False” if the azimuth for this element is arbitrary

* End Northing /End Easting — the grid/ground coordinates of the
end station of the element

* End Azimuth - the azimuth that sets the tangent to the end station
of the element

e Spiral Dir — the spiral direction
* Delta — the angle between the radii corresponding to the curve

 Chord - the length of the segment joining start and end points of a
curve

» Tangent — the length of the segment which touches the given
curve

* Mid Ord - the distance from the midpoint of a chord to the
midpoint of the corresponding curve

» External — the distance from the midpoint of the curve to the
intersection point of the tangents

* Spiral Const — the square root of the product of the length and the
radius of the spiral

 Spiral Const 1/Spiral Const 2 — the spiral constants used to define
a compound curve
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* Start Deg Chord/End Deg Curve — the angle in degrees used to
compute the radius of curve whose chord is 100 units long.

M C:\topcon\Topconlinkigradework_road.tlsv <TopSURY PC Job> E]@@
7 Points Roads ||~ section Templates | & Codes |
= ¢ 6220-812Gradework " [1.] Order [ Type [ azimuth [ Length (m) [ Turn ~
-1 "¢ Horizontal alignme |~ Line £0°57'59.0000 250,948
EEET@HE_ e Spiral TS ko 5C 60°57'59.0000 83.392 Right
G"TDT'E 3 Curve 63°51'58.9963 624,177  Right
- [[mg’;“:ahla‘g”me”t 4 Spiral C5 o 5T 10404921 5635 80,392 Right
o lane Pl Line 107743219798 214,555
Graphic
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Figure A-18. TopSURYV Data Table — Roads Tab, Horizontal Alignment Panel

The vertical alignment table has the following default columns and/
or a graph for the road or vertical alignment selected in the left panel.

* Icon — displays an image associated with the elements.
* Type — the type of the element (grade, parabola, or long section)

 Sta/Chainage — the number of the start station or chainage for the
grade, parabola, and long section element

* Order — the order of the element in the vertical alignment

* Length — the length of the vertical element for the grade and
parabola, and the length of the curve of the long section

* Start Grade / End Grade — the starting and ending percentages of
grade of the element. If the grade is rising, the value should be
positive; if the grade is falling, the value should be negative

 Elevation — the elevation value on the end station for the grade
and parabola and the elevation value of the station used for
creating of the long section
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Data Views Reference
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Figure A-19. TopSURYV Data Table — Roads Tab, Vertical Alignment Panel

The x-section table has the following default columns and/or a
graph for the road or cross section selected in the left panel.

* Station — the station at which the template is applied

* Side — the left or the right side of the road relative to the central
line where this template is used

» Template — the name of the template (selected from the list of
existing templates in the current job)

M C:\topcon\Topconlinkigradework_road.tlsv <TopSURY PC Job> E]@@
7 Points Roads ||~ section Templates | & Codes |
= # 6zen-alzCradewor ' [ 1] StafChainage (m) | Side [ Template [ ~
-1 "¢ Horizontal alignme [~ 26868.174  Right 351500
FEH Table — 26868.174  Left 851500
[2] Graphic — 26883.414  Right BE200R
- [[mg’;t'ca‘ slgrment | 26083414 Left Ba200L
FEH Table — 26974.854  Right BES00R.
: N 26974854 Left aas00L
: 27035814 Left aa700L
N 27188214 Left 9200 )

Figure A-20. TopSURYV Data Table — Roads Tab, X-Section Template Panel
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TopSURYV File Data Views

Icon Descriptions

Table A-4 lists the icons that represent different Topcon Link
parameters in the data table. Note that the icons for codes and
linework are user-selectable, and are not listed below.

Table A-4. TopSURYV File Icons

Location

Icon

Description

Points Tab

¥

TS station

<

TS point

&

TS BackSight point

Point coordinates input manually

Point coordinates calculated by means of COGO

Design point

Stakeout point

Fixed coordinates point

Fixed Horizontal control

Fixed Vertical control

Base station

Topo point?

@ o @ 0B e &8«

Auto Topo pointb

¥

PTL (point to line) offset point

GPS offset point

B o

Tape Measurement Point

P/N 7010-0522

A-27



Data Views Reference

Table A-4. TopSURYV File Icons (Continued)

Location

Icon

Description

TS Obs Tab, Left
Panel

e

TS station

TS Obs Tab,
Right Panel

ForeSight measurement

SideShot measurement

BackSight measurement

BackSightBearing point measurement

TS Resection Observation

IR AR R

TS MLM Observation

GPS Occupations
Tab

Base station occupation

&,

& Auto Topo occupation®
4

& Topo occupationd
4

GPS Obs Tab

Baseline from the base station to a Topo point

Baseline from the base station to an Auto Topo
point

Tape Dimensions
Tab

Left Panel

| a2 e

Ll
Ll

Start reference line

Tape Dimensions
Tab

Right Panel

A=)

Tape Measurement Point
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TopSURYV File Data Views

Table A-4. TopSURV File Icons (Continued)

Location Icon Description
2 Horizontal Alignment
Vertical Alignment
i
Roads Tab - X-Section Template
ﬁ View Table
View Graphic
7 Line element
Roads Tab B Curve element
Horizontal Soial el -
Alignment Table e piral elemen
7 Intersection element
A Grade element
Roads Tab
Vertical ) Parabola element
Ali t Tabl
enment Tt Ty Long Section element

a. Topo point — the point collected during a static RTK measurement
b. Auto Topo point — the point collected during a kinematic RTK

measurement
c. Auto Topo occupation — the kinematic occupation in the RTK survey
d. Topo occupation — the static occupation in he RTK survey
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Notes:
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Appendix B

Sample File Formats

Coordinate File Formats

Topcon Link can send, receive, and convert a number of different
coordinate file data types. ASCII file formats are listed below.

KOF Coordinates Format

a5 cP1 HAIL 48450.534 G55B462.743 246368
85 cpP2 HAIL 48579 .742 G5LB401.918 247 067
85 CP3 HAIL 48472 .683 G55B478.853 245 _887
a5 188 BC 48456 .898 G55B451.681 246._684
a5 101 BC 48459 882 G55B456.825 246 468
a5 182 BC 4B8460.338 G5LBU5G7.281 246439
a5 183 BC 4B461.0874 SLBUST 14T 246 408

Name,E,N,Z,Code/Name,N,E,Z,Code
Coordinate Format

This file has the following format:
Name, Easting/Northing, Northing/Easting, Elevation, Code

CP1,1832223.183,158958 128,888 .202 NAIL
CP2,1832023.626,159382 _835,810.585 ,NATL
CP3,1832276.836,159030.533,806.714,HAIL
1008,1832186.891,158978.979,8089.329,,BC
161,1832203.767 ,1589088 534,888 _.619,BC
182,1832205.263,158990.294,808.526,BC
183 ,1832204.823,158992 706,888 423 ,BC
104,1832196.907 ,159006 .653 ,887 .951,BC

If the code information is absence in the file:

CP2_HADBZ,1832023.616,159382.018,810.587,
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Sample File Formats

Name,Lat,Lon,Ht,Code Coordinate
Format

This file has the following format:
Name, Lat, Lon, Ht, Code

CP1,48 86 06.98974,-82 59 13.59801,888.292,HAIL
CP2,48 86 11.88744,-82 59 16.18833,818.585,HAIL
CP3,48 86 B7.62810,-82 59 12.91513,886 .714,HAIL
160,408 86 O87.11376,-82 59 14.85850,889.329,BC
161,48 86 067.28911,-82 59 13.84203,888.619,BC
162,408 86 O7.22658,-82 59 13.82291,888.526,BC
163,408 86 07.25040,-82 59 13.82875,888_423,BC

If the code information is absence in the file:

CP2_NAD83,40 086 11.08726,-82 59 16.18847,810.587,

FC-4 Coordinate Format

This file has the following format:
Name

Northing

Easting

Elevation

Code

CP1
158958.12838
1832223.18323
8088 .29207
HAIL

CP2
159382.083548
1832823.62629
810.58455
HAIL
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Coordinate File Formats
GTS-210/310-10 Coordinate Format

®_+CP1 ®+001524003_ y+0015240803_ z+000213360_*=HAIL_+CP2
x+ﬂﬂ1666888 y+ﬂﬂ152hﬂﬂ1 Z+BBBZ1HB?9 *NAIL_+CP3 _ G048%
Bx+ﬂﬂ153?189 y+ae1547977_ Z+BBBZ12988 *NRIL +188 ®+001534464
y+@01516782_ Z+BBBZ136?2 *BC_+101 _ x+ﬂﬂ153h988 y+ﬂ1ﬂ?3§
F01522596_ z+000213460_ *BC +102 ®+001535200_ y+ﬂﬂ152323?
z+000213433 _*BC_+103 _ x+ﬂﬂ1535922 y+ﬂﬂ1523h29 z+080821320823%
B401_=BC_+104 ®+0015408796_ y+ﬂﬂ1523856 z+008213258_=BC_+185
x+ﬂﬂ15h1?21 y+ﬂﬂ153?31h Z+BBBZ12983 *BC_+106 38575

& _ x+ﬂﬂ15h19?8_ y+ae15481972_ Z+BBBZ128hB *BC_+107 _ ®+0801528084
y+001534145_ 2+000213366_=BC_+108 _ x+ﬂﬂ152?955 y+4839%
001532304 z+000213372_ *BC 109 ®+001527571_ y+ﬂﬂ1531588
Z+BBBZ133??_*BC_+11B _ x+ﬂﬂ1526826 y+ﬂﬂ1531869 z+0808215019%

GTS-7 Coordinate Format

This file has the following format:

Name, Northing, Easting, Elevation, Code
CP1,5000.0000,5000.0000,700.00008,HAIL
CP2,4999 9943 5468 .5206,702 3573 ,HAIL
CP3,5078.6555,5042 9982 ,698 49683 ,HAIL
180,4976.08449 ,5034.3210,701.68230,BC
181,4995_3832,50835.7784,700.3283 ,BC
182, 4997 4859 ,50836.7339,7008.2372 ,BC
183 ,4998.1150,5039.1841,700.1345 ,BC
184,4996.8930,5055.08934,699.6638,BC
185,5043.6716,5058.1299,698 4984 ,BC

If the code information is absent in the file

CP2_NADB3,4999.9771,5468 _5091,702 3597,

TopSURV Coordinate File

This file has the following format:
Name, Northing, Easting, Elevation, Note, Code

CP1,5000.000,5000.080,700.0008,Base St,HAIL

If the note information is absence in the file:

CP3,5042.998,5878.655,698.490, ,HAIL
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Sample File Formats
t information is absence in the file
ICPZ HADS83,5468.509,4999 977,702 .368,,

GPS Vector File Format

GPS Vector

Header(//To
VPP(for
vector),Name_ —
r_XY,cor_XZ,cor_ YZ

P(for point),Nane_Point,Lat(DD MMSS.ss),Lon(DD
MMSS.ss),ElL Height Code Note,

A/TopconvectorFormat :v. 1, UsFeaet,

VRTK Topo,Basel, 134,161, 241‘3 89 8123, -68,3288,0.00773025, 0.01944847, 0. 01418940, 0. 0900, -0, 0300, -0, 2800, LT+T _
VRTK Topo,Basel,155,57.3292, Lo7! 0161, l17. 1042, b, 00894811, b. 02141176, b, 00965558, a. 2500, Zo. 1300, -0.2500,LT+T
VRTK Topo,Basel,156,27.2449, -40.4948, -43.0569,0.00796278,0.01099455,0. 01267762,0.2000,-0.0300, -0, 3500, LT+T
VRTK Topo,Basel,157,23.827%,14.0509, Sa. 5551,0.008033064,0.01335403,0.01057374, 0.4300, b, 1200, b, 4200, LT+
P,Basel, 38 32 17 80191 =104 54 00. 37541 5879 325,CP, LT+T PL COR

pi154,35 32 16.09613, -104 53 58.00238, 5870.788,CP, LT+T

P,155,39 32 17.60005,-104 53 5%, 57981, 5877.202,CP, LT+T

P,156,39 32 17.27173,-104 53 59.90637,3876.692,CP,LT+T

p,157,3% 32 18.13790,-104 54 00.05360,5379.843,CP, LT+L
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